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Preface

EMC® Documentum® D2 consists of two components:

• D2 Configuration: The web-based application, hereafter known as D2 Config, for administrators
to use to configure settings such as automated content-handling processes and background
settings for D2 Client.

• D2 Client: The web-based application, hereafter known as D2 Client, for users that provides the
ability to interact with content in one or more repositories.

When this guide refers to D2, it refers to the product as a whole, not the individual components.

Intended audience

The information in this guide is for administrators who access and configure D2 using D2 Config.

Revision history

The following table lists changes in this guide.

Revision Date Description

March 2016 Updated Widget Communications Channels section

August 2015 Updated the description of the AdminGroupsWidget
in the List of Widgets, page 167 topic.

April 2015 • Added a note in the Configuring Auto Link, page
43 topic.

• Updated the description of the Default theme field
in the Configuring a D2 Client Workspace, page
104 topic.

• Added additional information to an existing note
in the Understanding Workflows, page 67 topic.

March 2015 • Added a note about configuring graphics in the
Configuring Custom Icons for Rendition Formats
and Content Types, page 117 topic.

• Added a note about creating query for repeating
date attribute in the Configuring Advanced
Search, page 78 and Configuring a Query Form
Search, page 78 topics.
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Preface

Revision Date Description

December 2014 • Updated the $dqlvalue keyword name in the
Configuring Security, page 40 topic.

• Added a note about default value for repeating
attribute r_creation_date in the Configuring
a Query Form Search, page 78 topic.

• Updated the description of BrowserWidget in the
List of Widgets, page 167 topic.

November 2014 Added a note stating automated delegation is not
supported.

July 2014 Added a note about using the DQL statement
with parenthesis in the Required condition in the
Configuring Property Conditions, page 37 topic.

January 2014 Initial Release.
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Chapter 1
Understanding the Configuration Matrix
and Contexts

This chapter contains the following topics:

• Introduction to D2 Config
• Understanding the Configuration Matrix
• Organizing the Configuration Matrix
• Configuring Contexts
• Configuring Application Filters and Permissions
• Understanding Parent and Child Configurations

Introduction to D2 Config
D2 Config is the administration client of Documentum D2. You can use D2 Config to:

• Customize the user interface of D2 Client for end users.
• Configure automatic processes run by D2.
• Configure actions available to end users in D2 Client.
• Configure interaction with external applications such as Documentum Administrator, rendition
servers, and retention policy services.

Understanding the Configuration Matrix
The configuration matrix is the user interface that you use to control the application of configuration
elements to contexts as shown in the following screenshot:
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Understanding the Configuration Matrix and Contexts

To use the configuration matrix:

• Create a configuration component: Configuration components are the types of configurations, such
as autonaming and security. Specific instances of configurations are saved as configuration elements,
shown as collapsible rows in the vertical Y-axis of the configuration matrix. For example, you can
create a security element for quality assurance draft writers with WRITE access. You can access
the element by expanding the Security configuration component.

• Create a context, shown as the horizontal X-axis of the configuration matrix. Contexts logical
groupings of content qualified by conditions composed of properties such as document types, DQL
conditions, and user groups. Contexts determine when a configuration element applies to content
within the repository. For example, you can create a context that applies for all dm_document
content types created for quality assurance and set to the Draft status.

• Apply the configuration element to the context. For example, applying the configuration element
to the context created in the first two examples leads to a configuration such that the Draft
dm_document quality assurance content provides quality assurance draft writers WRITE access.

Organizing the Configuration Matrix
You can organize the configuration matrix in three ways:

• Organize configuration elements and contexts by assigning them to applications. You can designate
a user group for an application and assign a set of permissions separate from the Security
configuration component. Configuring Application Filters and Permissions, page 16 contains further
instructions on configuring applications.

The list box on the configuration matrix menu bar allows you to filter the configuration matrix
by application.

• Expand and collapse configuration components to show or hide the configuration elements. In
the following example, clicking Expand next to Auto naming opens the list of Auto naming
configuration elements.

• Organize contexts in a tree by designating parent contexts, then expand and collapse contexts to
show or hide the child contexts. In the following example, clicking the arrow next to Public Folder
opens the Public Folder configuration matrix.

14
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Understanding the Configuration Matrix and Contexts

The following table describes the icons next to contexts:

Icon Description

A set with a type and user group definition

A set with one or several type(s)

A set with one or several user group(s)

A set with a type not marked (in use)

A set with a type not marked (in use) in the selected
application

A set with a user group not marked (in use)

A set with a user group not marked (in use) in the
selected application

A set with a type and user group not marked (in use)

Configuring Contexts
1. Navigate to Go to > Context from the menu bar.
2. Click New to create a context.

If you want to create a child context that inherits the properties of an existing context, select a
context and click Create from. Understanding Parent and Child Configurations, page 16 contains
more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this context
applies. For example, adding the QA application
causes the context to only apply to matching quality
assurance cases.
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Understanding the Configuration Matrix and Contexts

Field Description

Parents Add or remove parent contexts for this context to
correspond to a context tree.

Type Add or remove content types.

Condition Type the DQL-query filter.

Group Add or remove user groups.

The field conjoins groups using the OR statement.

4. Click Save.

Configuring Application Filters and Permissions
1. Navigate to Tools > Application from the menu bar.
2. Click New to create an application.

If you want to create a child application that inherits the properties of an existing application,
select an application configuration and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name.

Description Type a description.

User/Group names Use the list controls to add and remove users and
groups.

Permissions Use the list controls to add and remove permissions.

If more than one application is applicable to content,
end users can only perform actions shared across all
applications. For example, Application A grants
the permission Can drag and drop context, while
Application B grants the permissions Can drag
and drop context and Can create, modify, and
delete content. The end user can only drag and
drop content because both applications grant the
permission.

4. Click Save.

Understanding Parent and Child Configurations
You can create a configuration that inherits the settings of and creates a parent-child relation with
an existing configuration. When you import a configuration update, you can set D2 to check for
changes made to the parent configuration. D2 then generates a PDF document listing the configuration
components that were changed and its child configurations. D2 does not automatically apply the

16
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Understanding the Configuration Matrix and Contexts

changes to child configurations because you may not want to change one or more of the child
configurations.

If you delete a parent configuration, the child configurations continue to show the deleted configuration
as a parent.

Importing a D2 Configuration, page 101 contains instructions for importing a configuration.
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Chapter 2

Defining Repository Terminology

This chapter contains the following topics:

• Defining Terminology Using Dictionaries
• Defining Terminology Using Taxonomies
• Configuring a Dictionary
• Importing a Large Dictionary
• Configuring a Taxonomy
• Storing a Registered Table

Defining Terminology Using Dictionaries
Use dictionaries to help end users by defining choice sets for property values, generating autonaming
patterns, and providing input assistance during advanced searches. The choice sets ensure that uniform
terminology is used across the context. As a result, you can:

• Increase the likelihood of a property being filled out by an end user.

• Reduce labeling errors such as extraneous spaces, inconsistent plurality, and so on.

You can define values for a dictionary, then apply a language, an alias, or both to each value. Use
languages to specify a different value based on the language used by the end user. For example, you
can have the value One in English but assign the value Ichi in Japanese. When an end user using an
English interface opens a property page with a list box of numbers, they see one of the options is One.
An end user using a Japanese interface opens the same property page with the same list box and sees
the option Ichi. The value stored in D2 is treated as an equivalent due to the dictionary.

You can use an alias to create an alternate equivalent of the value. For example, you can have the value
Draft, and assign as aliases the values Rough Draft, First Draft, and In Progress. In configuration
components such as property page fields, you can designate the dictionary and alias used. You can use
the different terms to assist end users. For example, in some cases when an end user accesses a list
box, they see the option Rough Draft. You can use aliases so that in other cases, the end user sees the
option In Progress. Despite the difference, both terms are treated as equivalent values and receive
equivalent treatment from automatic processes.

The following screenshot shows an example dictionary:
EMC Documentum
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Defining Repository Terminology

You can use two types of dictionaries:

• Static values such as the category of a document, which is a fixed property.

• Dynamic values such as an authors property that is accessed using a DQL query for existing users.

As dictionaries encourage uniform terminology, D2 can then enforce automatic content linking rules
with more confidence. Dictionaries as a whole improve content management from both a manual and
automatic perspective. Dictionaries are used in the following configuration components:

• Property pages for combo lists, labels, and so on.

• Creation profile for type and attribute selection.

• Autonaming for alias or languages in naming content.

• Autolinking for using properties labels for content placement.

• Search mapping for input assistance during advanced searches.

• Column mapping for use of labels and languages.

Defining Terminology Using Taxonomies
Use a taxonomy if you want to filter values or design a tree of values. You can select dictionaries used
in a taxonomy, then select which values to use and at what level of a hierarchy. D2 uses taxonomies in
the property page to allow you to show the values available for series of attributes. Like dictionaries,
taxonomies help end users by defining choice sets for property values, generating autonaming patterns,
and providing input assistance during advanced searches. The choices sets ensure that uniform
terminology is used across the context. As a result, you can:

• Increase the likelihood of a property being filled out by an end user.

• Reduce labeling errors caused cases such as extraneous spaces, inconsistent plurality, and so on.

For example, you can define a level of types, then define subtypes for each type, as shown in the
following screenshot:

20
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Defining Repository Terminology

Configuring a Dictionary
1. Navigate to Data > Dictionary from the menu bar.

2. Select one of the options for creating a dictionary.

If you want to create a child dictionary that inherits the properties of an existing dictionary, select
a dictionary and click Create from. Understanding Parent and Child Configurations, page 16
contains more information on child configurations.

Click Restore dictionary to open a specific version of an existing dictionary.

Click Import to import a table as a dictionary.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
dictionary applies. For example, adding the QA
application would cause the dictionary to only apply
to matching quality assurance cases.

Versioned dictionary Select to use automatic version control for each
save operation.

Groups > Administration group Select a user group to have the ability to administer
the dictionary using D2 Client.

Groups > Search Dictionary available for the group Select a user group to have the ability to search the
dictionary.

Labels > Label <language> Type a label to appear in the configuration matrix
and during content creation in D2 Client.
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Field Description

Manual sort Select to enable ordering of dictionary values.

Create a registered table Select to create an external table based on the values
contained within the dictionary. D2 creates the table
when you save the changes.

4. Select DQL dictionary to enable DQL dictionary creation.
a. Select Dictionary caching to enable dictionary updates only when you restart the web

application server or when you refresh the cache. Selecting the option increases performance.
To use this option, add the Dictionary caching URL to the Clients URL field in the D2 Options.

b. Type in to DQL query the DQL query. The following table describes commands you can use:

Command Description

as name Sets the preceding attribute as a key attribute.

as is_enabled Enable or disable boolean properties.

as mon_alias Create a new matching list for the key.

The command is similar to the alias column.

as label_en/fr Translate values

$value() Insert into the WHERE statement to refine results

5. Add dictionary values.

IfManual sort was selected, use the up and down arrows to reorder values.

You cannot delete dictionary values used in a creation profile and property page. Unselect Key to
remove it from the dictionary.

6. Add or remove Languages values.
7. Add or remove Alias values.
8. To save the dictionary:

• Click Save to use automatic versioning.
• Click Save dictionary to manually version the dictionary.
• Click Export to export the dictionary in a file format you want.

9. Click Update repository to load the changes in the repository without restarting the server.

Importing a Large Dictionary
Use the D2JobImportDictionary job to import large dictionaries, because you may encounter
performance problems when using D2 Client or D2 Config to import large dictionaries.
1. Create an index for the Oracle table d2_dictionary_value using the following command:

EXECUTE make_index WITH type_name=’d2_dictionary_value’,
attribute=’dictionary_name’, attribute=’object_name’

2. Import the dictionary using the following command:

22
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Defining Repository Terminology

EXECUTE do_method WITH method = ’D2ImportDictionaryMethod’,
arguments =’-overwrite true -folder <path to the dictionary>
-sorted false -transaction false’

Configuring a Taxonomy
1. Navigate to Data > Taxonomy from the menu bar.
2. Select one of the options for creating a taxonomy.

If you want to create a child taxonomy that inherits the properties of an existing taxonomy, select
a taxonomy and click Create from. Understanding Parent and Child Configurations, page 16
contains more information on child configurations.

Click Restore taxonomy to open a specific version of an existing taxonomy.

Click Import to import a table as a taxonomy.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Administration group Select a user group to have administration rights.

Description Type a description.

Versioned taxonomy Select to enable automatic version control of the
taxonomy.

4. Add or remove dictionaries used in the taxonomy. You can only remove the lowest level on the list.
5. Use the list controls to add or remove taxonomy values.
6. To save the taxonomy:

• Click Save to use automatic versioning.
• Click Save taxonomy to manually version the taxonomy.
• Click Export to export the taxonomy in a file format you want.

Storing a Registered Table
Registered tables are relational database management system tables that are not part of the repository
but are known to the Content Server. The Documentum Content Server DQL Reference contains
further information about creating and querying registered tables. You can use registered tables as
read-only dictionaries. You can import:

• Exported dictionaries.
• Imported .csv or .xsl files. This option can be used only on an existing registered table to edit
its values.

Use registered tables as a reference.
1. Navigate to Data > Registered table from the menu bar.
2. Select one of the options for showing or editing a registered table. New does not create a registered

table, you must create registered tables in Documentum Administrator or through a dictionary.
EMC Documentum
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If you want to create a child registered table that inherits the properties of an existing registered
table, select a registered table and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Select a registered table in the repository.

Description Type a description.

Applications Add or remove the applications to which this
registered table applies. For example, adding the QA
application would cause the registered table to only
apply to matching quality assurance cases.

Administration group Select a user group to have administration rights.

4. Add or remove table values.

Add a row by typing values into the empty row at the bottom of the table.

5. To save the registered table:

• Click Save to save the registered table.
• Click Export to export the registered table in a file format you want.

24
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Chapter 3
Configuring Content Creation Compo-
nents

This chapter contains the following topics:

• Determining Which Creation Processes to Use
• Configuring Autonaming
• Configuring a Property Page
• Configuring Value Assistance Fields
• Configuring Property Conditions
• Configuring Inheritance
• Configuring Security
• Understanding Minimum Security Rights
• Editing a Security Model
• Configuring Security Inheritance
• Configuring Auto Link
• Configuring Template Lists
• Setting Up Thumbnails for Template List Previews
• Configuring Virtual Document Templates
• Configuring Linked Documents for Creating or Importing Content
• Configuring Checkin
• Configuring Checkout
• Configuring Uniqueness Check
• Configuring Mass Update

Determining Which Creation Processes to Use
You can configure context-dependent automated processes, which are performed when an end user
creates content. Use the following table to determine which processes you want performed:
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Configuring Content Creation Components

Process Description Example

Auto naming

Configuring Autonaming, page 28
contains further instructions.

You can configure an automatic
process to change property values.

An end user creates a quality
assurance Draft document. An
auto naming process can be run
to rename the file to include
quality assurance (QA) and Draft,
such as QA_project_draft_7-30-
2014.docx.

Property pages

Configuring a Property Page, page
30 contains further instructions.

You can create and configure
property pages to determine the
properties that end users can view
and edit.

If you do not specify a properties
page in a creation profile, the D2
Client content creation wizard
skips the properties step.

If you delete properties from
content types using other
Documentum applications, such
as Documentum Administrator,
D2 shows the property pages with
blank spaces. You must manually
update the property pages to
remove the deleted properties.

An end user creates a quality
assurance Draft document. You
can configure a property page
to show a comment field and a
checkbox for whether it is a private
or public draft. This allows end
users to view and add comments to
the document and set its privacy
status. End users cannot view
or make changes to all other
properties such as the document
title, author, and status.

Inheritance

Configuring Inheritance, page 39
contains further instructions.

You can configure an automatic
process to copy properties from
existing content to new content.

An end user creates a Project
122 documentation that inherits
properties from Project 120
documentation. Keywords such
as Project 12X are copied from
the 120 documentation to the 122
documentation, alleviating the
need to manually copy properties.

Security

Configuring Security, page 40
contains further instructions.

You can configure security models,
which define dynamic access
control lists (ACLs) that apply
to contexts. You can specify a
condition based on three identifiers
to apply a level of permissions.
The three types of identifiers are
specific users, user groups, and
content properties. If multiple
conditions match a specific
situation, the most extensive set of
rights is applied.

If no security model is selected, D2
applies the default ACL configured
depending on the Documentum
repository configuration.

An end user can belong to the
quality assurance Draft Writers
group, which gives them WRITE
permission within the quality
assurance documentation folder.

26
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Configuring Content Creation Components

Process Description Example

Auto linking

Configuring Autolink, page 43
contains further instructions.

You can configure an automatic
process to place content in
specified locations within the
repository. You can configure an
auto link template to have multiple
placements, in which case the
content is placed in the first, then
linked to the other placements.

Changing the property values
of content and affecting its
context can cause a change in the
placement of the current version of
the content.

If no auto link rule is configured,
D2 adds content to the selected
folder. If no folder is selected, D2
adds content to the cabinet level.

Folders with a high volume
(roughly 500) of content can
have performance issues and
errors. Configure auto linking of
content to minimize the amount
of content within each folder. For
example, a project may contain 500
documents, leading to performance
degradation. To work around the
issue, you can configure an auto
link to create and fill subfolders
for project phases to reduce the
number of content directly found
in the project folder.

An end user creates a quality
assurance Draft document. The
document is placed in the quality
assurance Draft folder with all
other quality assurance drafts. If
the end user sets the document to
Private, in which it is hidden from
other users, auto link can move
the document to a personal, locked
folder in the quality assurance
Draft folder. When the end user
decides to set the document back
to Public, auto link can move
the document back to the quality
assurance Draft folder.

Template list

Configuring Template Lists, page
46 contains further instructions.

You can configure a list of content
templates suggested to an end
user during the end of the content
creation process. Assign lists
of templates to contexts, which
allows you to provide templates
that are only relevant to specific
circumstances.

End users can be part of the
administration group for template
lists. This enables configuration of
template lists directly through D2
Client.

If there is only one template that an
end user can select and the end user
does not have template creation
privileges, the D2 Client content

You can bundle a set of
templates for all quality assurance
documentation, such as drafts,
presentations, and reports. When
an end user creates content using
the quality assurance application,
they can select from a list of quality
assurance-specific templates.
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Process Description Example
creation wizard selects the template
and skips the template step.

VD Template

Configuring Virtual Document
Templates, page 47

You can configure a virtual
document template for inheritance
of properties and components. End
users can use virtual document
templates to insert components of
a selected virtual document into a
virtual document or create a copy
of the template virtual document.

An end user creates a presentation
content and selects a virtual
document template to inherit.
The presentation gains the virtual
document children applied to the
template.

Linked document

Configuring Document Linking,
page 48 contains further
instructions for configuring
linked documents for new and
imported content.

Configuring Linked Documents for
Importing Emails, page 57 contains
further instructions for importing
attachments as linked documents.

You can configure the content
creation process to create
additional documents during
content creation and link them to
the base content. This enables
end users to create batches of
documents that are controlled by a
central document.

An end user can create a business
plan, then link notes, presentation
slides, and so on to the business
plan.

Checkin

Configuring Checkin, page 49
contains further instructions.

You can configure aspects of
checkin such as versioning and
logging.

An end user checks in a quality
assurance Draft. Checkin
configurations result in no
versioning.

If an end user checks in a quality
assurance In-Review document,
checkin configurations can result
in minor versioning.

Checkout

Configuring Checkout, page 50
contains further instructions.

You can configure aspects
of checkout such as warning
messages and checkout range.

An end user checks out an
approved document. Checkout
configuration causes a warning
message reminding the end user
the document has already been
approved.

If the end user checks out a draft
document, checkout configuration
can differ, such as showing no
warning message.

Configuring Autonaming
1. Navigate to Go to > Auto naming from the menu bar.

2. Click New to create an autonaming rule.
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If you want to create a child autonaming rule that inherits the properties of an existing autonaming
rule, select an autonaming rule and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
autonaming rule applies. For example, adding the
QA application would cause the autonaming rule to
only apply to matching quality assurance cases.

Generate the document name for each property
modification

Select to have the document name updated whenever
a save operation is performed on properties used
by the autonaming rule.

For example, if an autonaming rule uses the
a_status property of the content, and the content
passes through a workflow or lifecycle that alters
a_status, selecting the checkbox would cause
the property controlled by the autonaming rule to
change.

Regenerate on new version Select to have the document name updated
whenever a new version of the content is created.

Property name Select the property changed.

4. To add a property to the Auto naming template:
a. Select a property from the Properties list box in the Naming menu bar.
b. Select a dictionary if the property uses a dictionary. Select a language or alias.

c. Type the index position of the value if the property is a repeating property and you want
to select a specific value.

For example, if you want to select the first value of the list, type 0.

d. Type the date format if the property is a date property, select a DQL action, and enter the value.
Use the following table to understand what values to type for each DQL action:

DQL Action Value

DATEADD year|month|week|day followed by an
integer value

DATEFLOOR year|month|week|day

5. Select the position in the autonaming template, then type text to insert static text.

6. To configure the counter:

a. Type the initial counter value in Counter value.
b. Select Counter depends on template properties to count subtype changes. When not selected,

changes to content subtype do not increase the counter.

c. Fill the form as follows:
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Field Description

Send email notification to Type the email address to which D2 sends a
notification.

when the number of remaining values is Type a counter value. When the entered number
of values remains, D2 sends a notification to the
previously entered email address alerting the
recipient.

Interval start value Type the starting value.

Interval end value Type the end value.

d. Click + to add another interval of counter values. When one interval ends, D2 continues the
counter from the next sequential interval start value.

7. Click + to add a regular expression:
a. Fill out the form as follows:

Field Description

Name Type the name of the regular expression.

Pattern Type the statement to be replaced.

Replace Type the replacement statement.

For example, having underscore, _, - respectively replaces all _ with -.

b. Use the up and down arrows to reorder the regular expressions. Regular expressions are
executed from top to bottom.

8. Click Save.

Configuring a Property Page
1. Navigate to Go to > Property page from the menu bar.
2. Click New to create a property page.

If you want to create a child property page that inherits the properties of an existing property page,
select a property page and click Create from. Understanding Parent and Child Configurations,
page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
property page applies. For example, adding the QA
application causes the property page to only apply
to matching quality assurance cases.

Document type Select the document type.

Focused control Select the property object that has focus when the
property page is opened.
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Field Description

Width Enter the width in pixels.

Height Enter the minimum height of the property page in
pixels.

If the property page widget in D2 Client does not
scroll down far enough to show all property page
content, increase the height of the property page.

Resizable Select if you want the property page to be resizable.

Buttons Select the position of the OK and Cancel buttons.

4. Configure electronic signature options as described in the following table:

Field Description

Electronic signature required (in edition mode) Select to require an electronic signature to save
properties.

Intention required Select to require the reason with the electronic
signature.

Intentions dictionary Select a dictionary to enable users to select a reason
from a list of options.

5. Add organizational objects to the property page.

a. Use the following table to determine which organizational objects to add:

Icon Name Description

Tab unit Creates an area to which you can add tabs.

Tab Creates a tab in a tab unit.

Type a label for the field.

Field set Creates a fieldset to cluster property objects together.

Type a label for the field and select whether to use a border.

Grid Creates a table using properties as columns. DQL using
dependencies on values of other columns and taxonomies
configured inside the Grid do not function.

Type a height for each grid in pixels. All controls added to the
grid can be toggled to have No empty cell. When the checkbox
is selected, the field must be populated before the properties
can be saved.

Column set Organizes property objects by a configured number of columns.

Type the number of columns in the set and add objects. The
property page automatically organizes objects in columns.
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Icon Name Description

Comment Adds a static comment with font styles.

Type a label for the field. You can use HTML in the label
by selecting the option, or you can use the $value and $alias
keywords.

Select font color, size, and style.

Empty cell Adds an empty cell. Use empty cells in grids and column sets
to organize property placement.

Separator Adds a horizontal bar. Use separators to add a visual marker
for different sections of the property page.

b. Configure property conditions. Configuring Property Conditions, page 37 contains further
instructions.

6. Add property objects.

You can preview the property page by clicking the Display preview in create mode, Display
preview in edit mode, and Display preview in import mode buttons. The buttons show a
dialog box with the selected property page form, allowing you to check your work. Permissions
configured for each property are active for the preview. If you do not belong to the correct groups,
certain properties may not appear when previewing properties.

a. Use the following table to determine which property objects to add:

Icon Name Description

Label Adds as static text the property name, a colon, and the value of
the property.

Select a property. Type a label if you do not want to use the
label that was defined for the property using Documentum
Application Builder.

For example, if you select the property date_finish and
type the label Finishing Date, the property page shows
Finishing Date : 8/9/2017

If you type the label Finish date the property page instead
shows Finish date : 8/9/2017

Text Adds a text field for end users to type values into and save.

Select the property for storing the value and type a label if you
do not want to use the label that was defined for the property
using Documentum Application Builder.

Password Adds a text field for end users to type a password into for
saving. D2 displays the password during auditing and when
producing info dumps, so make sure end users account for the
risk of password exposure.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder.
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Icon Name Description

Memo Adds a text box for end users to type a memo into and save.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder and
the row height of the field.

Rich text editor Adds a rich text editor for users to format the content or value
of a property.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder.

Boolean Adds a checkbox that returns a boolean value.

Type a label if you do not want to use the label defined for the
property in Documentum Application Builder.

Date Adds a date field for end users to select a date from a calendar.
D2 uses the server date and time to registered the selected date
and can show an error when you click Save if the dates do not
match due to timezone differences.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder.

URL hyperlink Adds a list field for end users to add, remove, reorder, and
access external links.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder and
select which action you want users to perform to open the URL.

Combo field Adds a list for end users to select values from a DQL query,
a dictionary, or a taxonomy.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder and
select Load asynchronously to load values on click and filter
as opposed to when the dialog box is opened. Use the option
when the list contains a large number of values.

Editable combo field Adds a list for end users to select values from a DQL query,
a dictionary, or type. End users can type text in the field to
filter the list of values.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder and
select Load asynchronously to load values on click and filter
as opposed to when the dialog box is opened. Use the option
when the list contains a large number of values. You can also
type a width and height for the popup dialog box shown to
the end user.
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Icon Name Description

List field Adds a list for end users to select several values from a DQL
query or a dictionary. The selected values must have the
Repeating property.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder, select
the row height for the field, select whether to sort the list in
alphabetical order, select whether to enable import and export
of the list of values from and to XLS documents, and type the
height and width of the selection dialog box.

Select Load asynchronously to load values on click and filter
as opposed to when the dialog box is opened. Use the option
when the list contains a large number of values.

Select Load on selection popup opening to load values when
the selection dialog box is opened. If not selected, users must
press ENTER to load the list.

Editable list field Adds a list for end users to select several values from a DQL
query or a dictionary, or add text. The selected values must
have the Repeating property.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder, select
the row height for the field, select whether to sort the list in
alphabetical order, select whether to enable import and export
of the list of values from and to XLS documents, and type the
height and width of the selection dialog box.

Select Load asynchronously to load values on click and filter
as opposed to when the dialog box is opened. Use the option
when the list contains a large number of values.

Select Load on selection popup opening to load values when
the selection dialog box is opened. If not selected, users must
press ENTER to load the list.

Radio Adds a list for end users to select a single value with a single
click.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder
and select whether to list the options vertically instead of
horizontally.

Checkbox Adds a list for end users to select a multiple values. The
selected values must have the Repeating property.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder
and select whether to list the options vertically instead of
horizontally.
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Icon Name Description

Controlled relation Adds a controlled relation field for users to add related
documents for that relationship type.

Select a configured relationship type from the Relation type
list box.

Do not use the D2_COPY_OF relationship type because it is
an internal relation used for inheritance. When creating or
importing content, D2 does not create a relationship for the
D2_COPY_OF relationship type and does not show the relation
in the property page.

PDF preview (For D2 Client 3.1 only) Adds a preview of the content to the
property page.

Type a label if you do not want to use the label that was defined
for the property using Documentum Application Builder and
the height of the preview box.

Button (For D2 Client 3.1 only) Adds and enables the ability to
configure buttons.

By default, the button executes a Save operation. You can
configure the buttons to execute a Javascript action.

Type the:

• Label if you do not want to use the label that was defined for
the property using Documentum Application Builder

• Width.

• Javascript action to execute.

You can configure buttons to appear on the left or right of the
property page. Otherwise, they appear on the bottom.

List of Custom Actions, page 177 contains further information
on the commands you can use.

b. To fill the field with a value, select a Type and fill out the subsequent fields. You can select a
type for labels, radio buttons, checkboxes, combo fields, and list fields.

The following table describes keywords that you can use if you select DQL:

Keyword Description

as name Save the value as the Name.

as label Save and use the value as the Label.

$value(property name) Use the value of the property property name.

If you load asynchronously, a DQL query for loading values must include $value(filter)

For example, select user_name as name, user_name as label from
dm_user where $value(filter) order by 1

Ensure that you use specific queries such as the above example. D2 may not be able to process
large sets of results returned by queries that are too general, such as select * from.
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c. To save the value of the field to a property, select a Property. If you do not want to save the
value to a property, select Do not link to property and type an ID for the field in Control id.
Use the control ID to create value assistance fields. Configuring Value Assistance Fields, page
36 contains further instructions on linking fields to create dynamic forms.

d. Configuring Property Conditions, page 37 contains instructions on configuring conditions in
which a property applies.

e. When applicable, use < and > to configure reinitialization of properties when content is
modified.

7. Click Save.

Configuring Value Assistance Fields
You can set fields in property pages to act as assistance for filling out other fields.

For example, you can have a State list field and a Facility list field. With this example, an end user can
select a state, which populates the Facility field with a list of facilities specific to the selected state.
This helps an end user to find a facility within a state.
1. To use DQL assistance:

a. Set the Type of the property object receiving assistance to DQL.
b. Type a filtering query using $value(<the control ID of the assisting

object>)

For example, during configuration of the State field, you can enter selected_state as the
Control id. During configuration of the Facility field, select DQL as the Type, then type as the
query select * from facilities where state=$value(selected_state)

The following table shows a summary of the fields:

Assisting property object (State) Assisted property object (Facility)

Control id: selected_state Type: DQL

DQL Query: select * from facilities
where state=$value(selected_state)

If the user selectsMaryland in the State field, the DQL query is run. The DQL query filters all
facilities with the state value matchingMaryland and populates the Facility field with a selectable
list.

Append enable (return_top <maximum number of results>)to limit the result
set of the query to the indicated value. Use this parameter to avoid performance problems
associated with large result sets.

2. To use Taxonomy assistance:
a. In the property object being used as assistance, select Taxonomy, fill out the respective fields,

then select the level of the taxonomy to be used in the assisted field in Next Property.
b. In the property object receiving assistance, select Taxonomy and select the Level to match

the Next Property field selected previously.

This example uses the taxonomy Facilities by state, which has the hierarchy of Country > State
> Facility.
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During configuration of the State field, select Taxonomy, select the taxonomy Facilities by state,
select the level State, and select in Next Property the subtype Facilities. During configuration of
the Facility field, select the taxonomy Facilities by state and select the level Facilities.

The following table shows a summary of the fields:

Assisting property object (State) Assisted property object (Facility)

Type: Taxonomy Type: Taxonomy

Taxonomy: Facilities by state Taxonomy: Facilities by state

Level: State Level: Facilities

Next Property: Facilities

If the user selectsMaryland in the State field, the Facility field is populated by the subtypes of
Maryland in the taxonomy.

Configuring Property Conditions
You can configure the display, activation, and requirements for every property object added to a
property page, as described in the following table:

Tab name What the conditions are for

Enabled condition Conditions configured in this tab determine whether
the property object can be edited.

Visibility condition Conditions configured in this tab determine whether
the property object can be viewed.

Required condition Conditions configured in this tab determine whether
the property object is a required property. Not all
objects contain a required condition tab.

Validation constraint The regular expression configured in this tab forces a
validation to be performed on a text field, password
field, or date fields. This tab does not appear for other
property objects.

Validation is performed:

• When validating the dialog during creation.

• While leaving each field during editing.

There are two editors for property conditions:

• Simple view editor: This editor provides a user interface for inputting conditions.

• Advanced view editor: This editor provides a text field for typing a DQL query as the condition.
This editor is only available in D2 Client 3.1.

Note: Using DQL statement with parenthesis in the Required condition in the Advanced view
editor is not honored in a properties dialog used within a query form. For a query form, design the
condition without parenthesis and define from left to right in a specific order to allow the query to
meet the condition.

1. On the Enabled condition tab:
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a. Use the list controls to add and remove conditions. If you do not set conditions, D2 considers
conditions to have been met.

If you are using the simple view editor, select a condition attribute and operator and type
the condition value. For example, you can have the condition attribute object_name, the
operator contains, and the value QA. The property then requires the content to have QA in
the file name.

If you are using the advanced view editor type your condition.

b. Fill out the form as described in the following table:

Field Description

Enabled only for group Select the content subtype for which the property
is enabled.

Reinitialize when this control is disabled Select to reset the attribute value when the content
is deactivated.

Creation mode Select to use this property element when content
is being created.

Edit mode Select to use this property element when the
properties page of content is being edited.

Import mode Select to use this property element when content
is being imported.

2. On the Visibility condition tab:
a. Use the list controls to add and remove conditions. If you do not set conditions, D2 considers

conditions to have been met.

If you are using the simple view editor, select a condition attribute and operator and type
the condition value. For example, you can have the condition attribute object_name, the
operator contains, and the value QA. The property then requires the content to have QA in
the file name.

If you are using the advanced view editor type your condition.

b. Fill out the form as described in the following table:

Field Description

Visible only for group Select the content subtype for which the property
is shown.

Reinitialize when this control is disabled Select to reset the attribute value when the content
is deactivated.

Reserved space Select to keep the space allotted for the property
element even if the element is set to invisible.

Creation mode Select to use this property element when content
is being created.

Edit mode Select to use this property element when the
properties page of content is being edited.

Import mode Select to use this property element when content
is being imported.

3. On the Required condition tab:
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a. Use the list controls to add and remove conditions. If you do not set conditions, D2 considers
conditions to have been met.

If you are using the simple view editor, select a condition attribute and operator and type
the condition value. For example, you can have the condition attribute object_name, the
operator contains, and the value QA. The property then requires the content to have QA in
the file name.

If you are using the advanced view editor type your condition.

b. Fill out the form as described in the following table:

Field Description

Required only for group Select the group for which filling out this property
element is required.

Creation mode Select to use this property element when content
is being created.

Edit mode Select to use this property element when the
properties page of content is being edited.

Import mode Select to use this property element when content
is being imported.

4. On the Validation constraint tab, set a validation constraint:
a. Configure the regular expression:

• Text and password property validation accepts Javascript regular expressions.
• Date validation accepts two types of constraints (equals, notEquals, Greater,
Lesser, LesserOREquals, GreaterOREquals) when comparing to other date fields,
or $TODAY when comparing to the current date. The other field must be available in the
dialog box.

b. Type a Message to show when validation fails. This message is appended to the default
message:

’attr’ is invalid.

5. Click Save.

Configuring Inheritance
1. Navigate to Go to > Inheritance from the menu bar.
2. Click New to create an inheritance rule.

If you want to create a child inheritance rule that inherits the properties of an existing inheritance
rule, select an inheritance rule and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.
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Field Description

Description Type a description.

Applications Add or remove the applications to which this
inheritance rule applies. For example, adding the
QA application would cause the inheritance rule to
only apply to matching quality assurance cases.

4. Use the list controls to add and remove inherited properties.
5. Select the relation type used during inheritance. The following table describes the differences:

Relation type Description

Default Use the COPY_OF relation.

None No relation used.

Other relation Select a defined relation type from the list box.

6. If you want to prevent inheritance of Virtual Document structure:
a. Type the inheritance prevention condition for each Virtual Document component in Testing

condition on each component.
b. Type a warning message inWarning message. The message is shown in D2 Client when

inheritance is performed.
7. Click Save.

Configuring Security
1. Navigate to Go to > Security from the menu bar.
2. Click New to create a security model.

If you want to create a child security model that inherits the properties of an existing security model,
select a security model and click Create from. Understanding Parent and Child Configurations,
page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Configuring Security Inheritance, page 43 contains
more information on using the Name field to
configure security inheritance.

Description Type a description.

Applications Add or remove the applications to which this
security model applies. For example, adding the QA
application would cause the security model to only
apply to matching quality assurance cases.

4. Configure levels of permissions:
a. Use list controls to add, remove, and reorder permission levels.
b. For each level, select an Identifier from one of the three list boxes:
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• User

• Group

• Property

You can merge text and property context using the following keywords:

Keyword Description

$dqlvalue(’<dql request>’) Perform a DQL request. You must include the
quotation marks.

$value(<property>)$value(<prop-
erty>)

Merge two properties, for example
$value(country)$value(state)

c. Use list controls to add, remove, and reorder conditions. You cannot remove the default
condition.

Conditions relate a property list box to an expression. D2 prioritizes the matching of the
conditions from top to bottom.

d. Toggle permissions by double-clicking on the cells as described in the following table:

Right Description

Change State Users can change the state of content that has
been applied a lifecycle.

Change Owner Users can change the owner of content. If the user
is not the content owner or a superuser, they must
also have Write permission.

Change Permit Users can change the basic permissions of content.

Delete Object Users can only delete the object. Give this
permission if you want to allow a user to delete
without being able to read the content.

Change Folder Links Users can create or remove links to a folder.
Give this permission if you want to allow a user
to move content into a folder without having
permissions to read or write within the folder.

Change Location Users can move content within the repository. The
user must also have Write permission to move
content and Browse permission to link content.

Execute Proc Users can run external procedures stored in the
repository as a dm_procedure on certain object
types.

IRM Print Users can print content through an IRM server.

This permission is shown when D2 detects the
installation of an IRM server.

IRM Copy Users can copy content through an IRM server.

This permission is shown when D2 detects the
installation of an IRM server.
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Right Description

IRM Take Offline Users can access a local copy of content when
disconnected from the IRM server. You can
configure in the IRM server the duration of offline
access,

This permission is shown when D2 detects the
installation of an IRM server.

IRM View Activity Users can view the IRM activity log for content.

This permission is shown when D2 detects the
installation of an IRM server.

5. Click Save.

Understanding Minimum Security Rights
Users require at least a certain level of security rights to perform different content-related tasks. Use
the following table to understand the minimum rights for users and superusers for creating, modifying,
and copying content:

Without folder security With folder security

Superuser User Superuser User

Creation of
content

Parent folder None Browse Write Write

Parent folder None Browse Write WriteDeletion

Object Delete Delete Delete Delete

Parent folder None Browse Write Write

Destination
folder

None Browse Write Write

Move

Object Write Write Write Write

Parent folder None Browse Read Read

Destination
folder

None Browse Write Write

Duplicate

Object Read Read Read Read

Editing a Security Model
Changing an existing security model can affect newly created content as well as existing content
that uses the model being changed.
1. To modify a security model and affect existing content, modify the security model and do not

modify the configuration matrix.

D2 runs a job in the background to modify the ACL of all previously created content using the
security model.
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2. To modify a security model and avoid affecting existing content, unless you perform a manual
operation:
a. Create a copy of the security model.
b. In the configuration matrix, unselect the previous security model and select the new security

model.

D2 applies the security model to new content and to existing content when it is saved, checked in,
or has a property changed.

3. To modify a security model and avoid affecting existing content:
a. Create a copy of the security model.
b. Create a copy of the content context used for the previous security model. Add the condition

r_creation_date > <the date of creation for the new security
model> to identify the content created for the new security model.

c. Drag the new context before the old context in the configuration matrix.
d. Activate the new context.

D2 applies the new model to all new content, and old content continues using the old security
model. You can launch D2CoreJob using Documentum Administrator or run a mass update to
apply the new security model to linked content.

Configuring Security Inheritance
1. Create or configure a security model.
2. Type one of the following keywords corresponding to the set of ACLs you want inherited in

the Name field:
• FOLDER for the rights of the creation folder.
• USER for the rights of the user.
• TYPE for the rights of the document type.

3. Click Save.

Configuring Auto Link
1. Navigate to Go to > Auto link from the menu bar.
2. Click New to create an auto linking template.

If you want to create a child auto linking template that inherits the properties of an existing auto
linking template, select an auto linking template and click Create from. Understanding Parent and
Child Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.
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Field Description

Applications Add or remove the applications to which this auto
linking template applies. For example, adding
the QA application would cause the auto linking
template to only apply to matching quality assurance
cases.

Label for undefined property Type a name for the folder to be created if a property
is not filled.

For example, if you define the path :/Property
1/Property 2/Property 3

If Property 1 = Apple and Property 2 = Berry,
but Property 3 is not set with a value and you typed
Orange in the Label for undefined property
field, the auto link template places the content in
:/Apple/Berry/Orange

No empty folder on the extremity Select if you do not want to create a folder for
a missing property value. For example, if you
take the example from Label for undefined
property, instead of placing the content in
:/Apple/Berry/Orange the content is placed
in :/Apple/Berry

Link all versions to current version folders Select if you want all versions of the content to be
moved to the new location in the repository.

If you do not select this checkbox, other versions
are kept in their original locations.

4. Configure repeating properties:

Fields Description

Link only the first value of the repeating properties Select to link the first values of each repeating
property together.

Link repeating properties between themselves Select to link repeating attributes together.

The following table shows examples of the two checkboxes:

Property 1 Property 2 Property 3 No checked
boxes

Link only the
first value of
the repeating
properties

Link repeating
properties
between
themselves

A,B C,D E (single) /A/C/E

/A/D/E

/B/C/E

/B/D/E

/A/C/E /A/C/E

/B/D/E

A,B C,D E (repeating) /A/C/E

/A/C/
Undefined

/A/D/E

/A/C/E /A/C/E

/B/D/
Undefined
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Property 1 Property 2 Property 3 No checked
boxes

Link only the
first value of
the repeating
properties

Link repeating
properties
between
themselves

/A/D/
Undefined

/B/C/E

/B/C/
Undefined

/B/D/E

/B/D/
Undefined

5. Click Add path to add a path.
6. Click /+ to add a folder to a path.

7. Click the text field above the folder category to select and configure a folder property:

a. Select a property from the Properties list box.
b. Type a Repeating Index if the selected property is a repeating property.
c. If applicable to the selected property, select a dictionary from the Dictionaries list box, then

select an alias or language.

d. Click the hand button to add the property.

e. You can type static text into the folder property.

f. To reorder properties, drag and drop properties.

8. Click the space between the / symbols and select a default value to associate with the content at
different folder levels:

9. Click the space below the default values and select an ACL template for the security of the folder:

10. To set the cabinet to your personal folder, select Home cabinet.
11. Click + to add a regular expression.

a. Fill out the form as follows:

Field Description

Name Type the name of the regular expression.

Pattern Type the statement to be replaced.

Replace Type the replacement statement.

For example, having underscore, _, — respectively replaces all _ with -.

b. Use the up and down arrows to reorder the regular expressions. Regular expressions are
executed from top to bottom.

12.Click Save.

Note: Auto Linking is performed only by the installation owner account. You cannot restrict
this feature to a specific set of users or groups.
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Configuring Template Lists
1. Navigate to Go to > Template from the menu bar.

2. Click New to create a template list.

If you want to create a child template list that inherits the properties of an existing template list,
select a template list and click Create from. Understanding Parent and Child Configurations, page
16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
template list applies. For example, adding the QA
application would cause the template list to only
apply to matching quality assurance cases.

Administration group Select a user group to have administration rights
over the list in D2 Client (D2 Client 3.1 only).

Enable document without content Select to allow documents with empty content
bodies.

4. You can create a static, defined list of templates or a dynamic list of templates based on a DQL
filter. To create a static list, select List.
a. Click Browse to show the Templates dialog box and use < and > to configure the list of

template documents.

For each template, you can add a template display condition. Select the template, then type
a DQL statement in Selected template display condition.

b. Click Import to show the Import dialog box add a template to the repository, then fill out
the form as described in the following table:

Field Description

Name You can change the name after importing the file.
By default the name of the imported file name is
used.

File Click Browse, then locate and select the document
to use as a template.

Do not select a blank document as a template.

Format Select the file format.

Click OK to close the Import dialog box and import the template to the repository.

c. When you have imported all templates you wish to add to the repository, click OK to close
the Templates dialog box.

5. To create a dynamic list of templates, select Query, then type a DQL filter into Qualification to
create a template list based on a DQL query of the templates in the repository.
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For example, mes_templates where a_status = ’Approved’ creates a list of
templates that have been set to Approved. The produced list uses the object_name property
as the template name.

6. Click Save.

Setting Up Thumbnails for Template List
Previews
If renditions generated using the ADTS are available for the template, D2 shows a preview of the
template file. You can configure this by ensuring that template files have the correct .jpg rendition
associated. To do so, you can:

• Configure the ADTS to automatically create thumbnail renditions for the D2 environment. In this
case, you should see previews instead of file format icons.

• Request a thumbnail rendition from the rendition server. For example, the Bulk-request of
PDF rendition for existing documents in the docbase article in EMC Solutions contains further
information about configuring bulk-requests of PDF renditions.

When a thumbnail server is configured, D2 uses the .jpeg thumbnail files as described below:

• jpeg_th: Used in the Thumbnails widget when an end user sets the page modifier for the widget
to large_jpeg_th.

• jpeg_lres: Used in the Preview widget.

Configuring Virtual Document Templates
1. Navigate to Go to > VD Templates from the menu bar.
2. Click New to create a virtual document template.

If you want to create a child virtual document template that inherits the properties of an
existing virtual document template, select a virtual document template and click Create from.
Understanding Parent and Child Configurations, page 16 contains more information on child
configurations.

3. Fill out the form as described in the following table:
Field Description

Name Type a name to appear in the configuration matrix.

Label <language> Type a label.

Description Type a description.

Applications Add or remove the applications to which this
virtual document template applies. For example,
adding the QA application would cause the virtual
document template to only apply to matching
quality assurance cases.

Asynchronous build Select to create the virtual document in
asynchronous mode.
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4. Click + to add an operation. D2 applies all applicable operations for each child of the VD:
a. To create a virtual document with copied root and components, select Copy as the Operation,

then fill out the properties as described in the following table:
Field Description

Qualification DQL Type a single DQL query to filter the source
components.

For example, dm_document where
a_status = ’Draft’

New object type Select the object type of the newly created
component.

Inherit content Select to inherit the content of the component.

Default values Select a default values template.

Component inheritance Select an inheritance template for the properties
of the VD children.

Root inheritance Select an inheritance template for the properties
of the VD root.

Version label Type the version label for the copied output.

Default lifecycle Select a default lifecycle to set the starting status
of the copied output.

b. To link the source component to the new virtual document, select Link as the Operation, then
fill out the properties as described in the following table:
Field Description

Qualification DQL Type a single DQL query to filter content.

Binding rule Type the version number or version label of
the content to link. The option allows you to
force D2 to show a specific version in the new
virtual document. If a matching version is not
found, D2 shows the current version of the source
component.

c. To exclude the content in the VD, select Exclude as the Operation, then type a single DQL
query to filter content. You can only exclude copy or link operations.

5. Click Save.

Configuring Linked Documents for Creating or
Importing Content
1. Navigate to Go to > Linked document from the menu bar.
2. Click New to create a document link.

If you want to create a child document link that inherits the properties of an existing document link,
select a document link and click Create from. Understanding Parent and Child Configurations,
page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:
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Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
document link applies. For example, adding the QA
application would cause the document link to only
apply to matching quality assurance cases.

4. Add a document link by clicking Add linked document.
5. For each row of the table:

a. Select the link type. The following table describes the three available types:

Type Description

Relation The document link is derived from a relation.

Select a relation name and type.

VD and Relation The document link is derived from a virtual
document and a relation.

Select a relation name and type.

VD The document link is derived from a virtual
document.

b. Select the creation profile for the content being created.
c. Type the message shown before creating the document.
d. Select one of the following:

• Required to require the end user to configure a linked document.
• Silent creation to create the linked document as a background process.
Always select a default value template when using silent creation to avoid property
inheritance errors.

If you select Required or leave both options unselected, D2 Client shows end users the
message typed in step 5c.

6. Click Save.

Configuring Checkin
1. Navigate to Go to > Checkin from the menu bar.
2. Click New to create a checkin setting.

If you want to create a child checkin setting that inherits the properties of an existing checkin
setting, select a checkin setting and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.
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Field Description

Description Type a description.

Applications Add or remove the applications to which this
checkin setting applies. For example, adding the QA
application would cause the checkin setting to only
apply to matching quality assurance cases.

Silent checkin (in minor version) Select to have the checkin performed in the
background for minor versions.

Silent checkin (in same version) Select to have the checkin performed in the
background for same versions.

Allow major versions Select to allow checkin of major versions.

Display log entry Select to show the Log entry property for the user
to add comments during checkin. The comments
are saved in the log_entry property and can be
shown in the audit.

Require log entry Select to make log entry required.

Reset log entry before each checkin Select to clear the Log entry field after each
checkin.

Allow checkin from file Select to allow checkin from the file, such as when
importing content as a new version.

Request new rendition Select to request new renditions of the content.

Keep symbolic version label You can configure processes such as lifecycles
to apply additional labels on the content version.
Select this option to keep the label on the current
version.

For example, if you apply the DRAFT label, D2
shows the current content as:

• 1.0,CURRENT,DRAFT

If this option is selected and an end user creates a
new minor version, D2 transfers the version labels:

• 1.1,CURRENT,DRAFT

• 1.0

If this option is not selected and an end user creates
a new minor version, D2 keeps the additional labels
on the version in which they were introduced:

• 1.1,CURRENT

• 1.0,DRAFT

4. Click Save.

Configuring Checkout
1. Navigate to Go to > Checkout from the menu bar.
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2. Click New to create a checkout setting.

If you want to create a child checkout setting that inherits the properties of an existing checkout
setting, select a checkout setting and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
checkout setting applies. For example, adding the
QA application would cause the checkout setting to
only apply to matching quality assurance cases.

Allow checkout Select to allow content checkout.

Warning message Select to show a warning message before checkout.

Warning message <language> Type a warning message.

4. Configure checkout settings for XML applications:

Field Description

Checkout range Select the scope.

Checkout support documents as well Select to checkout supporting documents included
in the DocApp.

5. Click Save.

Configuring Uniqueness Check
You can configure D2 to check for content uniqueness using DQL qualification.
1. Navigate to Go to > Uniqueness check from the menu bar.
2. Click New to create a uniqueness check.

If you want to create a child uniqueness check that inherits the properties of an existing uniqueness
check, select a uniqueness check and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
uniqueness check applies. For example, adding the
QA application would cause the uniqueness check to
only apply to matching quality assurance cases.

4. Click Add a check to add a DQL qualification:
a. You can use $value and #repeatingvalue in Qualification andMessage.
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b. Fill out the row as described in the following table:

Field Description

Qualification Type a DQL directive.

Message <language> Type a warning message for when the content is
not unique.

5. Click Save.

Configuring Mass Update
You can allow users to update multiple content with a single process using the mass update component.
1. Navigate to Go to >Mass update from the menu bar.
2. Click New to create a mass update.

If you want to create a child mass update that inherits the properties of an existing mass update,
select a mass update and click Create from. Understanding Parent and Child Configurations, page
16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
mass update applies. For example, adding the QA
application would cause the mass update to only
apply to matching quality assurance cases.

Do not display warning message Select to prevent D2 Client from showing a warning
message for confirming the mass update.

Do not display mass update options dialog Select to prevent D2 Client from showing the dialog
box for end users to fill out the mass update property
form.

Update virtual document and all descendants Select to update a virtual document and all of its
components. This option is disabled when you are
not configuring a virtual document property page.

Update folder and all sub-folders and objects Select to update sub-folders and content within
sub-folders. This option is disabled when you are
not configuring a folder property page.

Property page Select the property page the user fills out.

Display only for users in this group Select the user group that can use this mass update.

You can leave the field empty to allow all end users
to access this mass update configuration.

Label <language> Type a label.

4. Click Save.
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Chapter 4

Configuring Content Creation Defaults

This chapter contains the following topics:

• Understanding the Content Creation Process
• Configuring Creation Profiles
• Configuring Default Value Templates
• Configuring Linked Documents for Importing Emails
• Configuring Importing Email Attachments
• Configuring Importing Folder Structure
• Configuring XML Import

Understanding the Content Creation Process
End users can add content to the repository using two methods:

• Create content using a rendition format and template

• Import content from the local file directory

You need an additional configuration to allow end users to import attachments to email and
messages.Configuring Importing Email Attachments, page 58 contains further instructions.

You can configure actions requested of users and automated processes performed by D2 when content
is created or imported. Automated processes can help users avoid manual content management. Use
the following table to understand how to configure creation and import:

When content is created or configured, you can configure:

• A creation profile with at least one document type. Depending on the user group, application, and
method of creation, the end user can select a document type from a creation profile. The document
type applies property pages, default values, and so on to the created content.

If there is only one document type that the end user can select, the D2 Client content creation wizard
automatically selects the document type and skips the selection page. You can configure creation
profiles by context in this way to streamline the content creation process for end users.

For example, create a creation profile for the quality assurance writers group available for creation
and import, then create a document type for drafts. You can then set configuration elements such as
the quality assurance property page, a default value template, and so on.

Configuring Creation Profiles, page 54 contains further instructions.
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• A default value template to set initial property values. Default value templates set values to
properties during content creation when the creation profile using the template is used. The end
user can then edit the property page.
For example, create a default value template that sets the keywords quality assurance and Draft, uses
the quality assurance property page, and enters the content into the quality assurance documentation
workflow.
Configuring Default Value Templates, page 56 contains further instructions.

• Configuration components and contexts to apply to the content. You can configure content-related
configuration components such as property pages, permissions, inheritance, automatic file renaming,
and so on. When the end user saves the property page during creation, D2 checks for context
matches and runs the applicable configuration elements on the content.
For example, create configuration elements such as a quality assurance Draft security and
autonaming of the file to conform with quality assurance documents. Create a context that applies
for all dm_document content for quality assurance with the a_status Draft. After enabling the
corresponding cell in the configuration matrix, whenever the end user creates a quality assurance
document with the Draft status, D2 applies the configuration elements.
Determining Which Creation Processes to Use, page 25 contains further information about
creation-related configuration components.

Configuring Creation Profiles
Before configuring creation profiles, configure the following components:

• Dictionary (required)
• Taxonomy
• Context (required)
• Property page (required)
• Inheritance
• Default value template
• Autonaming
• Autolinking
• Lifecycle
• Workflow
1. To configure:

• A non-context-based creation profile, navigate to Creation > Creation profile from the menu
bar.

• A context-based creation profile, navigate to Go to > Extended creation profile from the
menu bar. An extended creation profile must be mapped to a context for the content type
dm_folder. If an extended creation profile applies to content, the end user does not see
regular creation profiles.

2. Click New to create a creation profile.

If you want to create a child creation profile that inherits the properties of an existing creation
profile, select a creation profile and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.
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3. Fill out the form as described in the following table:

Field Description

Name Type a name. The name appears in the configuration
profile for extended creation profiles.

Description Type a description.

Label Type a label.

Available for Select the creation method for which the profile is
eligible. Only for a regular creation profile.

• Select Create & Import to allow end users to
select the creation profile in both content creation
and import.

• Select Create to allow end users to select the
creation profile during content creation but not
during content import.

• Select Linked document to allow end users
to configure linked documents during content
creation and import.

Users group Select the user groups for which the creation profile
applies. Only for a regular creation profile.

Folder properties used for creation Select one or more properties. D2 only shows the
creation profile for folders when the list properties
match the Name of the creation profile. Leave this
field blank if you do not want to restrict the creation
profile by any property. Only for a regular creation
profile.

For example, you can name a creation profile
Project A and type the keywords property for
this field. The end user does not receive the option
to select this creation profile unless the content
being edited contains Project A as a keyword.

Hide inheritance tab Select to hide the inheritance options from the
creation profile.

If you hide the inheritance tab, no properties and
content are inherited during creation and import.

Properties inheritance Select to enable inheritance of content properties.

Content inheritance Select to enable inheritance of parent content.

VD structure inheritance (D2 Client 3.1 only) Select to enable inheritance of
virtual document structure.

4. Add or remove dictionaries and properties to the creation profile.

5. Use the list controls to add and remove document types and fill out the fields as described in
the following table:

a. Fill out the default fields as described in the following table:
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Field Description

Property Select a property to which the value selected from
the dictionary is saved.

Values Select the values from the dictionary to which the
document type relates.

Type Select the content type.

Property pages Select the property page applied to the content.

Version Type the starting version number of the new
content.

Inheritance Select the inheritance rule applied to the content.

Default values template Select the default value template applied to the
content.

Lifecycle Select a lifecycle to which the content is entered.

The lifecycle sets the status of the content to the
initial state, and if the lifecycle is set to Execute
actions on start, the first action is executed.

Workflow (D2 Client 3.1 only) Select a workflow that the
content executes after the create or import process.

b. Click Add column to add a column to the document types.
6. For extended creation profiles, toggle the configuration for contexts in the configuration profile.
7. Click Save.

Configuring Default Value Templates
You can use default value templates to define the default values assigned to properties when content
is created.
1. Navigate to Creation > Default value templates from the menu bar.
2. Click New to create a default value template.

If you want to create a child default value template that inherits the properties of an existing default
value template, select a default value template and click Create from. Understanding Parent and
Child Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name.

Description Type a description.

Applications Add or remove the applications to which this default
value template applies. For example, adding the QA
application would cause the default value template
to only apply to matching quality assurance cases.

4. Click + to add properties and their default values:
a. Select a property in the Properties list box.
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b. Type the default value for the selected property n the Default values field.

The keywords you can use in the default values field are as described in the following table:

Keyword Description

$FILENAME The file name.

During content export, you can store the file name
into properties other than the object_name by
using this keyword.

During content import, the file name of
the imported file is stored in the property
corresponding to the $FILENAME value in the
template.

$USER The connected user.

$dqlvalue("<DQL>") A DQL query.

$TODAY The current date.

$NOW The current date and hour.

$ALIAS The alias.

5. Click Save.

Configuring Linked Documents for Importing
Emails
If an end user imports an email without any attachments, the creation wizard skips the linked
document steps.
1. Navigate to Go to > Linked document from the menu bar.
2. Click New to create a document link.

If you want to create a child document link that inherits the properties of an existing document link,
select a document link and click Create from. Understanding Parent and Child Configurations,
page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
document link applies. For example, adding the QA
application would cause the document link to only
apply to matching quality assurance cases.

4. Add a document link by clicking Add linked document.
5. For each row of the table:

a. Select the link type. The following table describes the three available types:
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Type Description

Relation The document link is derived from a relation.

Select a relation name and type.

If the linked documentation configuration is used
by an end for importing an email, D2 Client only
allows end users to select the first configured
relation.

VD and Relation The document link is derived from a virtual
document and a relation.

Select a relation name and type.

VD The document link is derived from a virtual
document.

b. Select the creation profile for the content being created.
c. Type the message shown before creating the document.
d. Select one of the following:

• Required to require the end user to configure a linked document.
• Silent creation to create the linked document as a background process.
Always select a default value template when using silent creation to avoid property
inheritance errors.

If you select Required or leave both options unselected, D2 Client shows end users the
message typed in step 5c.

6. Click Save.

Configuring Importing Email Attachments
You can configure content import such that when an end user imports an email with an attachment,
the attachment is processed and saved to the repository as a rendition. The content types accepted
are .eml or Outlook formats.
1. Navigate to Creation >Mail attachments from the menu bar.
2. Fill out the form as described in the following table:

Field Description

Import attachments Select to enable import of attachments.

When selected, the D2 Client user interface shows
a checkbox asking users if they want to import the
attachments.

Keep initial mail format Select to retain the format of the attachment.

Make a rendition Select to export the email as a rendition.

• Keep attachments in rendition: select to include
email attachments in the rendition.

• Rendition format: select the file format to save
the email.
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3. Use the list controls for Excluded attachment document format to add or remove accepted
file formats.

4. Click Save.

Configuring Importing Folder Structure
Note: This is applicable for D2 Client 3.1 only. You can import a folder and its subfolders and content,
and configure the folder type, security, and default autolink rules for the folders.
1. Navigate to Go to > Structure import from the menu bar.
2. Click New to create a folder structure import setting.

If you want to create a child folder structure import setting that inherits the properties of an
existing folder structure import setting, select a folder structure import setting and click Create
from. Understanding Parent and Child Configurations, page 16 contains more information on
child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this folder
structure import setting applies. For example,
adding the QA application would cause the folder
structure import setting to only apply to matching
quality assurance cases.

4. Set import settings as described in the following table:

Field Description

Folder Root type Select the folder type applied to the root folder.

Autolink for Root Select the autolink rule you want to use for placing
the folder.

Folder type Select the folder type applied to subfolders.

Security for tree folder Select the security configuration you want used on
the root folder and all subfolders.

5. Click Save.

Configuring XML Import
Use XML import for the integration of:

• Large amounts of data, such as migrating a content management system or importing a content
dump from an external application.

• Content on a routine basis, such as the daily retrieval of content produced by another application.
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For example, you can configure an external application to save content to a specific folder. You
can then configure the XML import component of D2 to scan the folder on a regular basis. D2
automatically imports content found into the repository.

1. Create a folder on the Content Server to store content imported into the repository.

2. In Documentum Administrator, configure D2JobImportMassCreate similarly to the example
described in the following table:

If you are using a creation profile If you are not using a creation profile

-folder C:/d66_02/import -folder C:/d66_02/import

-naming false -naming false

-createconfig matrix_name

-args argument_name

List of D2 Jobs, page 171 contains further information.

3. In Documentum Administrator, configure D2JobCoreDeQueue similarly to the following example:

-scan_queue true

-naming true

-create true

List of D2 Jobs, page 171 contains further information.

4. Create an XML file to function as a metadata template for the content imported from the folder.
The XML must contain:

• A root element: <?xml version="1.0" encoding="UTF-8"?>

• Documentum attribute values: <d2_import_xml> followed by properties, such as title,
authors, and keywords. The specific properties used in the XML file depend on the
configuration of the content type and property page. You can designate a property as a repeating
property by adding the <value/> tag.

• The same file name as the content to be imported. To import only the properties of content, name
the XML file <filename of the content>-meta.xml

• If you did not use a creation profile using -createconfig, specify the r_object_type
to determine the context and configuration components to use. If you do not set an
r_object_type nor a -createconfig, D2 does not perform the import operation.

The D2JobImportMassCreate scans the folder as according to the configured interval, and
D2JobCoreDeQueue browses the d2c_mass_create_queue to apply job parameters and
D2CoreMethod to import the content into the repository.
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Chapter 5
Configuring Content Processes
Components

This chapter contains the following topics:

• Understanding Lifecycles
• Configuring a Lifecycle
• Configuring a Lifecycle Batch
• Understanding Workflows
• Configuring a Workflow

Understanding Lifecycles
A lifecycle is a sequence of states and is used to:

• Denote the status of the content as it passes from one business protocol to another.
• Apply and change content retention and markup policies.

The following table describes an example lifecycle:

State Conditions Next state

Draft None Reviewed

Reviewed Content is in Draft state

r_lock_owner is empty

Draft

Approved: requests electronic
signature

Approved Content is in Reviewed state

Content is a PDF

None

In this example:

• Content can progress from Draft to Reviewed to Approved. Content can progress by repeatedly
going to Draft after Reviewed.

• If you progress from Reviewed PDF to Approved, the system confirms the conditions have been
met. If this progression requests an electronic signature, a prompt appears. When you electronically
sign the approval, the system progresses the state to Approved.

• If you try to progress a spreadsheet instead of a PDF, the system rejects the progression request
because one of the conditions was not met.

For each state, you can configure:

• Entry conditions for the state, such as conditions based on properties, permissions, and linked
content.
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• Actions to execute when moving to the next step, such as filling a property, creating a version,
applying security, and changing the document state.

• Next states and transitions between states, such as popup dialog boxes, messages, and menu labels.

Configuring a Lifecycle
1. Navigate to Go to > Lifecycle from the menu bar.
2. Click New to create a lifecycle.

If you want to create a child lifecycle that inherits the properties of an existing lifecycle, select a
lifecycle and click Create from. Understanding Parent and Child Configurations, page 16 contains
more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Select a lifecycle.

Description Type a description.

Applications Add or remove the applications to which this
lifecycle applies. For example, adding the QA
application would cause the lifecycle to only apply
to matching quality assurance cases.

Execute actions on start Select to execute actions related to the lifecycle
when an end user starts the lifecycle.

Alternate attribute for state (default is a_status) Select a property to control the state of the content.

4. Click Add lifecycle state to add a state to the lifecycle:
a. Type a name for the lifecycle state.
b. Select Start state to initialize the content with the selected state.
c. Select Direct state if all states of the lifecycle can access the state.

5. Configure the entry conditions for each Lifecycle state:
a. Use the list controls to add, remove, and reorder entry conditions.
b. Fill out the form as described in the following table depending on the entry condition selected:

Entry condition Description

Condition VD children Select the lifecycle state that is required of all
virtual document components, type a DQL request
to filter virtual document components, and type a
warning message that appears when the condition
is not met.

Condition check by Method Select the method to run for verifying that the
condition is met, type arguments and parameters
required by the method, and type a warning
message that appears when the condition is not
met.
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Entry condition Description

Condition on group Select whether the group was Saved in a property
or whether the end user types the group name
using Free input. Type the property that contains
the group or group name, select the dictionary and
alias, and type a warning message that appears
when the condition is not met.

Condition on linked document Select the relation type for the linked documents,
select the lifecycle and state to which the linked
documents are to be set, and type a warning
message that appears when the condition is not
met.

Condition on property Select the property, operation, and value for a
property-based condition, and type a warning
message that appears when the condition is not
met.

Condition on rendition Select the required rendition format, and type a
warning message that appears when the condition
is not met.

Condition on uniqueness Select the configured uniqueness check that must
be passed, and type a warning message that
appears when the condition is not met.

Condition permission Select the minimum permission level required,
and type a warning message that appears when
the condition is not met.

6. Click a state from Lifecycle state to configure the actions of each lifecycle state:
a. Click Add action and select an action.
b. Fill out the form as described in the following table depending on the action selected:

Action Description

Action on VD children Select the lifecycle state you want to apply to all
virtual document components and select actions
you want ignored.

Apply autolink No entry required. By default, D2 uses the highest
priority configuration in the configuration matrix.

Apply autonaming No entry required. By default, D2 uses the highest
priority configuration in the configuration matrix.

Apply method Select the method to run against the content and
type the arguments and parameters required.

Apply parameters No entry required. By default, D2 uses the highest
priority configuration in the configuration matrix.

Apply security No entry required. By default, D2 uses the highest
priority configuration in the configuration matrix.

Change linked document state Select the relation type for the linked documents,
select the relation direction between the parent
and child documents, and select the lifecycle and
state to which the linked documents are set.
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Action Description

Change other versions state Select the state you want other versions to be set
to and type a DQL query to further specify the
versions.

Copy repeating property Select the repeating property you want to copy,
the copy operation, the target property, and select
Remove duplicate values if you want to remove
duplicate values.

Make version Select the type of versioning you want to perform.

Manage distribution Select the distribution configuration and action
you want to use.

Mark Type a version label to with value.

Remove other versions Select Authorize destruction of annotated
document to enable removal of annotated content
and type a DQL query to further specify the
versions.

Rendition request No entry required.

Send email Select the mailing list configuration.

Send in workflow Select the workflow configuration and type a
name and note for the workflow being entered.

Set property Select the property and type the value to assign.

Set repeating property Select the repeating property and the set operation,
type the value you want to assign, then select
Remove duplicate values to remove duplicate
values.

Snapshot Type a title.

Unmark Type a version label to with value.

Work offline No entry required.

Delete this action No entry required.

c. Use Action up and Action down to reorder the lines in the table of actions..
7. Click a state from Lifecycle state to configure next states and transition condition:

a. Click Add transition and select a next state.
b. Fill out the form as described in the following table:

Field Description

Type Select the type of transition to perform during this
state change.

Action to perform (For D2 3.1 only) Select the type of action to
perform.

• Checkin: check in the content.

• ExportFile: export the content.

• Insert PDF: insert a PDF inside the rendition.
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Field Description

Dialog box Select the dialog box to display as a popup form
for the end user to fill.

Trigger event for transition Select the event that serves as a trigger for
automatic progression of the lifecycle.

• Check in: lifecycle progresses when checked
in.

• (For D2 3.1 only) Cancel checkout: lifecycle
progresses when checkout is canceled.

• D2 import: lifecycle progresses when the file is
imported.

Menu label <language> Type a menu label that is visible when the end
user opens the lifecycle context menu.

Electronic signature required Select to require the reason with the electronic
signature.

Intention required Select to require an electronic signature to end the
lifecycle state.

Intentions dictionary Select a dictionary to enable users to select a
reason from a list of options.

Confirmation message <language> Type a confirmation message.

c. Configure the entry conditions for each transition.

8. Configure the transition conditions for each Lifecycle state:
a. Select a Next state to set a transition condition from the selected lifecycle state to the selected

next state.

b. Use the list controls to add, remove, and reorder transition conditions.

c. Fill out the form as described in the following table depending on the transition condition
selected:

Entry condition Description

Condition VD children Select the lifecycle state that is required of all
virtual document components, type a DQL request
to filter virtual document components, and type a
warning message that appears when the condition
is not met.

Condition check by Method Select the method to run for verifying that the
condition is met, type arguments and parameters
required by the method, and type a warning
message that appears when the condition is not
met.

Condition on group Select whether the group was Saved in a property
or whether the end user types the group name
using Free input. Type the property that contains
the group or group name, select the dictionary and
alias, and type a warning message that appears
when the condition is not met.
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Entry condition Description

Condition on linked document Select the relation type for the linked documents,
select the lifecycle and state to which the linked
documents are to be set, and type a warning
message that appears when the condition is not
met.

Condition on property Select the property, operation, and value for a
property-based condition, and type a warning
message that appears when the condition is not
met.

Condition on rendition Select the required rendition format, and type a
warning message that appears when the condition
is not met.

Condition on uniqueness Select the configured uniqueness check that must
be passed, and type a warning message that
appears when the condition is not met.

Condition permission Select the minimum permission level required,
and type a warning message that appears when
the condition is not met.

9. Click Save.

Configuring a Lifecycle Batch
You can configure lifecycle batches to control lifecycles for all content assigned to a context
simultaneously. For example, you can create the Draft, Review, and Approved folders, and configure
a context for each folder. Using autolink, you can configure D2 to place content created by an end
user in the Draft folder. You can configure D2 to pass all content automatically within the Draft
folder through the Review and Approved folders.

Lifecycle batches use the D2JobLifecycleBatch job. List of D2 Jobs, page 171 contains further
information.
1. Navigate to Go to > Lifecycle batch from the menu bar.
2. Click New to create a lifecycle batch.

If you want to create a child lifecycle batch that inherits the properties of an existing lifecycle batch,
select a lifecycle batch and click Create from. Understanding Parent and Child Configurations,
page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Select a lifecycle batch.

Description Type a description.

Applications Add or remove the applications to which this
lifecycle batch applies. For example, adding the QA
application would cause the lifecycle batch to only
apply to matching quality assurance cases.
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Field Description

Lifecycle Select the lifecycle you want to use.

Target state Select the target state.

Transition type Select the type of transition performed.

4. Click + to add and configure properties modified by the lifecycle batch.

Configure each property as described in the following table:

Field Description

Property Select a property from the list box.

Value Type the value of the property.

5. Click Save.

Understanding Workflows
A workflow is a formalized version of a business process which has been broken down into individual
tasks. Users use workflows to:

• Apply business processes into the lifecycle of a content.

• Support commenting, tracking of workflow progress, management of various participants, and
attaching of supplementary content.

You can use Documentum Workflow Manager to create and configure workflows, then install them
as templates into the repository. D2 Config recognizes the templates, allowing you to select the
templates when creating a workflow for use by users in D2 Client. In order to use a workflow template
in D2, the following conditions must be met:

• There must be a task.

• There must be a name for each task.

• There must be flow.

• There must be aliases for the recipients of the workflow.

• There must be triggers and transitions.

• There must be delegation if necessary.

• There must only be a single package from start to end.

Note: D2 workflows do not manage the Some users from group alias. You must configure workflows
to use either the All users from group alias or the Single user from group alias. When you use the All
users from group alias, a temporary group for the workflow instance is created and the list of recipients
can be specified.
Also, automated delegation is not supported.
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Configuring a Workflow
If you used Documentum Workflow Manager to create a workflow template, you can use D2 to
configure the workflow template to allow end users to perform business processes on content. When
configuring the workflow template in Workflow Manager:

• Create short aliases in the list of performers.
• Do not use spaces in the list of performers.
• Do not select Optional.
D2 creates groups in real time to represent performers.
1. Navigate to Go to >Workflow from the menu bar.
2. Click New to create a workflow.

If you want to create a child workflow that inherits the properties of an existing workflow, select
a workflow and click Create from. Understanding Parent and Child Configurations, page 16
contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Workflow label <language> Type a label that appears when the end user access
the workflow context menu.

Description Type a description.

Applications Add or remove the applications to which this
workflow applies. For example, adding the QA
application would cause the workflow to only apply
to matching quality assurance cases.

Workflow template Select a workflow template.

View Click to see a popup dialog with a graphical diagram
of the workflow template.

4. Click Add condition and select entry conditions for the workflow.

Fill out the form as described in the following table depending on the entry condition selected:

Entry condition Description

Condition on property Select the property, operation, and value for a
property-based condition, and type a warning
message that appears when the condition is not met.

Condition permission Select the minimum permission level required,
and type a warning message that appears when the
condition is not met.

Condition on group Select whether the group was Saved in a property
or whether the end user types the group name using
Free input. Type the property that contains the
group or group name, select the dictionary and alias,
and type a warning message that appears when the
condition is not met.
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Entry condition Description

Condition on rendition Select the required rendition format, and type a
warning message that appears when the condition
is not met.

Condition check by Method Select the method to verify that the condition is
met, type arguments and parameters required by the
method, and type a warning message that appears
when the condition is not met.

Condition on uniqueness Select the configured uniqueness check that must be
passed, and type a warning message that appears
when the condition is not met.

a. Use Condition up and Condition down to reorder conditions.
5. Configure workflow abort options as described in the following table:

Field Description

Lifecycle Select the lifecycle to use for an aborted workflow.

Target state Select the final state of the content.

Apply on attachments Select the checkbox to apply the state to all
associated content.

Note: During a workflow abort, the entry conditions set for the lifecycle state are not evaluated
when the state is changed.

6. Select a task from the Task configuration list. Manual tasks are shown with a white background,
while tasks that are automatically processed are shown with a gray background.

a. Fill out the Task parameters tab as described in the following table:

Field Description

Subject <language> Type a subject to appear in the D2 Client user
task inbox.

Use $value(<property name>) to refer
to properties.

Message <language> Type the email message.

Category <language> Type a category with which to associate the task
when an end user sorts the Workflow task browser
widget by category. You can create a subcategory
using / to designate a category path. For example,
to create the subcategory Reviewing under the
category Review Process, type Review
Process/Reviewing.

You can configure autolinks to organize the user
task inbox.

Priority Select a priority level for the task as it appears for
end users in their list of tasks.

Display task in workflow manager Select to show the task in the D2 Client workflow
manager for end users.
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Field Description

Manual acquisition Select to require users to manually acquire a task.
This is necessary when the manual task is set in
Workflow Manager to use a single user from a
group.

When not selected, tasks are automatically
considered being performed by the assigned user.
Requiring users to manually acquire tasks adds a
level of work to the end user in performing tasks,
but lets you see when an end user has seen and
acknowledged the task.

Check lifecycle consistency on task end Select to verify lifecycle entry conditions before
an end user accepts or rejects a task.

Always display dialog box Select to improve the speed of the validation
process by hiding dialog boxes such as the
comment box of a task.

Mandatory comments in case of reject Select to require end users to provide comments
when rejecting a task.

Mandatory comments in case of forward Select to require end users to provide comments
when forwarding a task.

Property page in case of reject Select a property page to show when an end user
rejects a task. The option enables end users to
supply additional information for the content.

Property page in case of forward Select a property page to show when an end user
forwards a task. The option enables end users to
supply additional information for the content.

Electronic signature required Select to require an electronic signature to end a
task.

Required for Select which progression case for which you want
an electronic signature.

Request a signature for each document Select if you want a signature for each attached
document.

Intentions dictionary Select a dictionary to enable users to select a
reason from a list of options.

Intention required Select to require the reason with the electronic
signature.

Audit information add-on Configure a manual tasks audit for electronic
signatures by typing additional audit information.

You can use the DQL keywords $value and
$dqlvalue for this field.

Audit task on acquisition Select to audit when users acquire a task.

Audit choice of next task Select to audit the progression of the task.

Don’t send notification for this task Select to avoid sending an email notification to
the workflow performer.
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You can use the $value keyword to use property values. For example,
$value(<document.property_name>) shows the property of a document.

You can use the $alias keyword to use a dictionary.

You can use HTML in the body of the email.

b. Fill out the Participants management tab as described in the following table:

Field Description

Task participant Type the alias of the group performing the task.

Can add or remove a task when the activity is
running

Select to allow current performers to add or
remove participants during workflow execution.

This option is only available for dynamic tasks.

Participants available and Participants modifiable Use the list controls to configure available and
modifiable participant lists.

Required Select if a participant must be assigned the task.

Type Select the user list to propose delegation.

You can use DQL or Dictionary to filter the list
of users.

You can use the DQL keyword $value.

c. Fill out the External task tab as described in the following table:

Field Description

Define external task Select to send an email to an external participant.

Attach document Select to allow attachment of documents.

Add workflow notes in the message Select to allow addition of workflow notes to the
message.

Add workflow scheme (HTML/VML) Select to allow addition of the workflow scheme
in HTML/VML format.

Add rendition with format Click Browse, then use the list controls to modify
the list of formats.

Checkin options Select Add as annotation to check in the change
as a content annotation.

Select Silent checkin minor version to check in
the change as a minor version and as a background
process.

Select Silent checkin same version to check
in the change without version control and as a
background process.

Select No checkin to not check in the change.

Log entry <language> Type a log entry.

Mandatory attached file in case of reject Select to require end users to attach a file if they
reject the task.

Add reply as a workflow note Select to add the mail message as a workflow note.
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d. Fill out the Task follow up tab as described in the following table:

Field Description

Task duration in days Type an integer for the total number of days
allotted for the task.

Add or delete followup procedures using Add notification and Delete this notification, and
configure the process as described in the following table:

Field Description

Remaining days before Type an integer for the number of days remaining
in the task.

When the number of days remaining until the task
deadline reaches the entered number, the follow
up process is triggered.

You can type a negative integer to send a
notification when the deadline has passed.

Notification recipients Select one or more of the following users to
receive the notification:

• Supervisor

• Task owner

• Other

If you select Other, you can use the DQL
keywords $value, $alias, and $dqlvalue.

Action You can select an action to perform on the
workflow when the follow up is sent.

Subject <language> Type the subject of the email.

Message <language> Type the message body of the email.

You can use the $value keyword to use property values. For example,
$value(<document.property_name>) shows the property of a document.

You can use the $alias keyword to use a dictionary.

You can use HTML in the body of the email.

e. Fill out the Reject follow up tab as described in the following table:

Field Description

Activities available Select an activity in the list and click > to enable a
follow up activity for this task.

Reject Follow up Activities Select an activity in the list and click < to disable
the activity as a follow up.

7. To configure a system task, fill out the form as described in the following table:

Field Description

Label <language> Type a label.

Transition type Select the transition type.
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Field Description

Lifecycle Select the lifecycle to use.

Target state Select the lifecycle state for the content.

Apply on attachments Select to add attachments during this process.

Add workflow properties Click Browse, then use < and > to modify the list
of additional properties.

For example, you can configure a workflow task
to require users to fill out a date property page.
The task can be performed at different stages
of the workflow by different user groups, such
as the Product team, the Testing team, and the
Management team. To keep and show the dates
input by the different teams, configure the date
property as a workflow property. If you do not
configure the property, you cannot display the dates.

Display task in workflow manager Select to show the task in the workflow manager.

8. To configure the performer list, configure the properties page using the editor. The buttons function
the same as in the property page. For each participant, fill out the fields shown for the selected
list control as described in the following table:

Field Description

Participant Select the participant being modified in this object.
D2 can manage only one participant alias per task.

Default value Type default values, such as user names.

Linked attribute Select a property. D2 sets the value of the property
as the list of performers listed under the alias. You
can use this property with a D2 security template to
ensure that workflow performers have access rights
to the documents in the workflow.

If the workflow is set to allow multiple performers
and the list of performers contains groups, D2 adds
the individual users contained in the groups when
the workflow is started. As a result, if a user is
removed from a group after the workflow is started,
D2 does not update the list of workflow performers
and the linked attribute. You must manually remove
users from the list of performers to update the linked
attribute.

Load asynchronously Select to load values on click and filter as opposed
to when the dialog box is opened. Use the option
when the list contains a large number of values.

Label <language> Type a label.

Read-only on startup Select to disable the field in the workflow startup
page.

Required on workflow start-up Select to make the field required when the end user
starts the workflow.
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Field Description

Type Select DQL or Dictionary to filter the list and select
or type the condition.

Rows number Type the number of rows the field shows.

Required values count Type the minimum number of values for accepting
the performer list.

Maximum values count Type the maximum number of values for accepting
the performer list.

Sort list Select to sort the list alphabetically.

Enable values import export Select to enable the import and export of the list of
performers in .xls format.

Popup width and Popup height Type the size of the popup dialog.

9. To prevent workflow supervisors from changing the list of performers:

a. In Participant’s Structure, select Read-only on startup for each performer.
b. On the Participants management tab, clear Can add or remove a task when the activity is

running and remove the performer from Participants modifiable.

D2 requires default values when workflow supervisors cannot change performers.

10.Use the list controls to reorder tasks.

11. Click Save.
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Configuring D2 Search

This chapter contains the following topics:

• Configuring Global Search Settings
• Configuring Advanced Search
• Configuring a Query Form Search

Configuring Global Search Settings
Configure the properties of the search engine, type, and results to apply to every search performed in
D2 Client.
1. Navigate to Interface > Search from the menu bar.
2. Select a dictionary as described in the following table:

Field Description

Dictionary for object type labels Select a dictionary to add specific labels to object
types.

Alias/Locale Select an alias or language.

3. Use the list controls to configure the Groups allowed to create public search. Users in the
selected groups can create and save public searches.

4. Configure the search engine as described in the following table:

Field Description

Maximum results returned by search Type an integer to restrict the number of maximum
returned results.

Type 0 to have all results shown.

Maximum number of asynchronous searches in a
user session

(D2 3.1 only)

Type an integer to restrict the number of
asynchronous searches that a user can launch.

Type 0 to allow an unlimited number of
asynchronous searches.

Enable full text search Select to enable full-text search.

By default only simple searches are performed.
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Field Description

Quick search on all versions (default is CURRENT) Select to enable quick search on all versions of
content.

By default quick search is only executed on current
versions of content.

Indexing engine choice Select the search engine used by D2.

If you do not enable full-text searches, you do not
have to select a search engine. Simple searches are
performed using DQL queries and do not need an
external search engine.

DQL Fulltext is the same as Documentum xPlore,
except that end users cannot configure and use
facets.

If you use Documentum xPlore, end users can set
D2 Client to highlight search terms in the search
results.

5. You can select and configure the OpenSearch Search engine for only the 3.1 version of D2 Client:
a. Configure the OpenSearch properties as described in the following table:

Field Description

Search Engine URL Type the search engine URL. You can define
parameters.

For example,
http://exalead:10000/D2–Client/
opensearch?q=corporate/tree:Top
security_user:"$USER" secu-
rity_group:"$USER_GROUPS"

Open in a new window Select the checkbox to open search results in a
new window in D2 Client 3.1.

HTTP Method Select the HTTP method to pass queries.

Number of results per page (if the user does not
have paging)

Type the number of results per page.

D2 uses the field only if you use $COUNTINDEX
in the parameter list or in the search engine URL.

XSLT to use Select the OpenSearch stylesheet for
transformation (XSLT) operation to use.

Add XSLTs to D2 by naming the stylesheets
opensearch-<name>.xsl and placing them
in the /system/D2/OpenSearch folder. D2
automatically places all XSLTs found in the list
box.

By default D2 uses the first XSLT it finds.

b. Configure extensions to the search engine URL request to improve interoperability.
c. Click Add a search extension to add a search extension.
d. Fill out the Search Extension table as described in the following table:
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Field Description

Name Type a name for the search extension.

Value Type one of the available alias for the search
extension.

$STARTINDEX defines the starting index value
of the pagination of results.

$COUNTINDEX defines the number of results per
page.

$USERGROUP resolves the list of groups to which
the user belongs.

$USERTICKET resolves the Documentum ticket
of the user.

$DOCBASE resolves the repository name for
which the search is being performed.

Type Select refine to refine the search term.

Select param to add a security parameter.

6. If you select the Documentum xPlore search engine, fill out the form as described in the following
table:

Field Description

Use xPlore for all searches (even the one without
full-text criteria)

Select to enable xPlore for all searches.

You can configure the length of the search summary
D2 shows when configured to use xPlore. The
EMC Documentum xPlore Administration and
Development Guide contains further information.

Enable Facets Select to enable search facets.

Facets represent one or more important
characteristics of an object in the Documentum
object model. Configure facets to search large
data sets without explicit queries and to avoid
queries that do not return desired results. The EMC
Documentum System Search Development Guide
contains further information about facets.

Configuring Advanced Search, page 78 contains
further information on how to configure properties
for use as facets.

Maximum number of result by Facet Type the number of property values retrieved by
facets.

7. Click Save.
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Configuring Advanced Search
Use search mapping to enable types and properties that have been defined in the repository for
advanced searches. You can construct different search modules in accordance with different contexts.
1. Navigate to Go to > Search from the menu bar.
2. Click New to create an advanced search.

If you want to create a child advanced search that inherits the properties of an existing advanced
search, select an advanced search and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
advanced search applies. For example, adding the
QA application would cause the advanced search to
only apply to matching quality assurance cases.

4. Use the list controls to configure the list of available types for Type.
5. Select an available type, select a property, and use the list controls to configure the list of

Properties of selected type.
6. Select a property and select Dictionary or DQL to create input assistance:

a. If you select Dictionary, select a dictionary from the Dictionary list box, then an alias or
a language from the Alias/Locale list box.

b. If you select DQL, type a DQL query in the Query field.
NoteTo ensure that a single document with multiple dates in a custom repeating date field
displays as a single result in the search results:

1. Configure server.ini of Content Server with
return_top_results_row_based=false in the [SERVER_STARTUP] section.

2. Include r_object_id in the SELECT statement of your DQL query.
c. Select Use this property as a facet to allow end users to select the property as a facet in

searches.
d. Select Facet selected by default for quick searches to have quick searches use the property

as a facet.
7. Click Save.

Configuring a Query Form Search
Use query form searches to provide property templates to end users of D2 Client. End users can select
a query form, fill out the properties, then search. The alternatives would be to perform:

• A standard search, in which end users can only input a general query.
• An advanced search, in which an end user must specify the properties they wish to use.
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1. Navigate to Go to > Query form from the menu bar.

2. Click New to create a query form.

If you want to create a child query form that inherits the properties of an existing query form, select
a query form and click Create from. Understanding Parent and Child Configurations, page 16
contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this query form applies.
For example, adding the QA application would cause the query
form to only apply to matching quality assurance cases.

Label <language> Type the form label.

Property page Select the property page to display for the search from the list
box.

You can preview the property page by clicking the magnifying
glass.

Default value Select a default value template to add values to the properties.

Note: For repeating attribute r_creation_date, if the field
is non-mandatory and blank in the query form, then a default
value of 01/01/1970 is used.

DQL Type a DQL query using the attributes of the property page.
Use $value(<property name>) to retrieve the values of
different properties.

Ensure that the DQL query is selective. Neither theMaximum
results returned by search field in the global search
configuration page nor the dfc.search.max_results
options in D2FS.properties affect the result size returned
by query forms. End users could experience performance issues
when a large number of search results are returned.

Note: To ensure that a single document with multiple dates in
a custom repeating date field displays as a single result in the
search results:

1. Configure server.ini of Content Server with
return_top_results_row_based=false in the
[SERVER_STARTUP] section.

2. Include r_object_id in the SELECT statement of your
DQL query.
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Field Description

Add mandatory attributes in hidden
mode

Select the option to retrieve properties required for content
control in the search results.

If you do not select the option, the search result returns an
informational listing of matching content. In this state, you
cannot make any changes to the retrieved content, including
launching a lifecycle.

If you select this option, some of the attributes included in the
query may not be displayed in the results, as they are added in
hidden mode. For example, r_lock_owner attribute.

Add the user column preferences Select the option to retrieve content properties matching the
column preferences of the user.

If you do not select the option, added columns using properties
that are not automatically retrieved for showing search results
remain blank.

4. Add the query form to a search category so that end users can locate it for use:

a. In the Existing categories browser, navigate to the folder in which you want to add the query
form.

b. Type /<folder name> in Path.
c. Type a description for the category.

d. You can configure the name, title, and user group permissions of a category by right-clicking
the category and selectingModify search category.

5. Click Save.
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Chapter 7
Configuring Administrator-to-User
Communication

This chapter contains the following topics:

• Understanding How to Communicate with Users Through D2 and Email
• Configuring the Mail Server
• Configuring a Mailing List
• Configuring Options for Sending Emails through D2
• Configuring a Subscription
• Configuring a Distribution

Understanding How to Communicate with
Users Through D2 and Email
If you have an email server to which D2 connects and communicates, you can configure:

• Mailing lists that end users can use to send pre-configured batch emails.
• The ability for end users to send emails directly from the D2 interface instead of having to open up
an email application.

• Distributions that end users can use to create an email-based distribution of content for expedited
and external validation.

• Subscriptions” that end users can use to receive email notifications for events, such as workflow and
lifecycle tasks. An end user who creates or owns the subscription does not receive notifications
even if the end user had configured to receive the subscription.

Configuring the Mail Server
1. Navigate to Tools > Email from the menu bar.
2. Fill out the Email server form as described in the following table:

Field Description

Protocol Select the mail protocol used by the server.

Using SSL Select to use an SSL connection.

Server Type the server address for the email server.

Port Type the port number for the server.

Login Type the username for the email address to use
when sending messages.
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Field Description

From address Type an address to mask the sender email.

Password Type the password for the username.

From name Type the name to use when sending messages.

The email server is used for sending emails.

3. Fill out the Email reception server form as described in the following table:

Field Description

Protocol Select the mail protocol used by the reception server.

Using SSL Select to use an SSL connection.

Server Type the server address for the email server.

Port Type the port number for the server.

The reception server is checked for received emails.

4. Fill out the Accepted task account form as described in the following table:

Field Description

Login Type the username for the email address to use
when accepting tasks.

Address Type an address to mask the sender email.

Password Type the password for the username.

When using the email reception server, D2 logs into the accepted task account to accept tasks.

5. Fill out the Rejected task account form as described in the following table:

Field Description

Login Type the username for the email address to use
when rejecting tasks.

Address Type an address to mask the sender email.

Password Type the password for the username.

When using the email reception server, D2 logs into the rejected task account to reject tasks.

6. Fill out the Administration of errors into external task inbox form as described in the following
table:

Field Description

Send back mail on task error Select to send mail back to the sender if the email
address used by the task assignee returns an error.

Active mail history Select to enable keeping a history of emails,
including duplicate messages, in the event that a
message is sent back in the above option.

7. Click Add a notification to add an event:

Fill out the form for each row as described in the following table:

82

EMC Documentum

Version 4.2 Administration Guide



Configuring Administrator-to-User Communication

Field Description

Event Select or type the event to use from the list box. D2
accepts Documentum audit events as a trigger for
sending a notification.

For example, if you want D2 to send a notification
when a workflow is started, select or type
d2_workflow_started

Subject <language> Type the subject of the email.

Message <language> Type the body of the email.

You can use the $value keyword to use property values. For example,
$value(<document.property_name>) shows the property of a document.

You can use the $alias keyword to use a dictionary.

You can use HTML in the body of the email.

8. Click Save.

Configuring a Mailing List
1. Navigate to Go to >Mailing list from the menu bar.
2. Click New to create a mailing list.

If you want to create a child mailing list that inherits the properties of an existing mailing list, select
a mailing list and click Create from. Understanding Parent and Child Configurations, page 16
contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
mailing list applies. For example, adding the QA
application would cause the mailing list to only
apply to matching quality assurance cases.

Attach document Select to allow attaching of documents.

Attach rendition with format Click Browse, then use→ and← to configure the
list of allowed rendition formats.

The end user can only add attachments that have an
allowed rendition format.

4. Click + to add a recipient, then select or type a recipient.

Use the following table to understand the options shown:

Field Description

User Select a user from the list box.
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Field Description

Group Select a user group from the list box.

Property value Select a property to use the value of the property
as the recipient.

Email address Type an email address.

5. Fill out the content of the email as according to the following table:

You can use the DQL keyword $value(<property name>).

The body accepts HTML.
Field Description

Email subject <language> Type the subject of the email.

Email message <language> Type the body of the email.

You can use the $value keyword to use property values. For example,
$value(<document.property_name>) shows the property of a document.

You can use the $alias keyword to use a dictionary.

You can use HTML in the body of the email.

6. Click Save.

Configuring Options for Sending Emails
through D2
1. Navigate to Go to > Send mail from the menu bar.
2. Click New to create anemail sending option.

If you want to create a child email sending option that inherits the properties of an existing email
sending option, select an email sending option and click Create from. Understanding Parent and
Child Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:
Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this email
sending option applies.

For example, if you add the Quality
Assurance application, D2 makes the
configuration available only when an end user
interacts with content recognized by the Quality
Assurance application

Enable external recipients Select to allow end users to add email addresses of
recipients outside of the repository when sending an
email through D2 Client.
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Field Description

Enable attachments Select to allow end users to add attachments when
sending an email through D2 Client.

Email subject <language> Type the subject of the email.

Email message <language> Type the body of the message.

You can use DQL substitutions such as $value(object_name) in the email subject and
message. To specify the smart URL for the selected content item, use $value(locate_url)

4. Click Save.

Configuring a Subscription
1. Navigate to Go to > Subscription from the menu bar.
2. Click New to create a subscription.

If you want to create a child subscription that inherits the properties of an existing subscription,
select a subscription and click Create from. Understanding Parent and Child Configurations, page
16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
subscription applies. For example, adding the QA
application would cause the subscription to only
apply to matching quality assurance cases.

Differ notifications Select the option to send notification events
to the intermediate queue subscription_audit.
After treating the queue, D2 launches the job
D2JobSubscriptionSendMail to send the notification
email to subscribed users.

When using the delayed notification
feature, configure the email message using
$foreachdoc{} to list the documents.

For example, $foreachdoc{$value(ti-
tle),
$value(r_modifier)}

As D2JobSubscriptionSendMail sends a single
message that can contain events for multiple
documents, not configuring the message with the
above syntax can cause confusion.

Label <language> Type a label.

4. On the Events tab, click Add an event to add an event:
a. Select an event to audit.
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You cannot use the following events for event subscriptions because they do not apply to
content:

• d2_template_
• d2_taxonomy
• d2_dictionary
• d2_workflow_added
• d2_workflow_removed
• d2_workflow_sent_
• d2_delegation
• d2_connect
Event names may be suffixed by one or more characters.

b. Type a DQL qualification to filter the event. If you want to configure more than one condition
for an event, change the DQL qualification for the event instead of adding another instance of
the event because you can only save one instance of a configuration for an event. For example,
to configure an event for one of two titles, use the following query:

title=’toto’ or title ’titi’

5. Select the Email tab to configure notification parameters as described in the following table:

Field Description

Attach document Select to attach content to the notification message.

Attach rendition with format Click Browse to add a rendition format.

Email subject <language> Type the subject of the email.

Email message <language> Type the body of the message.

You can use the $value keyword to use property values. For example,
$value(<document.property_name>) shows the property of a document.

You can use the $alias keyword to use a dictionary.

You can use HTML in the body of the email.

6. Click Save.

Configuring a Distribution
1. Navigate to Go to > Distribution in the menu bar.
2. Click New to create a distribution.

If you want to create a child distribution that inherits the properties of an existing distribution,
select a distribution and click Create from. Understanding Parent and Child Configurations, page
16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.
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Field Description

Description Type a description.

Applications Add or remove the applications to which this
distribution applies. For example, adding the QA
application would cause the distribution to only
apply to matching quality assurance cases.

Attach document Select to attach content to the distribution email.

Attach rendition with format Click Browse to add the rendition formats you want
to use when sending content.

Label <language> Type a label.

Property page Select a property page.

You can click the magnifying glass to preview the
page.

Attribute which contains recipients Select a property that contains the list of recipients.

Email subject <language> Type the subject of the email.

Email message <language> Type the body of the message.

Electronic signature Select to require an electronic signature during when
accepting a distribution and rejecting a distribution.

Intention required Select to require the reason with the electronic
signature.

Intentions dictionary Select a dictionary to enable users to select a reason
from a list of options.

You can use the $value keyword to use property values. For example,
$value(<document.property_name>) shows the property of a document.

You can use the $alias keyword to use a dictionary, and you can use HTML in the body of
the email.

4. Click Save.
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Configuring External Services

This chapter contains the following topics:

• Configuring a Rendition Server Connection
• Configuring an Advanced Documentum Transform Services (ADTS) Rendition

Server Connection
• Enabling a Branch Office Caching Service (BOCS) Element

Configuring a Rendition Server Connection
You cannot configure specific connections to rendition servers through D2 Config. Use D2 Config to
send events and messages to preconfigured queues.
1. Navigate to Go to > Rendition server from the menu bar.
2. Click New to create a rendition server connection.

If you want to create a child rendition server connection that inherits the properties of an
existing rendition server connection, select a rendition server connection and click Create from.
Understanding Parent and Child Configurations, page 16 contains more information on child
configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
rendition server connection applies. For example,
adding the QA application would cause the rendition
server connection to only apply to matching quality
assurance cases.

Queue name Select the rendition server queue you want to use.

For example, when using default event names used
by Documentum Content Server, you can select:

• dm_autorender_win31 for legacy PDF/HTML
rendition requests.

• dm_mediaserver for other rendition requests

Priority Select the processing priority.
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Field Description

Event If you selected dm_autorender_win31, type
rendition

If you selected dm_mediaserver, type
dm_register_asset for imported items and
dm_transcode_content for other rendition
requests.

Message Type the message you want accompanying the
event.

Rendition format Select format to which the rendition is created.

Don’t overwrite the rendition of a document with
the same format

Select if you do not want the rendition server to
overwrite a rendition if a rendition of the same
format already exists.

4. Click Save.

Configuring an Advanced Documentum
Transform Services (ADTS) Rendition Server
Connection
You must configure ADTS servers to use thumbnail view mode.

1. Navigate to Go to > Rendition server from the menu bar.

2. Click New to create a rendition server connection.

If you want to create a child rendition server connection that inherits the properties of an
existing rendition server connection, select a rendition server connection and click Create from.
Understanding Parent and Child Configurations, page 16 contains more information on child
configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
rendition server connection applies. For example,
adding the QA application would cause the rendition
server connection to only apply to matching quality
assurance cases.

Queue name Select the queue dm_mediaserver.

Priority Select the processing priority.

Event Type the event dm_register_asset

Message Do not type a message.
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Field Description

Rendition format Select format to which the rendition is created.

Don’t overwrite the rendition of a document with
the same format

Select if you do not want the rendition server to
overwrite a rendition if a rendition of the same
format already exists.

4. Click Save.

Enabling a Branch Office Caching Service
(BOCS) Element
Set up BOCS elements that have been installed and configured in D2 Config to allow use by end users.

1. Navigate to Go to > BOCS cache from the menu bar.

2. Click New to create a BOCS element.

If you want to create a child BOCS element that inherits the properties of an existing BOCS
element, select a BOCS element and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Select a BOCS element.

Description Type a description.

Applications Add or remove the applications to which this BOCS
element applies. For example, adding the QA
application would cause the BOCS element to only
apply to matching quality assurance cases.

4. Click Save.
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Chapter 9

Configuring D2 Config Tools

This chapter contains the following topics:

• Configuring Relations
• Configuring Automated Delegation
• Configuring Fonts
• Configuring Access to D2 Client and D2 Config
• Configuring D2 Options
• Enabling Actions for Intelligent URLs

Configuring Relations
Create and configure relations in Documentum Application Builder, then install them into the
repository. EMC Documentum Administrator User Guide contains further information. You can
configure specific application of relations in D2, such as the type of relation, inheritance of the relation
during versioning, and so on.

You can place controlled relations in property pages, so that end users can set related contents
depending on the type of relation.
1. Navigate to Tools > Relation from the menu bar.
2. Click New to create a relation.

If you want to create a child relation that inherits the properties of an existing relation, select a
relation and click Create from. Understanding Parent and Child Configurations, page 16 contains
more information on child configurations.

3. For each relation, fill out the row as described in the following table:

Field Description

Relation Type Select a relation type.

Permanent link This field is automatically set, and it indicates the
permanent_link property of the relation as
created in Documentum Application Builder.

If Permanent link is set to Yes, new versions of
the content creates a new, identical relation to keep
the relation through versioning.

Multiple relation Select if the relation is a one-to-many relationship.
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Field Description

Controlled relation Select if you want the relation to only be set through
the properties page.

Child version Select the behavior of the relation for child versions
of the content.

Select All versions to have each child version link
to the relation. In this case, where one parent has a
relation with multiple child versions, end users see
one relation in the Relation tab when selecting he
parent.

Select Current to have the only the current version
link to the relation. In this case, where a child
document has relations toward several versions of
the parent document, end users see one relation in
the Relation tab when selecting the child.

Select Unique version to have only the version
used for creating the relation link to the relation.

4. Click Save.

Configuring Automated Delegation
Use the automated delegation tool to create automated delegation rules. For example, if a user goes
on vacation for two weeks, you can create a rule to automatically delegate all workflow tasks from
that user to specified users and groups.

1. Navigate to Tools >Manage Delegations from the menu bar.

2. Click New to create a delegation control.

If you want to create a child delegation control that inherits the properties of an existing delegation
control, select a delegation control and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

User/Group name Select a user or group who can setup a delegation
for other D2 Client users.

Manage user/group delegations Select the list of users or groups for whom the
automated delegations can be targeted.

Click Browse, then use the list controls to add or
remove automated delegation targets.

4. Click Save.
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Configuring Fonts
You can configure the fonts used in the XSL outputs produced by plugins.

1. Navigate to Tools > Fonts from the menu bar.

2. Click Import to add a font, then fill out the table as described in the following table:

Field Description

Name Type a name.

File Locate and select the font file.

Format Select the file format.

3. Click OK.
4. Type a Label.
5. To save the font:

• Click Save to save to the repository.
• Click Export to export the font in a file format you want.

Configuring Access to D2 Client and D2 Config
Configure access privileges to D2 Client and D2 Config based on user groups.

1. Navigate to Tools > Options from the menu bar.

2. Select Display all groups if you want to limit the list boxes to only the groups to which you
have administrator rights.

3. Select user groups for the list boxes as described in the following table:

Field Description

Access group for D2-Client Select the user group to have access to D2 Client.

Access group for D2-Config Select the user group to have access to D2 Config.

Access group for administration node Select the user group to have access to the Users,
Groups, Dictionaries, and Taxonomies widgets in
D2 Client.

Access group for users administration node Select the user group to have access to only the
Users widget in D2 Client.

Access group for groups administration node Select the user group to have access to only the
Groups widget in D2 Client.

Group and user administration parent node Select the user group to have access to the Users
and Groups widgets in D2 Client.

If you leave the list box blank, all groups have access.

4. Click Save.
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Configuring D2 Options
1. Navigate to Tools > Options from the menu bar.
2. Fill out the form as described in the following table:

Field Description

Copy not allowed Select content that you want to forbid copying. For
example, you can prevent the copying of content
with a counter in its name.

To add a content set, select a set from Document
sets and click the > button.

To remove a set, select a set from Document set
which copy is not allowed and click the < button.

Clients URL Type client web application URLs to refresh the
caches of application servers.

Click Add, type the URL for the application server
you want to add, and click OK.

To remove a server, select the server and click
Delete.

Enable the Word files comparison Select to enable comparison of content through
two different versions of Word using the Versions
widget.

Properties list display mode You can select the display mode for properties.

Select Name for only names.

Select Label for only labels.

Select Name (Label) for names followed by labels.

Select Label (Name) for labels followed by names.

Use DocApp constraints in property pages Select to use the constraints for values defined for
the repository when the attributes were created in
Documentum Application Builder.

Structure import (For D2 Client 3.1 only) Select the creation profile
to use for importing folder structure.

3. Click Save.

Enabling Actions for Intelligent URLs
To prevent end users from performing unintended actions, such as deleting content, D2 set the default
to have actions disabled for use in intelligent URLs. You can change the setting for an action to
enable it for your end user.
1. Navigate to Tools > Options from the menu bar.
2. Use the list controls to add or remove Allowed actions in the Allowed actions in URL section.
3. Click Save.
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Auditing and Monitoring D2

This chapter contains the following topics:

• Configuring Documentum Audit
• Configuring D2 Audit
• Monitoring D2

Configuring Documentum Audit
You can configure specific audit events for Documentum audit.
1. Navigate to Tools > Documentum audit from the menu bar.
2. Select D2 connection audit to log an audit event whenever a user connects to D2.
3. Use the list controls to select document types. D2 logs an audit event whenever content of the

selected types is deleted.
4. Click Save.

Configuring D2 Audit
Configure the audited D2 events and properties. The EMC Documentum Content Server System Object
Reference contains further information on auditing non-D2 events.
1. Navigate to Go to > Audit from the menu bar.
2. Click New to create an audit template.

If you want to create a child audit template that inherits the properties of an existing audit template,
select an audit template and click Create from. Understanding Parent and Child Configurations,
page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this audit
template applies. For example, adding the QA
application would cause the audit template to only
apply to matching quality assurance cases.
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4. Use the list controls to configure the list of Audited events and Displayed events.

The Audit widget only shows events in the Displayed events list.

If you place events in theDisplayed events list, D2 only shows the listed events in the Audit widget.

Select Limit the display to D2 events if you want to remove non-D2 events from the events lists.

Select Extended display if you want to use extended messages to describe event information in the
D2 Client Audit widget in place of standard Documentum columns.

5. Use the list controls to configure the list of Audited properties:
a. Select Display previous and new value if you want D2 to display the value change.
b. For a repeating property, select Display only changes if you want D2 to omit events that

resulted in no change.

6. Click Save.

Monitoring D2
You can access the D2 monitoring information by navigation to Help >Monitoring from the menu
bar. This opens theMonitoring dialog box. The following table describes the information presented
in the tabs:

Tab Description

D2 reloading Shows the state of D2 on application servers and
checks that the URL is responsive.

Summary Shows information about the JVM executing D2 on
the operating system.

VM Shows information about the JVM executing D2 on
the virtual machine.

Memory Shows information about the memory status for the
JVM executing D2.

Threads Shows information about the threads for the JVM
executing D2.

Classes Shows information about the classes for the JVM
executing D2.

Documentum Shows information about active sessions and
Documentum resources.

D2 Cache Shows the number of caches in use along with all
statistical information.

ACS/BOCS Shows the URL status of ACS and BOCS configured
in Documentum Administrator.

Click Refresh to update all monitored information.
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Chapter 11

Using D2 Config Configurations

This chapter contains the following topics:

• Understanding D2 Configurations
• Backing Up a D2 Configuration
• Restoring a D2 Configuration
• Exporting a D2 Configuration
• Importing a D2 Configuration
• Importing a D2 Configuration Using a Command Line
• Resetting the D2 Configuration

Understanding D2 Configurations
You can back up all configurations in D2 for the repository for backup purposes as well as to transfer
configurations through the importing feature. The actions you can take regarding configurations are:

• Backup
• Restore
• Export
• Import

You can view the version of the current configuration by navigating to About > D2 Solution >
Configuration.

Backing Up a D2 Configuration
1. To create a new configuration object:

a. Navigate to File > Save configuration > Check in as new object from the menu bar.
b. Select an application or select All applications to define the scope of the configurations you

want to save.
c. Type a name and description of the configuration.
d. Click OK.

2. To save a configuration as a new version of an existing configuration object:
a. Navigate to File > Save configuration > Check in configuration base from the menu bar.
b. Select and edit a name.
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c. Select the version.

d. Type a description.

e. Click OK.

Restoring a D2 Configuration
1. Navigate to File > Restore configuration from the menu bar.

2. Select a configuration.

3. Select the version you want to use.

4. Click OK.
5. Select options as described in the following table:

Option Description

Full import with current config reset Import the entire configuration and erase the current
configuration

Full import without actual config reset Import the entire configuration without erasing the
current configuration. New contexts are placed
between the lowest-priority context and the default
context. Existing contexts keep their position.

Include imported modules relative to matrix
switches

Import the toggled status of the configuration
matrix.

Overwrite existing elements Replace existing configurations with the imported
configuration.

Do not overwrite the autonaming values in the new
configuration

Keep existing values of autonaming counters.

Do not overwrite the cache URLs Keep the cache URLs.

Do not overwrite the mail server configuration Keep the mail server URLs.

6. Select a context from Import the context before this context to select the relative context when
importing contexts to the configuration matrix.

7. Select all modules you want to import.

8. Click OK.

Exporting a D2 Configuration
1. Navigate to File > Export configuration from the menu bar.

2. Select an application or select All applications to define the scope of the configurations you
want to export.

3. To export all configurations, select Full config export. Otherwise select the modules to export.
4. Click OK.
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Importing a D2 Configuration
1. Navigate to File > Import configuration from the menu bar.
2. Select the configuration Zip file you want to import.
3. Click Open.
4. Select options as described in the following table:

Option Description

Full import with current config reset Import the entire configuration and erase the current
configuration

Full import without actual config reset Import the entire configuration without erasing the
current configuration. New contexts are placed
between the lowest-priority context and the default
context. Existing contexts keep their position.

Include imported modules relative to matrix
switches

Import the toggled status of the configuration
matrix.

Overwrite existing elements Replace existing configurations with the imported
configuration.

Do not overwrite the autonaming values in the new
configuration

Keep existing values of autonaming counters.

Do not overwrite the cache URLs Keep the cache URLs.

Do not overwrite the mail server configuration Keep the mail server URLs.

5. Select a context from Import the context before this context to select the relative context when
importing contexts to the configuration matrix.

6. Select all modules you want to import.
7. If you are importing updates to existing configurations, select Report extension configuration

warnings to generate a PDF report that lists the configurations that were changed.
8. Click OK.

Importing a D2 Configuration Using a Command
Line
1. Open a DOS or Linux console.
2. Type the following line:

java —cp [classpath] eu.c6.d2.api.config.batch.D2ConfigImport
[-login login_name] [-password password] [-docbase docbase_name]
[-config_file file_config_path] [-full_import true|false]
[optional parameters] [modules list]

The following table describes the parameters:

Parameter Description

classpath Classpaths contain D2 libraries, DFC libraries, and
the dfc.properties file.
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Parameter Description

login Repository connection login

password Repository connection password

docbase Repository name

config_file Configuration file

full_import Full or custom import based on true or false,
respectively

reset Reset of existing configuration

overwrite Overwrite the existing configuration (default: false)

keep_naming_counter Keep autonaming counters (default: false)

keep_url_cache Keep cache URL values (default: false)

keep_mail_server Keep mail server URL values (default: false)

help Show a help message with a list of parameters.

Resetting the D2 Configuration
You can erase the current configuration and revert to default settings.

1. Navigate to File > Reset configuration from the menu bar.

2. Click OK.
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Chapter 12

Configuring D2 Client

This chapter contains the following topics:

• Configuring a Gadget Server for D2 Client Widgets
• Configuring a D2 Client Workspace
• Designing a D2 Client Workspace
• Understanding the Border Layout Container
• Understanding the Tab Container
• Understanding the Accordion Container
• Understanding the Horizontal and Vertical Containers
• Configuring a D2 Client Theme
• Configuring an Internal Widget
• Configuring an External Widget
• Configuring D2 Client Menus
• Configuring Custom Icons for Rendition Formats and Content Types
• Configuring Icons and Text Color for Content Properties in List Widgets
• Configuring Display Filters
• Configuring D2 Client Column Preferences
• Configuring Access to Administration Widgets in D2 Client
• Refreshing and Reloading D2

Configuring a Gadget Server for D2 Client
Widgets
You can configure the a gadgets server for external widgets. For example, Apache Shindig
(http://shindig.apache.org) functions as a gadget server.
1. Make sure you have a gadget server installed and configured.
2. Navigate toWidget view > Options from the menu bar.
3. Type the server URL of the gadget server in Gadget server url.
4. Click Save.
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Configuring a D2 Client Workspace
1. Navigate toWidget view >Workspace from the menu bar.
2. Click New to create a workspace.

If you want to create a child workspace that inherits the properties of an existing workspace, select
a workspace and click Create from. Understanding Parent and Child Configurations, page 16
contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
workspace applies. For example, adding the QA
application would cause the workspace to only
apply to matching quality assurance cases.

Label <language> Type a label.

Description <language> Type a description.

Workspace structure file Select the workspace XML to use as this template
configuration.

Preview file Select the preview image, if any, to use as a
thumbnail so the end user has an idea of what
the workspace looks like. If you do not select or
import a thumbnail, D2 automatically generates a
thumbnail.

Default theme Select the default color theme used for the
workspace.

You must select a theme.

Define the default theme in the global registry
docbase so that it is applied to the login screen and
workspace gallery. Initially, the docbase settings are
not retrieved and the theme does not display (please
verify if this is correct). Ensure that the default
theme is specified both for the global registry
docbase setting and for retrieval. If multiple themes
are checked in the default column in D2-Config, the
theme from the first row is applied, by default.

If you already have a default theme defined, import
that default theme to the global registry docbase.

4. Select whether the workspace uses multiple views. If you selectMultiple view, use the list controls
to add, remove, or reorder workspace views. For each view:
a. Type the label for the view in View <language>.
b. Click Browse, select a workspace XML, then click OK.
c. Click View to preview the workspace template.
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5. Select Lock workspace layout to prevent end users from modifying the widgets contained in a
workspace. Select this option to prevent end users from removing widgets that are necessary for
context-sensitive widget operations. For example, you can configure the Locate widget so that
when an end user selects content within the Locate widget, D2 makes the Doclist widget visible.

6. If you want to configure one or more events that cause D2 to set a workspace view to active:
a. Use the list controls for Add focus events for the selected workspace view to add, remove, or

reorder D2 actions and events. List of Widget Communication Channels, page 181 contains a
list and description of the events, actions, and their parameters.

b. Select an event to configure its Additional event parameters.

For example, if you add and select the event D2_EVENT_WIDGET_FOCUS to the
TasksWidget, you can type the parameter widgetType==BrowserWidget. When the
end user selects the Document browser widget, D2 makes the selected workspace view visible
and active, then sets focus to the Document browser widget if it is found in the new view.

You can also type the parameter config== and set the value to the Name of the widget. You
can use this parameter to differentiate between instances of the same widget. For example, you
can create a Document browser widget with the name Word document browser and
another Documentum browser widget with the name PDF document browser. If you use
widgetType==BrowserWidget D2 triggers the focus event for both widgets. If you use
config==”Word document browser” you can specify the specified widget.

7. Click Save.

Designing a D2 Client Workspace
The workspace XML must contain the following object:

<?xml version="1.0" encoding="UTF-8"?>

<root xsi:noNameSpaceSchemaLocation="SpaceSchema.xsd"
xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">

<space>

<border-layout-container>

</space>

</root>

There must only be one <root> tag at the beginning of the file, which contains one <space> tag.

The <space> tag requires at least one <border-layout-container>.

All containers may contain itself, other containers, or widgets. The following table lists the available
containers and possible sub components:

Container Subcomponents

Border layout container Containers and widgets

Tab container Widgets

Accordion container Widgets

Vertical and horizontal containers Containers and widgets
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Understanding the Border Layout Container
The border layout container is the main frame of the workspace. Border layout containers are
composed of data nodes and content nodes.

Data nodes are exclusive to border layout containers and define the location and size of container
elements. The following table describes the attributes you can use:

Attribute Description

layoutregion Defines the location of a container element.

• NORTH for north (top of the container)

• SOUTH for south (bottom of the container)

• EAST for east (right of the container)

• WEST for west (left of the container)

• CENTER for center (middle of the container).

size Defines the default container size. You can define
sizes in two ways, and D2 automatically detects the
type.

If you type a value greater than 0, the value is
considered an absolute size in pixels. For example,
D2 considers 100 to be 100 pixels.

If you type a value less than 0, the value is considered
a relative size. For example, D2 considers 0.5 to be
0.5%, or half the size of the window.

maxSize The maximum size for a container during resizing.

minSize The minimum size for a container during resizing.

split Determines enabling or disabling of resizing of the
container. If split is set to TRUE, maxSize and
minSize must be set.

There must be a content node for each data node, and they define the elements used in a container. If
the element is a widget, you must specify the name of the widget. If the element is a container, you
must specify the name of the container. The number of elements that can be defined is limited to
5 for display reasons.

The following image contains an example code of a border layout container with data and content
nodes:
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Understanding the Tab Container
The tab container is a type of horizontal layout with tab items organized horizontally.

Tab containers contain a single content node. Add a widget to the layout by entering the name of the
widget in the <widget config> tag. There is no limit to the number of widgets you can put in
a tab container. You do not need to define a size, as the tab container uses the size as determined
by its parent container.

The following image contains an example of a tab container:

Understanding the Accordion Container
The accordion container is a type of vertical layout with tab items organized vertically.

Accordion containers contain a single content node. Add a widget to the layout by entering the name
of the widget in the <widget config> tag. There is no limit to the number of widgets you can put
in an accordion container. You do not need to define a size, as the accordion container uses the size
as determined by its parent container.

The following image contains an example of a accordion container:
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Understanding the Horizontal and Vertical
Containers
Use horizontal and vertical containers to organize elements horizontally and vertically, respectively.

Horizontal and vertical containers can contain containers and widgets, which are placed in a content
node. Resizing is disabled for horizontal and vertical containers.

The following image contains an example of a horizontal container:

The following image contains an example of a vertical container:

Configuring a D2 Client Theme
You can configure color themes that end users can select and use on their D2 Client workspaces. You
can define the colors of the background, logo, borders, and so on.
1. Navigate toWidget view > Theme from the menu bar.
2. Click New to create a theme.

If you want to create a child theme that inherits the properties of an existing theme, select a theme
and click Create from. Understanding Parent and Child Configurations, page 16 contains more
information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.
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Field Description

Applications Add or remove the applications to which this theme
applies. For example, adding the QA application
would cause the theme to only apply to matching
quality assurance cases.

Label <language> Type a label.

4. Configure the application header as described in the following table:

Field Description

Logo Select a logo from the list box.

If you want to import a new logo, click Browse and
fill out the Import dialog box. Use an image with
a maximum dimension of 250 pixels width by 50
pixels height.

Background Select a background color using the Color selection
dialog box.

Normal Select a color for the menu icons, labels, and buttons
in the normal state using the Color selection dialog
box.

Hover Select a color for the menu icons, labels, and buttons
for when an end user mouses over the menu using
the Color selection dialog box.

5. Configure the workspace tabs as described in the following table:

Field Description

Tab label Select a color for the workspace tab label and
workspace menu button using the Color selection
dialog box.

Border Select a color for the horizontal border below the
workspace tabs using the Color selection dialog
box.

6. Configure the widget tabs, borders, and item selection as described in the following table:

Field Description

Tab label - Active Select a color for the tab label, menu button, and
button label for an active widget using the Color
selection dialog box.

Tab label - Inactive Select a color for the tab label and menu button for
an inactive widget using the Color selection dialog
box.

Tab background - Active Select a color for the tab background and buttons
for an active widget using the Color selection
dialog box.

Tab background - Inactive Select a color for the tab background for an inactive
widget using the Color selection dialog box.

Use transparent tab background Select this option to alter the theme to use
transparent widget tabs and a larger tab font.
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Field Description

Selected Item - Active Select a background color for a selected item in a
grid, menu, list, and tree for an active widget using
the Color selection dialog box.

This color does not apply to the text color of the
selected item. Depending on the color selected, D2
sets the text color to black or white for visibility.

Selected Item - Inactive Select a background color for a selected item in
a grid, menu, list, and tree for an inactive widget
using the Color selection dialog box.

This color does not apply to the text color of the
selected item. Depending on the color selected, D2
sets the text color to black or white for visibility.

Border - Active Select a color for the panel border for an active
widget using the Color selection dialog box.

7. Configure the application background as described in the following table:

Field Description

Single color Select this option to use a solid color background.

Select a color using the Color selection dialog box.

Gradient Select this option to use a gradient color background.

Select a Start color and an End color for the
gradient using the Color selection dialog box.

Image Select this option to use a background image.

Select a background image from the list box.

If you want to import a new background image,
click Browse and fill out the Import dialog box.

Use white dialog background Select this option if you want dialog boxes to use a
white background. If you do not select this option,
dialog boxes use the application background.

8. Click Save.

Configuring an Internal Widget
Internal widgets are user interface components used to display internal repository information.
1. Navigate toWidget view >Widget from the menu bar.
2. Click New to create a widget.

If you want to create a child widget that inherits the properties of an existing widget, select a widget
and click Create from. Understanding Parent and Child Configurations, page 16 contains more
information on child configurations.

3. Fill out the form as described in the following table:
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Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this widget
applies. For example, adding the QA application
would cause the widget to only apply to matching
quality assurance cases.

Label <language> Type a label.

Description <language> Type a description.

Widget type Select the widget type from the list box containing
internal widgets. List of Widgets, page 167 contains
more information about the widgets.

Preview file Select the preview image to use as a thumbnail
preview. If you do not select or import a thumbnail,
D2 uses a default image.

4. You can add and configure events that cause D2 to set a widget to active:

a. Use the list controls for Add focus events to add, remove, or reorder D2 actions and events.
List of Widget Communication Channels, page 181 contains a list and description of the events,
actions, and their parameters.

b. Select an event to configure its Additional event parameters.

For example, you can add and select the event D2_EVENT_WIDGET_FOCUS to a
TasksWidget and set the parameter and value widgetType==TaskFoldersWidget.
When the end user selects the Tasks browser widget, D2 makes the Workflow tasks widget
visible if the widget exists in the current workspace view.

To differentiate between instances of the same widget, use the parameter config== and set
the value to the Name of the widget. For example, you can create a Document browser widget
with the name Word document browser and another Documentum browser widget with
the name PDF document browser. If you use widgetType==BrowserWidget
D2 triggers the focus event for both widgets. If you use config==”Word document
browser” you can specify the specified widget.

5. To configure a search query form widget, select a configured query form from the Query form
list box.

Each instance of the search query form widget can only pertain to a single type of query form.
Use a naming convention that makes it clear to both administrators and end users that the widget
is configured for a specific query form. For example, you can use the widget name SQF QA
General Documents to indicate that the widget uses the QA General Documents query form.

6. If you are configuring a ThumbnailsWidget or a DoclistWidget, fill out the Parameters
fields are described in the following table:

Field Description

Enable breadcrumb Select to show a container path breadcrumb at the
top of the widget.

Content type Select DQL to configure the widget to show a list
of content based on a DQL query.
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Field Description

DQL Query Type the DQL query the widget uses for retrieving
its list of content.

You can use the $value wildcards:

• $value(r_object_id): Add the selected
content.

• $value(all): Add filtered content.

You can use $value(all) when the widget
shares a context with a filter configuration that
is set to show all versions. D2 then finds and
replaces $value(all) with (all) at runtime.
Therefore, you must place $value(all) after
the type in the DQL query.

For example: from <type> $value(all)

• $value(default_attributes): Add the
attributes you want shown as columns.

• $value(preferences_attributes):
Add user preference attributes.

The DQL generated by $value(prefer-
ences_attributes) includes a preceding
comma, for example ,object_name,a_sta-
tus,r_modify_date,r_modifier

As a result, $value(preferences_at-
tributes) must never:

• Be the only attribute in the D2 DQL query.

• Be the first attribute in the D2 DQL query.

• Have a comma between the preceding attribute
and itself in the D2 DQL query.

If the DQL query is invalid, D2 ignores the query
and does not show an error message to indicate
a problem with the query. The widget shows an
empty list of content.

Override event subscribe Select to override the events for which the widget
refreshes.

Subscription events Use the list controls to add or remove the events
that trigger the widget to refresh.

Override event publish Select to override the events for which the widget
outputs information.

Loading events Use the list controls to add or remove the events
that trigger when the widget loads.
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Field Description

Select events Use the list controls to add or remove the events that
trigger when the end user selects content.

Make sure the event matches the content type
being shown by the widget. For example, if
you configure the widget to show folders, you
must use D2_EVENT_SELECT_FOLDER or
the widget shows an error. If you configure
the widget to show a mix of content, use
D2_EVENT_SELECT_OBJECT or create a custom
event to work with the widget.

Double-click events Use the list controls to add or remove the events that
trigger when the end user double-clicks content.

7. If you are configuring a BrowserWidget, type the path to a cabinet or folder in the Starting
path field. The end user can only browse the entered cabinet or folder when using the widget.

8. If you are configuring a PropertiesWidget:
a. If you want the properties widget to open properties in edit mode instead of view mode,

select Enable auto edit.
b. If you want the properties widget to broadcast a D2_ACTION_REFRESH_DOCUMENT event,

select Enable refresh. Widgets that listen to the refresh event do not automatically change
locations even if D2 moves the content to a different folder based on the updated property
values input by the end user.

If you do not select this option, the widget broadcasts the more resource-consuming
D2_ACTION_LOCATE_OBJECT event. If D2 moves the content to a different folder based
on the updated property values input by the end user, widgets that listen to the locate event
automatically move to the new location of the content.

9. Click Save.

Configuring an External Widget
External widgets are user interface components used to display external web information using
a third-party web application. You can configure external widgets to communicate with content
properties.
1. Navigate toWidget view >Widget from the menu bar.
2. Click New to create a widget.

If you want to create a child widget that inherits the properties of an existing widget, select a widget
and click Create from. Understanding Parent and Child Configurations, page 16 contains more
information on child configurations.

3. Make sure a gadget server is configured in the Widget View options. Configuring a Gadget Server
for D2 Client Widgets, page 103 contains further instructions.

4. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.
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Field Description

Description Type a description for the widget in D2 Config.

Applications Add or remove the applications to which this widget
applies. For example, adding the QA application
would cause the widget to only apply to matching
quality assurance cases.

Label <language> Type a label.

Description <language> Type a description for the widget to appear in the
D2 Client Widget Gallery.

Widget type Select ExternalWidget.

Widget url Type either a static or dynamic URL.

You can use $GADGET_SERVER as a keyword for
the gadget server URL set in widget options.

For example,
$GADGET_SERVER/gadgets/ifr?url=
http://www.labpixies.com/
campaigns/weather/weather.xml

Bidirectional communication Select if the widget communicates with the portal
using an Open Ajax Hub.

Communication channel Use the list controls to select a communication
channel for transmitting information between
widgets and repositories.

List of Widget Communications Channels, page
181 contains further information.

Preview file Select the preview image, if any, to use as a
thumbnail so the end user has an idea of what the
widget looks like. If you do not select or import a
thumbnail, D2 uses a default image.

5. Click Save.

Configuring D2 Client Menus
You can modify the position, label, display conditions, and contents of the menu in D2 Client.
1. Navigate to Go to >Menu D2 from the menu bar to configure the following menus for D2 Client:

• Menu bar (New, Import, Content, Help)
• Right click on Location widget
• Right click on Relation widget
• Right click on Rendition widget
• Right click on Version widget
• Right click on Task detail widget
• Right click on a list widget
• Right click on Admin Dictionary widget
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• Right click on Admin Group widget
• Right click on Admin Taxonomy widget
• Right click on Admin User widget
• Right click on Multisearch widget
• Right click on Tasks list widget
• Right click on VD widget
• Right click on Workflow widget

2. Click New to create a menu.

If you want to create a child menu that inherits the properties of an existing menu, select a menu
and click Create from. Understanding Parent and Child Configurations, page 16 contains more
information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this menu
applies. For example, adding the QA application
would cause the menu to only apply to matching
quality assurance cases.

4. You can add menu buttons as described in the following table:

Action Description

Add separator Add a line to partition the menu.

Add menu item Add a menu entry.

Add sub-menu item Add a menu as a submenu that an end user can view
by expanding the parent menu entry.

Add dynamic menu item Add a menu entry that executes a Java class.

You can only add dynamic menu items to context
menus.

5. Configure menu entries:
a. Configure the appearance of the selected menu entry as described in the following table:

Field Description

Hide this entry Select to hide the menu item users of the specified
application.

Label <language> Type a label.

Shortcut Select a shortcut key for accessing the menu entry.

Make sure to validate shortcuts by testing the key
in D2 Client, as D2 Config does not check for
conflicting shortcuts.

b. Configure the actions assigned to the selected menu entry as described in the following table:
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Field Description

Action Select a Javascript action for the button to
perform.

Message Type additional parameters to be read by services.
This field is only useful for service customizations.

The message that is typed in this field allows
administrators to add additional parameters or
change the built-in parameter value. If you do not
input an eligible parameter it does not have any
effect or may cause the configuration to fail.

Manager Select the Manager parameter for the selected
Javascript action.

Sub menu Select a menu to be shown as a submenu.

For example, selecting MenuContextAd-
minTaxonomy from the submenu list box adds
the most recent version of the menu for Right
click on Admin Taxonomy widget as a submenu.

Java class Select the Java class to execute if the menu item
is dynamic.

c. Configure the display conditions of the selected menu entry as described in the following table:
Field Description

Display conditions Use display conditions to define the rules and
scope of D2 shows the menu entry.

Click Browse to add display conditions.

Click Delete to remove display conditions.

Use the list controls to move conditions up and
down the list.

Display disabled instead of hidden Select whether to show the menu entry as grayed
out or hide the menu entry from view.

Invert the condition Select to invert the condition.

For example, you want to have a particular cabinet
shown to everyone except for users who have
the consumer role. You set the display condition
user has client capability equals
consumer and then select to invert. The display
condition then changes to user has not
client capability equals consumer

d. If you select a display condition that uses a DQL query, fill out the three fields as described in
the following table:
Field Description

Condition valid on Select whether the DQL query applies:

• If at least one selected content fits the condition.

• If all selected content fit the condition.
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Field Description

Property Select the property for the DQL query.

Value Type the parts of the DQL query after the select
and from conditions. The DQL query must use
the wildcard $value(r_object_id) to refer
to the selected object or objects. For example:

dm_document (all) where
r_object_id=’$value(r_object_id)’
and a_status=’Draft’

D2 automatically generates the select and
from parts of the DQL query.

6. Drag and drop menu items to reorder.
7. Click Save.

Configuring Custom Icons for Rendition
Formats and Content Types
You can configure custom icons for renditions formats and content types in the list and thumbnail
widgets. If D2 finds that the configuration for the content type and rendition format conflicts for given
content, D2 uses the configuration for the content type.

You can create a custom icon configuration with or without property styling. Configuring Icons and
Text Color for Content Properties in List Widgets, page 118 contains more information on configuring
property styles.
1. Navigate toWidget view > Graphics from the menu bar.
2. Click New to create a graphics configuration.

Note: In the configuration matrix, you can configure graphics only for group or user contexts.

If you want to create a child graphics configuration that inherits the properties of an existing
graphics configuration, select a graphics configuration and click Create from. Understanding
Parent and Child Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name.

Description Type a description.

Applications Add or remove the applications to which this
graphics configuration applies. For example,
adding the QA application would cause the graphics
configuration to only apply to matching quality
assurance cases.

4. Use the list controls to add, remove, and reorder rendition formats. D2 gives icon priority to lower
rows. Fill out the row for each rendition as described in the following table:

EMC Documentum

Version 4.2 Administration Guide 117



Configuring D2 Client

Field Description

Format Name Select the rendition format from the list box.

List Icons Select an icon for list widgets from the list box.

If you want to import a new icon, click Browse and
fill out the Import dialog box. Use a 16x16 pixel
image at 72 DPI.

Thumbnail Icons Select an icon for thumbnail widgets from the list
box.

If you want to import a new icon, click Browse and
fill out the Import dialog box. Use a 64x64 pixel
image at 72 DPI.

5. Use the list controls to add, remove, and reorder content types. D2 gives icon priority to lower
rows. Fill out the row for each content type as described in the following table:

Field Description

Type Name Select the type from the list box.

List Icons Select an icon for list widgets from the list box.

If you want to import a new icon, click Browse and
fill out the Import dialog box. Use a 16x16 pixel
image at 72 DPI.

Thumbnail Icons Select an icon for thumbnail widgets from the list
box.

If you want to import a new icon, click Browse and
fill out the Import dialog box. Use a 64x64 pixel
image at 72 DPI.

6. Click Save.

Configuring Icons and Text Color for Content
Properties in List Widgets
You can configure an icon and color-coding for content properties in the columns of list widgets. For
example, you can add an icon to the document status property and change the text color to show blue
for Draft, green for Accepted, and red for Rejected.

You can configure property styling with or without custom icon configurations. Configuring Custom
Icons for Rendition Formats and Document Types, page 117 contains more information on custom
icon configurations.
1. Navigate toWidget view > Graphics from the menu bar.
2. Click New to create a property style.

If you want to create a child property style that inherits the properties of an existing property style,
select a property style and click Create from. Understanding Parent and Child Configurations,
page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:
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Field Description

Name Type a name.

Description Type a description.

Applications Add or remove the applications to which this
property style applies. For example, adding the QA
application would cause the property style to only
apply to matching quality assurance cases.

4. Use the list controls to add and remove properties. Fill out the row for each property as described
in the following table:

Field Description

Property Type the name of the property.

Value Type the value of the property.

For example, you can type a_status in the
Property and Draft in the Value to configure
a style for when D2 sets the lifecycle state of a
document to Draft.

Icon Select an icon from the list box.

If you want to import a new icon, click Browse and
fill out the Import dialog box. Use a 16x16 pixel
image at 72 DPI.

For example, if you configure the Draft value to
show a pencil icon, the document status column
shows the icon followed by the value.

Icon only Select this option to replace the property value with
the icon.

For example, if you configure the Draft value
to show a pencil icon and select Icon only, the
document status column only shows the icon.

The end user can still filter and search content based
on the property because the option hides but does
not remove the value.

Text Color Select the color of the property text using the Color
selection dialog box.

You do not need to select a color if you selected
Icon only because D2 does not show the value.

5. Click Save.

Configuring Display Filters
You can create and configure display filters that end users can select in D2 Client. Display filters affect
the content shown in the Document list widget. For example, you can create a quality assurance filter
that only shows content labeled with the keyword QA. You can create a quality assurance Draft filter
that only shows content labeled with the keyword QA with the status Draft.
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1. Navigate to Go to > Filter from the menu bar.
2. Click New to create a display filter.

If you want to create a child display filter that inherits the properties of an existing display filter,
select a display filter and click Create from. Understanding Parent and Child Configurations, page
16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
display filter applies. For example, adding the QA
application would cause the display filter to only
apply to matching quality assurance cases.

Label <language> Type a label.

Default Select to make the filter the default setting.

All versions Select if you want to apply the filter to all versions
of content.

Clear to apply the filter to current versions.

DQL filter Type the DQL query defining the filter.

Type Select the content type to which the DQL query is
applied.

4. Click Save.

Configuring D2 Client Column Preferences
Default columns in the repository for tables display all properties and types. You can configure column
preferences to allow users to select columns that filter the table based on property and type.

For example, the following image is a dm_folder content type with its configured properties:
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The following image is the resulting column configuration interface in D2 Client as well as the
property Title, which shows the folder path:

1. Navigate to Interface > Display configuration from the menu bar.
2. Use the list controls to modify the list of columns that filter based on content type.
3. To add a property filter:

a. Select a type from Properties of selected type.
b. Use the list controls to modify the list of property filters.
c. For each property, you can select a dictionary and select an alias or language to configure the

display of values within the column.

For example, you can configure a Status column to use the English language setting of a
dictionary. Depending on dictionary configuration, values in a different language within the
column can be translated into English. You can use dictionaries and aliases to universalize
column value structure.

4. Click Save.

Configuring Access to Administration Widgets
in D2 Client
1. Navigate to Tools > Options from the menu bar.
2. Fill out the form as described in the following table:

Field Description

Access group for administration node Select the group to enable access to all
administration widgets.

If left blank, all groups have access.

Access group for users administration node Select the group to enable access to the user
administration widget.

If left blank, all groups have access.

Access group for groups administration node Select the group to enable access to the group
administration widget.

If left blank, all groups have access.

Group and user administration parent node Select the group to enable access to user and group
administration widgets.

If left blank, all groups have access.
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3. Click Save.

Refreshing and Reloading D2
You can refresh and reload certain aspects of D2 using the Tools menu in D2 Config, as described
in the following table:

Action Description

Tools > Refresh cache Run this task to rebuild the cache, which is an
operation that is normally run when the server is
restarted.

Tools > Reload D2 options Run this task to reload D2-Config.properties. You can
use this task to load the updated D2-Config.properties
settings without restarting your application server.
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Configuring the Interface of D2 Client
3.1

This chapter contains the following topics:

• Configuring Menus for D2 Client 3.1
• Configuring Toolbars for D2 Client 3.1
• Configuring Themes for D2 Client 3.1
• Configuring Treeview for D2 Client 3.1

Configuring Menus for D2 Client 3.1
D2 4.1 provides support for mixed-environment installations. You can configure the menus of D2
Client 3.1.
1. Navigate to Go to >Menu D2-Client from the menu bar to configure the following menus for

D2 Client 3.1:

• Locations
• Versions
• Renditions
• Relations
• Workflows
• Snapshots
• Details
• Relations
• Hyperlinks
• Publish profiles
• Overlays
• Components
• Right click
• Right click on async search
• New Component Template submenu
• Right Click on Edit TOC dialog
• Right click on P2 Manager node
• Right click on Publish frame
• Right click on snapshot frame

EMC Documentum

Version 4.2 Administration Guide 123



Configuring the Interface of D2 Client 3.1

• Right click on task
• Right click on templates administration node
• Right click on task node
• Right click on last search node
• Right click on VD frame
• Right click on node that has content
• Publish Hyperlink submenu
• MenuPublishP2Import
• Propagate property submenu
• Publish Update submenu

2. Click New to create a menu.

If you want to create a child menu that inherits the properties of an existing menu, select a menu
and click Create from. Understanding Parent and Child Configurations, page 16 contains more
information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this menu
applies. For example, adding the QA application
would cause the menu to only apply to matching
quality assurance cases.

4. You can add menu buttons as described in the following table:

Action Description

Add separator Add a line to partition the menu.

Add menu item Add a menu entry.

Add sub-menu item Add a menu as a submenu that an end user can view
by expanding the parent menu entry.

Add dynamic menu item Add a menu entry that executes a Java class.

You can only add dynamic menu items to context
menus.

5. Configure menu entries:
a. Configure the appearance of the selected menu entry as described in the following table:

Field Description

Hide this entry Select to hide the menu item users of the specified
application.

Label <language> Type a label.

b. Configure the actions assigned to the selected menu entry as described in the following table:
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Field Description

Action Type a Javascript action for the button to execute.

List of Custom Actions, page 177 contains further
information about the commands that you can use.

Sub menu Select a menu to be shown as a submenu.

For example, selecting MenuContextAd-
minTaxonomy from the submenu list box adds
the most recent version of the menu for Right
click on Admin Taxonomy widget as a submenu.

Java class Select the Java class to execute if the menu item
is dynamic.

c. Configure the display conditions of the selected menu entry as described in the following table:

Field Description

Display conditions Use display conditions to define the rules and
scope of D2 shows the menu entry.

Click Browse to add display conditions.

Click Delete to remove display conditions.

Use the list controls to move conditions up and
down the list.

Display disabled instead of hidden Select whether to show the menu entry as grayed
out or hide the menu entry from view.

Invert the condition Select to invert the condition.

For example, you want to have a particular cabinet
shown to everyone except for users who have
the consumer role. You set the display condition
user has client capability equals
consumer and then select to invert. The display
condition then changes to user has not
client capability equals consumer

6. Drag and drop menu items to reorder.
7. Click Save.

Configuring Toolbars for D2 Client 3.1
D2 Client 4.1 provides support for mixed-environment installations. You can modify the position,
label, display conditions, and contents of the toolbar of D2 Client 3.1.
1. Navigate to Go to > Toolbar from the menu bar.
2. Click New to create a toolbar.

If you want to create a child toolbar that inherits the properties of an existing toolbar, select a
toolbar and click Create from. Understanding Parent and Child Configurations, page 16 contains
more information on child configurations.
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3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this toolbar
applies. For example, adding the QA application
would cause the toolbar to only apply to matching
quality assurance cases.

4. Configure toolbar buttons:
a. Configure the appearance and action as described in the following table:

Field Description

Hide this entry Select to hide the button from the toolbar.

Label <language> Type the text of the button.

Tip <language> Type the tooltip text for the button.

Action Type a Javascript action for the button to execute.

List of Custom Actions, page 177 contains further
information about the commands that you can use.

b. Configure the display conditions as described in the following table:

Field Description

Display conditions Use display conditions to define the rules and
scope of D2 shows the menu entry.

Click Browse to add display conditions.

Click Delete to remove display conditions.

Use the list controls to move conditions up and
down the list.

Display disabled instead of hidden Select whether to show the menu entry as grayed
out or hide the menu entry from view.

Invert the condition Select to invert the condition.

For example, you want to have a particular cabinet
shown to everyone except for users who have
the consumer role. You set the display condition
user has client capability equals
consumer and then select to invert. The display
condition then changes to user has not
client capability equals consumer

5. Click Save.

Configuring Themes for D2 Client 3.1
D2 Client 4.1 provides support for mixed-environment installations. You can modify the color schemes
of dialog boxes, headers, menus, selections, and icons of D2 Client 3.1.
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1. Navigate to Go to > Theme from the menu bar.
2. Click New to create a theme.

If you want to create a child theme that inherits the properties of an existing theme, select a theme
and click Create from. Understanding Parent and Child Configurations, page 16 contains more
information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this theme
applies. For example, adding the QA application
would cause the theme to only apply to matching
quality assurance cases.

4. Configure the theme:

Item Description

Dialog box Select a border style, background color, and tab
style.

Header Select a color and logo.

Menu Select a background color.

Interface Select element and priority colors.

Icon Select document formats and types and a
corresponding icon.

Use the up and down arrows to reorder the formats
and types. The order must correspond to the
cascading style sheet (CSS) used for the repository,
and the most import styles must be located at the
bottom of the list.

The optimal size for the icon is 16*16 pixels.

5. Click Save.

Configuring Treeview for D2 Client 3.1
D2 Client 4.1 provides support for mixed-environment installations. You can modify labels and add
display conditions to repositories in D2 Client 3.1.
1. Navigate to Go to > Treeview from the menu bar.
2. Click New to create a treeview.

If you want to create a child treeview that inherits the properties of an existing treeview, select a
treeview and click Create from. Understanding Parent and Child Configurations, page 16 contains
more information on child configurations.

3. Fill out the form as described in the following table:
EMC Documentum

Version 4.2 Administration Guide 127



Configuring the Interface of D2 Client 3.1

Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
treeview applies. For example, adding the QA
application would cause the treeview to only apply
to matching quality assurance cases.

4. Select a node in the treeview and fill out the fields as described in the following table:

Field Description

Label <language> Type a label.

Hide this node Select to hide the node from users of the selected
application.

Display conditions Use display conditions to define the rules and scope
of when a node is shown.

Click Browse to add display conditions.

Click Delete to remove display conditions.

Use the list controls to move conditions up and
down the list.

Invert the condition Select to invert the condition.

For example, you want to have a particular cabinet
shown to everyone except for users who have
the consumer role. You set the display condition
user has client capability equals
consumer and then select to invert. The display
condition then changes to user has not
client capability equals consumer

5. Click Save.
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D2 Config Troubleshooting and Tips

This chapter contains the following topics:

• Accessing D2 Config without Opening a New Browser Window

Accessing D2 Config without Opening a New
Browser Window
If you do not want to open D2 Config in a new browser window, add the newWindow parameter to the
D2 Config URL and set it to false. For example:

http://<web application server URL>:8080/D2-Config/?newWindow=false
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Chapter 15

Configuring C2

This chapter contains the following topics:

• Overview of C2
• Configuring a Dynamic View Configuration
• Configuring a Dynamic Print Configuration
• Configuring a Dynamic Export Configuration
• Configuring a Static Configuration
• Formatting C2 Table of Contents using XSL
• Configuring C2 Administrator Access
• Clearing the dmi_queue_item After Creating a C2 Rendition

Overview of C2
Use C2 to extend PDF functionality of D2 with regards to adding:

• Extra pages: you can add one or several pages at the beginning, end, or after a given page. These
pages can contain content properties or variables.

• PDF layers: you can add headers, footers, or images to all or part of documents.
• Watermarks: you can add image or text watermarks to all or part of documents above or below text
and as transparent images.

• Dynamic pages: you can add dynamically-constructed pages, such as signature pages, gradually
over the course of the lifecycle of the PDF document. Create dynamic pages in XML format so
that tables can be managed based on their size. which are linked according to configurations when
the document is viewed, printed, or exported.

Changes are applied to the PDF document as according to four configurations: view, print, export,
and static conversion. Use static conversion to configure an actions that cannot be changed and is
carried out once during processing. Static conversions overwrite the current rendition or create a
new rendition. Toggle C2 configurations to contexts for end users the same way you configure and
enable D2 configuration components. If you enable a C2 View configuration, D2 always uses the C2
view instead of the default D2 view.

You can use C2 to secure and apply controls to PDF documents when they are distributed out of the
repository. The main functions are:

• Ensuring only secure versions are provided when viewing, exporting, and printing.
• Controlling printing using print counters and adding the ability to print with the note designating
the recipient. D2 audits the controlled prints using the information provided by the end user when
submitting the content for printing.
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• Controlling PDF security settings, such as setting passwords for opening the file, applying
encryption, and removal of save and print functions.

Configuring a Dynamic View Configuration
1. Navigate to C2 > View configuration from the menu bar.
2. Click New to create a view configuration.

If you want to create a child view configuration that inherits the properties of an existing view
configuration, select a view configuration and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:
Field Description

Name Select a view configuration.

Description Type a description.

Applications Add or remove the applications to which this view
configuration applies. For example, adding the QA
application would cause the view configuration to
only apply to matching quality assurance cases.

Default configuration Select to make this configuration the default view
configuration.

If more than one default configuration is applicable
for the end user in a context within the configuration
matrix, D2 uses the top-most configuration in the
C2 View Configuration page.

Compatibility Select the oldest compatible version of the PDF
viewing software.

Full compression If you are using Acrobat 6.0 or later, select the
option to compress the view configuration.

Label <language> Type a label.

Input format Select a rendition to use if no C2 rendition
configuration is applied to the content.

4. To configure the list of properties of the content, select the Properties tab:
a. Select a property from Properties or from the list of added properties.
b. If you want to apply a dictionary to the property, select a dictionary from Dictionaries and

optionally an alias or language.
c. Click Insert to add the property.

5. To configure the security parameters of the content, select the Protection tab:
a. Fill out the fields as described in the following table:

Field Description

Encryption level Select to use either 40 or 128 bit encryption levels.

User password Set a password for opening the PDF.

Password to modify preference Set a password for modifying the PDF.
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b. Select Allow printing, Allow modify content, Allow copy, or Allow modify annotations to
allow the user to perform the respective actions.

6. To configure the default viewing settings, select the Initial View tab:
a. Fill out the fields as described in the following table:

Field Description

Page Layout Select the page layout.

Display Select the display mode.

Displayed page on running Select the page number to show when the content
is opened.

b. Configure the window by selecting or clearing Resize from init page, Center on the screen,
and Open with fullscreen mode.

c. Configure the user interface by selecting or clearing Hide Tool bar, Hide menu bar, and
Hide Windows UI.

7. To merge files into the current content:
a. To insert a table of contents, click Insert table of content and fill out the form as described in

the following table:
Field Description

Name Type a name.

File Import an XSL for formatting the table of contents
XML generated by D2.

Formatting C2 Table of Contents using XSL, page
149 contains further information about the values
to map.

Bookmark label Type a label.

Table of content’s max depth Select the number of levels used by the table of
contents.

Separator type Select the type of separator used between the title
of a section and the page number.

b. To insert a blank page, click Insert blank page and fill out the form as described in the
following table:
Field Description

Name Type a name.

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

c. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:
Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.
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Field Description

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

d. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:
Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

e. Use the list controls to reorder merged files.
8. To add stamping to the content:

a. To add an image watermark, click Insert image watermark. Select an image from the list box
or click New to open a dialog box for adding an image. Type a name for the file, click Browse
to select a file, then select a Format from the list box, and click OK.

Click Properties to view and edit the properties of the watermark.

b. To add a text watermark, click Insert text watermark. Select a watermark from the list box or
click New to open the C2 watermark properties dialog box. Fill out the form as described in
the following table:
Field Description

Name Type a name.

Text Type the text for the watermark. You can use the
following variables:

• $value() to use properties and optionally
dictionaries.

For example, use $value(a_status) to
show the status of content.

• $dqlvalue() to use a DQL query.

For example, use $dqlvalue("se-
lect a_status from dm_document
where r_object_id=’$value(r_ob-
ject_id)’") to show the status of the
specified content.

Font name Select a font from the list box.

Font size Select or type a font size.

Font color Select a font color.

Horizontal align Select the horizontal alignment.
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Field Description

Vertical align Select the vertical alignment.

Opacity Select the opacity.

Rotation Select the rotation.

You can click Properties to view and edit the properties of the watermark.

c. To add a PDF layer, click Insert PDF layer. Select a file from the list box or click Browse to
open a dialog box for adding a file. Type a name for the file, click Browse to select a file, then
select a Format from the list box, and click OK.

You can use a PDF document to add dynamic image watermarking. The PDF document you add
as a PDF layer must contain a text field that uses the $image() variable to refer to an image.

For example, if you store images named after content status in the /System/Images/
folder, type the following line in the text field:

$image(/System/Images/$value(a_status).jpg)

d. You can click Preview to preview the look of the watermark.

Watermarks that use a PDF layer and a variable do not show up in the preview.

e. Fill out the form as described in the following table:

Field Description

Applicated on Select the scope of pages you want to apply the
watermarks.

From Select the first bookmark.

to page Select the last bookmark.

Apply on top of content Select to place the watermark over the text. By
default, watermarks are placed below the text.

9. To configure the document content:
a. To insert a blank page, click Insert blank page and fill out the form as described in the

following table:

Field Description

Name Type a name.

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

b. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.
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Field Description

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

c. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

d. To delete a page, click Delete a document content page, then type the page number of the
page to delete.

e. Use the list controls to reorder document content.

10.Click Save.

Configuring a Dynamic Print Configuration
1. Navigate to C2 > Print configuration from the menu bar.

2. Click New to create a print configuration.

If you want to create a child print configuration that inherits the properties of an existing print
configuration, select a print configuration and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Select a print configuration.

Description Type a description.

Default configuration Select to make this configuration the default print
configuration.

If you enable more than one default configuration
in the configuration matrix, D2 prioritizes
top-to-bottom among the configurations labeled as
default.

Compatibility Select the oldest compatible version of the PDF
viewing software.
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Field Description

Label <language> Type a label.

Input format (will be used only if there is no C2
rendition configuration applied on document)

Select a file format.

4. Configure the form for end users to fill out as described in the following table:

Field Description

Field number <number> Select to enable and configure the field in the
controlled printing dialog box for D2 Client.

Label <language> Type a label.

Assistance type Select the input mode for entering the reason for
printing.

• Free text: the user types the reason.

• DQL: type a query to provide the user with a
dynamic list of values.

• Dictionary: select a dictionary for a static list
of values.

End users are required to fill out these fields when they print through C2. The information typed
into the field is stored and shown with the D2 audit for the controlled print.

The Field n°1 field corresponds to the list of recipients. End users can type a list of users in this
field during controlled print. The Recipient field in the recall print dialog for D2 Client functions
as a list box of users entered in Field n°1.

5. To merge files into the current content:
a. To insert a table of contents, click Insert table of content and fill out the form as described in

the following table:

Field Description

Name Type a name.

File Import an XSL for formatting the table of contents
XML generated by D2.

Formatting C2 Table of Contents using XSL, page
149 contains further information about the values
to map.

Bookmark label Type a label.

Table of content’s max depth Select the number of levels used by the table of
contents.

Separator type Select the type of separator used between the title
of a section and the page number.

b. To insert a blank page, click Insert blank page and fill out the form as described in the
following table:

Field Description

Name Type a name.
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Field Description

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

c. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

d. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

e. Use the list controls to reorder merged files.

6. To add stamping to the content:

a. To add an image watermark, click Insert image watermark. Select an image from the list box
or click New to open a dialog box for adding an image. Type a name for the file, click Browse
to select a file, then select a Format from the list box, and click OK.

You can click Properties to view and edit the properties of the watermark.

b. To add a text watermark, click Insert text watermark. Select a watermark from the list box or
click New to open the C2 watermark properties dialog box. Fill out the form as described in
the following table:

Field Description

Name Type a name.
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Field Description

Text Type the text for the watermark. You can use the
following variables:

• $value() to use properties and optionally
dictionaries.

For example, use $value(a_status) to
show the status of content.

• $dqlvalue() to use a DQL query.

For example, use $dqlvalue("se-
lect a_status from dm_document
where r_object_id=’$value(r_ob-
ject_id)’") to show the status of the
specified content.

Font name Select a font from the list box.

Font size Select or type a font size.

Font color Select a font color.

Horizontal align Select the horizontal alignment.

Vertical align Select the vertical alignment.

Opacity Select the opacity.

Rotation Select the rotation.

Click Properties to view and edit the properties of the watermark.

c. To add a PDF layer, click Insert PDF layer. Select a file from the list box or click Browse to
open a dialog box for adding a file. Type a name for the file, click Browse to select a file, then
select a Format from the list box, and click OK.

You can use a PDF document to add dynamic image watermarking. The PDF document you add
as a PDF layer must contain a text field that uses the $image() variable to refer to an image.

For example, if you store images named after content status in the /System/Images/
folder, type the following line in the text field:

$image(/System/Images/$value(a_status).jpg)

d. You can click Preview to preview the look of the watermark.

Watermarks that use a PDF layer and a variable do not show up in the preview.

e. Fill out the form as described in the following table:

Field Description

Applicated on Select the scope of pages you want to apply the
watermarks.

From Select the first bookmark.

to page Select the last bookmark.

Apply on top of content Select to place the watermark over the text. By
default, watermarks are placed below the text.

7. To configure the document content:
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a. To insert a blank page, click Insert blank page and fill out the form as described in the
following table:

Field Description

Name Type a name.

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

b. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

c. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

d. To delete a page, click Delete a document content page, then type the page number of the
page to delete.

e. Use the list controls to reorder document content.
8. Click Save.

Configuring a Dynamic Export Configuration
1. Navigate to C2 > Export configuration from the menu bar.
2. Click New to create an export configuration.

If you want to create a child export configuration that inherits the properties of an existing export
configuration, select an export configuration and click Create from. Understanding Parent and
Child Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:
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Field Description

Name Select a export configuration.

Description Type a description.

Applications Add or remove the applications to which this export
configuration applies. For example, adding the QA
application would cause the export configuration to
only apply to matching quality assurance cases.

Default configuration Select to make this configuration the default export
configuration.

If you enable more than one default configuration
in the configuration matrix, D2 prioritizes
top-to-bottom among the configurations labeled as
default.

Compatibility Select the oldest compatible version of the PDF
viewing software.

Full compression If you are using Acrobat 6.0 or later, select the
option to compress the export configuration.

Label <language> Type a label that shows in the D2 interface.

Input format Select the file format used when exporting content.

4. To configure the list of properties of the content, select the Properties tab:
a. Select a property from Properties or from the list of added properties.
b. If you want to apply a dictionary to the property, select a dictionary from Dictionaries and

optionally an alias or language.
c. Click Insert to add the property.

5. To configure the security parameters of the content, select the Protection tab:
a. Fill out the fields as described in the following table:

Field Description

Encryption level Select to use either 40 or 128 bit encryption levels.

User password Set a password for opening the PDF.

Password to modify preference Set a password for modifying the PDF.

b. Select Allow printing, Allow modify content, Allow copy, or Allow modify annotations to
allow the user to perform the respective actions.

6. To configure the default viewing settings, select the Initial View tab:
a. Fill out the fields as described in the following table:

Field Description

Page Layout Select the page layout.

Display Select the display mode.

Displayed page on running Select the page number that appears when the
content is opened.

b. Configure the window by selecting or clearing Resize from init page, Center on the screen,
and Open with fullscreen mode.
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c. Configure the user interface by selecting or clearing Hide Tool bar, Hide menu bar, and
Hide Windows UI.

7. To merge files into the current content:
a. To insert a table of contents, click Insert table of content and fill out the form as described in

the following table:

Field Description

Name Type a name.

File Import an XSL for formatting the table of contents
XML generated by D2.

Formatting C2 Table of Contents using XSL, page
149 contains further information about the values
to map.

Bookmark label Type a label.

Table of content’s max depth Select the number of levels used by the table of
contents.

Separator type Select the type of separator used between the title
of a section and the page number.

b. To insert a blank page, click Insert blank page and fill out the form as described in the
following table:

Field Description

Name Type a name.

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

c. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

d. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.
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Field Description

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

e. Use the list controls to reorder merged files.

8. To add stamping to the content:

a. To add an image watermark, click Insert image watermark. Select an image from the list box
or click New to open a dialog box for adding an image. Type a name for the file, click Browse
to select a file, then select a Format from the list box, and click OK.

Click Properties to view and edit the properties of the watermark.

b. To add a text watermark, click Insert text watermark. Select a watermark from the list box or
click New to open the C2 watermark properties dialog box. Fill out the form as described in
the following table:

Field Description

Name Type a name.

Text Type the text for the watermark. You can use the
following variables:

• $value() to use properties and optionally
dictionaries.

For example, use $value(a_status) to
show the status of content.

• $dqlvalue() to use a DQL query.

For example, use $dqlvalue("se-
lect a_status from dm_document
where r_object_id=’$value(r_ob-
ject_id)’") to show the status of the
specified content.

Font name Select a font from the list box.

Font size Select or type a font size.

Font color Select a font color.

Horizontal align Select the horizontal alignment.

Vertical align Select the vertical alignment.

Opacity Select the opacity.

Rotation Select the rotation.

You can click Properties to view and edit the properties of the watermark.

c. To add a PDF layer, click Insert PDF layer. Select a file from the list box or click Browse to
open a dialog box for adding a file. Type a name for the file, click Browse to select a file, then
select a Format from the list box, and click OK.

You can use a PDF document to add dynamic image watermarking. The PDF document you add
as a PDF layer must contain a text field that uses the $image() variable to refer to an image.
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For example, if you store images named after content status in the /System/Images/
folder, type the following line in the text field:

$image(/System/Images/$value(a_status).jpg)

d. You can click Preview to preview the look of the watermark.

Watermarks that use a PDF layer and a variable do not show up in the preview.

e. Fill out the form as described in the following table:

Field Description

Applicated on Select the scope of pages you want to apply the
watermarks.

From Select the first bookmark.

to page Select the last bookmark.

Apply on top of content Select to place the watermark over the text. By
default, watermarks are placed below the text.

9. To configure the document content:

a. To insert a blank page, click Insert blank page and fill out the form as described in the
following table:

Field Description

Name Type a name.

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

b. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

c. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.
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Field Description

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

d. To delete a page, click Delete a document content page, then type the page number of the
page to delete.

e. Use the list controls to reorder document content.
10.Click Save.

Configuring a Static Configuration
1. Navigate to C2 > Rendition configuration from the menu bar.
2. Click New to create a static configuration.

If you want to create a child static configuration that inherits the properties of an existing static
configuration, select a static configuration and click Create from. Understanding Parent and Child
Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:

Field Description

Name Select a print configuration.

Description Type a description.

Compatibility Select the oldest compatible version of the PDF
viewing software.

4. Select an Input rendition format and an Output rendition format from the list boxes. For
example, you can select Acrobat PDF and C2 PDF Rendition, respectively, to create a
configuration that converts Acrobat PDF to C2 PDF.

5. To configure the list of properties of the content, select the Properties tab:
a. Select a property from Properties or from the list of added properties.
b. If you want to apply a dictionary to the property, select a dictionary from Dictionaries and

optionally an alias or language.
c. Click Insert to add the property.

6. To configure the security parameters of the content, select the Protection tab:
a. Fill out the fields as described in the following table:

Field Description

Encryption level Select to use either 40 or 128 bit encryption levels.

User password Set a password for opening the PDF.

Password to modify preference Set a password for modifying the PDF.

b. Select Allow printing, Allow modify content, Allow copy, or Allow modify annotations to
allow the user to perform the respective actions.

7. To configure the default viewing settings, select the Initial View tab:
EMC Documentum

Version 4.2 Administration Guide 145



Configuring C2

a. Fill out the fields as described in the following table:

Field Description

Page Layout Select the page layout.

Display Select the display mode.

Displayed page on running Select the page number that appears when the
content is opened.

b. Configure the window by selecting or clearing Resize from init page, Center on the screen,
and Open with fullscreen mode.

c. Configure the user interface by selecting or clearing Hide Tool bar, Hide menu bar, and
Hide Windows UI.

8. To merge files into the current content:
a. To insert a table of contents, click Insert table of content and fill out the form as described in

the following table:

Field Description

Name Type a name.

File Import an XSL for formatting the table of contents
XML generated by D2.

Formatting C2 Table of Contents using XSL, page
149 contains further information about the values
to map.

Bookmark label Type a label.

Table of content’s max depth Select the number of levels used by the table of
contents.

Separator type Select the type of separator used between the title
of a section and the page number.

b. To insert a blank page, click Insert blank page and fill out the form as described in the
following table:

Field Description

Name Type a name.

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

c. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.
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d. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

e. Use the list controls to reorder merged files.
9. To add stamping to the content:

a. To add an image watermark, click Insert image watermark. Select an image from the list box
or click New to open a dialog box for adding an image. Type a name for the file, click Browse
to select a file, then select a Format from the list box, and click OK.

You can click Properties to view and edit the properties of the watermark.

b. To add a text watermark, click Insert text watermark. Select a watermark from the list box or
click New to open the C2 watermark properties dialog box. Fill out the form as described in
the following table:

Field Description

Name Type a name.

Text Type the text for the watermark. You can use the
following variables:

• $value() to use properties and optionally
dictionaries.

For example, use $value(a_status) to
show the status of content.

• $dqlvalue() to use a DQL query.

For example, use $dqlvalue("se-
lect a_status from dm_document
where r_object_id=’$value(r_ob-
ject_id)’") to show the status of the
specified content.

Font name Select a font from the list box.

Font size Select or type a font size.

Font color Select a font color.

Horizontal align Select the horizontal alignment.

Vertical align Select the vertical alignment.

Opacity Select the opacity.

Rotation Select the rotation.
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Click Properties to view and edit the properties of the watermark.

c. To add a PDF layer, click Insert PDF layer. Select a file from the list box or click Browse to
open a dialog box for adding a file. Type a name for the file, click Browse to select a file, then
select a Format from the list box, and click OK.

You can use a PDF document to add dynamic image watermarking. The PDF document you add
as a PDF layer must contain a text field that uses the $image() variable to refer to an image.

For example, if you store images named after content status in the /System/Images/
folder, type the following line in the text field:

$image(/System/Images/$value(a_status).jpg)

d. You can click Preview to preview the look of the watermark.

Watermarks that use a PDF layer and a variable do not show up in the preview.

e. Fill out the form as described in the following table:

Field Description

Applicated on Select the scope of pages you want to apply the
watermarks.

From Select the first bookmark.

to page Select the last bookmark.

Apply on top of content Select to place the watermark over the text. By
default, watermarks are placed below the text.

10. To configure the document content:
a. To insert a blank page, click Insert blank page and fill out the form as described in the

following table:

Field Description

Name Type a name.

Landscape orientation Select to flip the page to be horizontally oriented.

Only if it’s a even page Select if the page is a blank page that users only
view when it falls on an even page.

b. To insert a PDF file, click Insert PDF and fill out the form as described in the following table:

Field Description

Name Type a name.

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

c. To insert an XSL file, click Insert XSL and fill out the form as described in the following table:

Field Description

Name Type a name.
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Field Description

File Select a file from the list box or click Browse,
type a name for the file, click Browse to select a
file, then select a Format from the list box, and
click OK.

Bookmark label Type a label.

Properties Click to open the C2 Xsl file property dialog box.
You can add, remove, and reorder DQL queries
for modifying the properties of the XSL file.

Include bookmarks contained in the pdf Select to add the contained bookmarks to the list.

d. To delete a page, click Delete a document content page, then type the page number of the
page to delete.

e. Use the list controls to reorder document content.
11. Click Save.

Formatting C2 Table of Contents using XSL
D2 automatically generates an XML containing the elements of the table of contents. Create and
import an XSL for formatting the table of contents when viewing, printing, or exporting content in C2.

The XML uses parameters within an object in the root as described in the following table:

Parameter Description

depth The depth is a numeric value indicating
the number of indentations preceding the
element in the table of contents. For example,
<depth>0</depth> corresponds to 0 indentations,
while <depth>1</depth> corresponds to a single
indentation.

action The action indicates the type of link being used by the
element in the table of contents. Use GOTO to have
the table of contents send the reader to the element
when the link is clicked.

title The title is the label shown for the element in the table
of contents.

page The page is the page number.

Configuring C2 Administrator Access
You can configure the group of users given access to changing C2 settings using D2 Config.
1. Navigate to Tools > Options from the menu bar.
2. Click the C2 Options tab.
3. Select or type a group to set as the C2 Administrator group.
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4. Click Save.

Clearing the dmi_queue_item After Creating a
C2 Rendition
The C2 plug-in creates a c2_rendition event in the dmi_queue_item queue to generate the
PDF rendition. After completing the request and generating the PDF, D2 marks the item as dequeued
but does not clear the dmi_queue_item events.

To remove the queue items you must either:

• Use the queue management tool to remove the queue item.

The queue management tool is installed out-of-the-box in an inactive state. The EMC Documentum
Content Server Administration and Configuration Guide contains more information about the
queue management tool.

• Delete the queue items using the DELETE...OBJECT DQL query. For example, to remove all
queue objects representing objects that were dequeued before January 1, 2013:

DELETE "dmi_queue_item" OBJECTS WHERE "dequeued_date" <
DATE(’01/01/2013’) AND "delete_flag" = true
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Configuring O2

This chapter contains the following topics:

• Configuring the O2 Transfer Configuration in D2
• Configuring File Formats Recognized by O2
• Configuring Microsoft Office for O2

Configuring the O2 Transfer Configuration in D2
Use O2 to allow management of properties transfer between D2 and Microsoft Office documents as
well as between .eml and .msg email messages.
1. Navigate to O2 > Transfer configuration from the menu bar.
2. Click New to create an O2 transfer configuration.

If you want to create a child O2 transfer configuration that inherits the properties of an existing O2
transfer configuration, select an O2 transfer configuration and click Create from. Understanding
Parent and Child Configurations, page 16 contains more information on child configurations.

3. Fill out the form as described in the following table:
Field Description

Name Type a name to appear in the configuration matrix.

Description Type a description.

Applications Add or remove the applications to which this
transfer configuration applies. For example,
adding the QA application would cause the transfer
configuration to only apply to matching quality
assurance cases.

Format of “date” property type Type a date format using dd for date, MM for month,
and yy for the last two digits of the year.

Trigger events Use the list controls to add and remove the events
that trigger properties transfer. If the list is empty,
O2 is activated on all events except view and
check out.

4. Configure properties to transfer:
a. Use the list controls to add or remove properties.

Content imported in D2 Client with an associated O2 configuration inherits the selected
properties.

b. Fill out the form as described in the following table:
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Field Description

Documentum property Type the Documentum name of the property.

Office property Type the Microsoft Office name of the property.

Relation direction Select the direction of the property transfer.

Do not use a bidirectional relationship with
repeating properties.

Dictionary Select a dictionary to use a dictionary.

Alias/Locale Select an alias or locale to specify the dictionary
being used.

5. Configure DQL queries to use in the Microsoft Office document:
a. Use the list controls to add or remove DQL queries.
b. Fill out the form as described in the following table:

Field Description

DQL query identifier Type a name.

DQL query Type a DQL query.

6. Click Save.

Configuring File Formats Recognized by O2
1. Navigate to Tools > Options from the menu bar.
2. Click the O2 Options tab.
3. Use the list controls to add and remove file formats recognized by O2.
4. Click Save.

Configuring Microsoft Office for O2
Perform the following steps on all end user machines. Refer to the documentation for the Microsoft
Office products for detailed instructions on creating and enabling a macro, setting trusted locations,
and adding properties.
1. Create a macro and enter the following set of code:

Sub AutoOpen()

Dim aStory As Range
Dim aField As Field

For Each aStory In ActiveDocument.StoryRanges
For Each aField In aStory.Fields
aField.Update
Next aField
Next aStory

ActiveDocument.Saved = True
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End Sub

2. In the Microsoft Office configurations:

a. Enable the macro.

b. Add the D2 repository view and checkout folders used by end users to the Trusted Locations
list.

3. Create the properties in Microsoft Word, Excel, and Powerpoint to allow O2 to transfer property
information.

4. To update the values of inserted properties in Microsoft Word, right-click the properties and select
Update fields.

If you cannot update the fields, make sure Update fields is enabled in the Microsoft Word
configurations.
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Chapter 17

Using D2 Specs

This chapter contains the following topics:

• Configuring D2 Specs Module Descriptions
• Generating a Specifications Document

Configuring D2 Specs Module Descriptions
You can modify the descriptions of D2 modules. D2 Specs uses the descriptions when generating a
specification document of your D2 configuration.

1. Navigate to Tools >Modules description from the menu bar.

2. Type a description for modules used.

3. Click Save.

Generating a Specifications Document
1. Navigate to Specifications > Generate configurations from the menu bar.

2. Fill out the form as described in the following table:

Field Description

Applications Select the application for which the specification is
generated.

Display elements without application Select to display configuration components that are
not assigned to applications.

Include dictionaries Select to include dictionaries.

Include taxonomies Select to include taxonomies.

Include registered tables Select to include registered tables.

3. Click OK.
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Chapter 18
Using D2 Retention Policy Services
(RPS)

This chapter contains the following topics:

• Understanding the D2 RPS Plug-In
• Adding Documentum RPS Policies to the Configuration Matrix

Understanding the D2 RPS Plug-In
The D2 RPS plug-in adds two modules to the configuration matrix to allow you to manage and use
retention and markup policies in D2 lifecycles:

• Retention policy configuration: Allows management of the preservation of repository content.
• Retention markup: Allows usage of Documentum RPS markup policies.
To use retention policies in D2, configure policies using Documentum Retention Policy Services.
EMC Documentum Records Client Administration and User Guide contains further information.
In D2, apply the retention or markup policies you create to contexts in the configuration matrix.
You can then use the policies in a D2 lifecycle using the D2ApplyRetentionMethod and
D2ApplyMarkupMethod methods.

Adding Documentum RPS Policies to the
Configuration Matrix
1. Navigate to:

• D2–RPS > Retention policy from the menu bar for retention policies.
• D2–RPS > Retention markup from the menu bar for markup policies.

2. Fill out the form as described in the following table:

Field Description

Name Select the policy that was configured in
Documentum RPS.

Description Type a description.

Application Add or remove the applications to which this
document link applies. For example, adding the QA
application would cause the policy to only apply to
matching quality assurance cases.

3. Click Save.
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Using D2-Bin

This chapter contains the following topics:

• Configuring D2-Bin
• Incorrect Properties for Content in the Recycle Bin

Configuring D2-Bin
The D2-Bin plug-in adds a recycling-bin approach to managing document removal in D2. If D2-Bin is:

• Not installed, D2 permanently removes content when an end user deletes content.

• Installed, D2 moves deleted content to an electronic recycling bin, which allows end users and
functional administrators to view, permanently remove, and restore content.

1. Navigate to D2-Bin > Options from the menu bar.

2. Fill out the form as described in the following table:

Field Description

Group allowed to administrate every recycle bin Select the user group to have administrative
privileges for the Recycle Bin widget.

Users can destroy documents located in their own
recycle bin

Select to allow users to permanently remove content
in their own recycle bin.

Send an email warning when the global size of the
recycle bin is more than <value>MB

Type megabyte value.

When the combined size of all user recycle bins
becomes larger than the input size, D2 sends an
email warning.

Send an email warning when the size of a user
recycle bin is more than <value>MB

Type a megabyte value.

When the size of any individual user recycle bin
becomes larger than the input size, D2 sends an
email warning.

Send email warning to Select the user group to which D2 sends the email
warnings.

3. Click Save.
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Incorrect Properties for Content in the Recycle
Bin
Due to the way the repository handles content in the recycle bin, D2 shows incorrect values for the
following properties:

• a_content_type

• i_chronicle_id

• i_contents_id

• i_antecendent_id

• i_direct_dsc

• i_latest_flag

• i_vstamp

• i_folder_id

• r_folder_path

• r_version_label - The value for r_version_label shows the correct version but also
incorrectly labels the content in the recycle bin as the CURRENT version.

• r_link_cnt

• r_modifier

• r_modify_date

• r_page_cnt

• r_content_size

• r_full_content_size

• r_immutable_flag
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Chapter 20

Optimizing D2

This chapter contains the following topics:

• Optimizing Content Import
• Optimizing Property Pages
• Optimizing Searches
• Optimizing Workspaces

Optimizing Content Import
You can configure D2 to execute actions, such as a lifecycle action, during content import. Enabling
Execute actions on start increases the back-end processing to complete the transaction and the
complexity of the actions further impacts the processing time. To prevent unnecessry performance
overhead, enable Execute actions on start for a configuration only if the actions are required.

Optimizing Property Pages
Select Load asynchronously when configuring property pages that contain combo or list fields that
perform a DQL query. When the option is enabled, D2 executes the DQL when the end user selects the
specific property instead of when the property page is loaded. D2 does not need to perform the DQL
query when loading a property page because the query is not necessary when the end user is viewing
instead of editing. Avoiding unnecessary DQL queries improves the response time for displaying the
property page and reduces the load on the Content Server and the database.

If you use an asynchronous DQL query:

• Use the $value(filter) wildcard to enable filtering. If you do not use the wildcard, the query
returns all values when an end user selects a list box.

• Limit the returned result set by using the enable (return_top <number of results>)
keyword. To use this keyword, set the return_top_results_row_based parameter in the
Content Server server.ini file to F.

The response time for loading a property page depends on the number of components on the property
page. Take advantage of contexts to create and configure targeted property page definitions instead of a
single comprehensive property page.
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Optimizing Searches
Use the following guidelines to optimize performance of searches:

• Use a full-text search engine such as Documentum xPlore in a large-scale environment because by
default the search operations use DQL queries, which may be inefficient on large data sets.

• You can create function-based indexes to improve search performance, but it is difficult to predict
the attributes that D2 uses for case insensitive searches. Each additional function-based index
consumes additional storage and can cause space issues.

• Set theMaximum results returned by search to a smaller value in the Global search configuration
page to reduce the impact of searches with a large number of results.

• Query form searches do not use the Maximum results returned by search value nor the
dfc.search.max_results parameters in dfc.properties. Make sure to design the DQL
query for query forms to be more selected or use the enable (return_top <number of
results>) keyword to limit the returned result set andfac reduce performance overhead.

Asynchronous Searches for D2 3.1

Asynchronous searches can cause high memory strain on the web application server because they are
saved to memory. Use the following guidelines to optimize saved asynchronous searches:

• Limit DQL queries by adding the parameter enable (RETURN_TOP 100)

• SetMaximum number of asynchronous searches in a user session to limit the maximum number
of asynchronous searches that end users can perform.

Optimizing Workspaces
The number of widgets displayed on a web page can affect response time, particularly in WAN
conditions with low latency. Construct workspaces focused on specific tasks instead of a
comprehensive workspace for all possible scenarios.

When configuring a workspace, note that widgets on a workspace do not share query results. For
example, if a workspace contains both a Doclist widget and a Searches widget, running an Advanced
Search with facets triggers the same full-text query twice: one to update the result list in the Doclist
widget and one to update the facet tree in the Searches widget. In a high workload scenario, this
uses more search engine resources.

162

EMC Documentum

Version 4.2 Administration Guide



Chapter 21

Formatting Date and Time

This chapter contains the following topics:

• Understanding Date Formats

Understanding Date Formats
You can configure date and time formats by changing their pattern strings. D2 interprets unquoted
letters from A to Z and a to z as patterns representing the components of a date or time string. You can
surround text in single quotes to avoid interpretation. The following table describes the defined letters:

Letter Component Presentation Example

G Era designator Text AD

y Year Year 1996 or 96

M Month in year Month July or Jul or 07

w Week in year Number 27

W Week in month Number 2

D Day in year Number 189

d Day in month Number 10

F Day of week in month Number 2

E Day in week Text Tuesday or Tue

a AM/PM marker Text PM

H Hour in day (0–23) Number 0

k Hour in day (1–24) Number 24

K Hour in AM/PM (0–11) Number 0

h Hour in AM/PM (1–12) Number 12

m Minute in hour Number 30

s Second in minute Number 55

S Millisecond Number 978

z Time zone General time zone Pacific Standard Time or
PST or GMT-08:00

Z Time zone RFC 822 time zone –0800

All other characters from A to Z and a to z are reserved.
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Make use of rules for presentations to determine formatting. The following table describes how
different string contexts affect a presentation:

Presentation Rule

Text If the number of pattern letters is 4 or more, the full
form is used.

Otherwise a short form is used if available.

For parsing, both forms are accepted independent of
the number of pattern letters.

Number The number of pattern letters is the minimum number
of digits required. If there are not enough numbers,
the amount is zero-padded.

For parsing, the number of pattern letters is ignored
unless needed to separate adjacent fields.

Year If the number of pattern letters is 2, the year is
truncated to 2 digits.

Otherwise the year is treated as a number.

For parsing with the abbreviated year pattern (y or
yy), the year is abbreviated relative to the century.
The date is adjusted to be between 80 years before and
20 years after the creation of the SimpleDateFormat
instance.

For example, if a date using the format MM/dd/yy
is created January 1, 1997, the string 0/11/12 is
treated as January 11, 2012. The string 05/04/64 is
treated as May 4, 1964.

Note that a string must consist of exactly two digits
as defined by Character.isDigit(char) to be
parsed into the default century. Other numeric strings,
such as a single-digit string, are parsed literally. For
example, 01/02/3 is treated as January 2, 3 AD.

Month If the number of pattern letters is 3 or more, the month
is treated as text.

Otherwise the month is treated as a number.

General time zone If the time zone has a name, it is treated as text.

If the time zone represents a GMT offset value, the
following syntax is used:

GMTOffsetTimeZone: GMT Sign Hours:
Minutes

Where Sign is + or –, Hours is between 0 and 23, and
Minutes is between 0 and 59.
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Presentation Rule

For parsing take digits from the Basic Latin block
of the Unicode standard. The locale is independent.
RFC 822 time zones are accepted for parsing.

RFC 822 time zone For formatting use the following syntax:

RFC822TimeZone: Sign TwoDigitHours
Minutes

Where Sign is + or –, TwoDigitHours is between 00
and 23, and Minutes is between 0 and 59.

Use the following table for examples of how D2 interprets date and time pattern strings:

Date and Time Pattern Result

yyyy.MM.dd G ’at’ HH:mm:ss z 2001.07.04 AD at 12:08:56 PDT

EEE, MMM d, ”yy Wed, Jul 4, ’01

h:mm a 12:08 PM

hh ’o”clock’ a, zzzz 12 o’clock PM, Pacific Daylight Time

K:mm a, z 0:08 PM, PDT

yyyyy.MMMMM.dd GGG hh:mm aaa 02001.July.04 AD 12:08 PM

EEE, d MMM yyyy HH:mm:ss Z Wed, 4 Jul 2001 12:08:56 –0700

yyMMddHHmmssZ 010704120856–0700
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Chapter 22

Widgets Reference

This chapter contains the following topics:

• List of Widgets

List of Widgets
Use internal repository navigation widgets as described in the following table:

Name in D2 Config Name in D2 Client Description

BrowserWidget Browser Displays cabinets and folders.

Enables uncluttered browsing of a
repository tree.

Required for use in a workspace
when an IntelligentURL locateID
is used to locate a document or
folder object.

DoclistWidget Document list Displays content and virtual
documents.

Enables full browsing and
content-seeking capabilities.

Use this widget to access the
content context menu.

Displays results from Quick search
and Predefined search widgets.

DocgalleryWidget Thumbnail Enables thumbnail previews for
browsing content.

You must set up a thumbnail server
to show and customize thumbnails.

PDFViewerWidget PDF Viewer Displays the PDF rendition of
selected content.

The widget displays a message if
a PDF rendition is not found for
selected content.

The widget downloads the file from
the application server even if you
install and enable a BOCS server.
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Name in D2 Config Name in D2 Client Description

FavoritesWidget Favorites Displays a list of content marked
as favorite.

CheckoutDocumentWidget Checkout Displays a list of checked-out
content with user name and time of
checkout.

CenterStageWidget CenterStage browser Enables browsing of CenterStage
spaces.

Only displays the Collaboration
folder.

CommentsWidget Comments Enables viewing, creating,
deleting, and replying to comments
about content.

RecycleBinWidget Recycle Bin Enables managing and restoring
deleted content.

If you have administrator
privileges, you can access the
recycle bins of other users.

Use search widgets as described in the following table:

Name in D2 Config Name in D2 Client Description

QuickSearchWidget Quick search Enables full-text searches.

SearchFormWidget Search query form Enables using pre-configured query
form searches. Administrators
configure an instance of the search
query form widget for each query
form option. Select the widget
instance that matches the query
form search you want to use.

SearchWidget Searches Enables viewing, editing, and
running past and saved searches.

Use internal content properties widgets as described in the following table:

Name in D2 Config Name in D2 Client Description

PropertiesWidget Properties Displays properties of the selected
content.

DetailsLocationsWidget Locations Displays a list of directory
locations in which the selected
content is found.

DetailsVersionsWidget Versions Displays a list of the versions of
the selected content.

DetailsRenditionsWidget Renditions Displays a list of renditions of the
selected content.
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Name in D2 Config Name in D2 Client Description

DetailsRelationsWidget Relations Displays a list of what is linked to
the selected content. This widget
manages content distribution by
allowing you to start distributions,
edit the list of recipients, and
generate reports.

DistributionWidget Distribution Displays a list of distributions sent
to the user. This widget allows
you to accept, reject, and stop
distribution tasks.

DetailsAuditWidget Audit Displays a list of audited actions
for the selected content.

ThumbnailWidget Preview Displays the selected content as a
slideshow.

You must set up an ADTS
rendition server to render previews
and storyboards.

VirtualDocumentWidget Virtual document Displays virtual document
structure.

Snapshots Displays a list of virtual document
snapshots for a virtual document
selected in a Doclist or Virtual
document widget.

DetailsRetentionsWidget Retentions Displays retention policies applied
to the selected content.

DetailsMarkupsWidget Markups Displays markup policies for the
selected content.

Use internal workflow widgets as described in the following table:

Name in D2 Config Name in D2 Client Description

TaskFoldersWidget Tasks browser Displays a list of tasks sorted by
category that have been assigned
to you.

Use this widget to refresh the
Workflow task list widget.

WorkflowOverviewWidget Workflow history Displays a list of past and current
events to show workflow progress.

You must have at least queue
manager permission to access this
widget.

TasksWidget Workflow task list Displays a list of tasks that have
been assigned to you.

Use this widget to access the
workflow context menu.
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Name in D2 Config Name in D2 Client Description

TaskDetailsWidget Task details Displays the subject and message
of selected task.

TaskNotesWidget Task notes Displays a list of accompanying
notes to the selected workflow.

TaskAttachmentWidget Task attachment Displays a list of content attached
to the selected task.

TaskPerformersWidget Workflow performers Displays a list of users organized by
groups assigned to the workflow.

Use administration widgets as described in the following table:

Name in D2 Config Name in D2 Client Description

AdminUsersWidget User Displays a list of users for the
repository.

Use this widget to add, edit, and
remove user accounts and to
change group memberships.

AdminGroupsWidget Group Displays a list of user groups for
the repository.

Use this widget to add or edit user
groups.

AdminDictionariesWidget Dictionaries Displays a list of repository
dictionaries.

Use this widget to view, export,
and configure dictionaries and
values.

AdminTaxonomiesWidget Taxonomies Displays a list of repository
taxonomies.

Use this widget to view, export,
and configure taxonomies and
values.
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Chapter 23

Jobs Reference

This chapter contains the following topics:

• List of D2 Jobs
• List of C2 Jobs

List of D2 Jobs
D2 installs Documentum jobs to the repository during installation. You can configure jobs in external
software, such as Documentum Administrator, to perform scheduled tasks. The following table
describes the jobs available to D2.

Name: D2ImportDictionary

Description: Import or update
dictionaries from Excel or .csv
documents.

Frequency: Once per day

Default state: Inactive

Parameters

• folder: Path of folders containing the files separated by
comma.

• separator: Defines the separating character for .csv
documents.

• overwrite: Enables erasing the dictionary.

• sorted: Enables sorting the dictionary.

• update: Enables updating autolinking with the imported
dictionary.

Name: D2JobImportTaxonomy

Description: Import or update
taxonomies from Excel or .csv
documents.

Frequency: Once per day

Default state: Inactive

Parameters

• folder: Path of folders containing the files separated by
comma.

• separator: Defines the separating character for .csv
documents.
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Name: D2CreateRendition

Description: Request rendition of
content and its components.

Frequency: Once per hour

Default state: Inactive

Parameters

• id: The content ID.

Name: D2JobImportMassCreate

Description: Import and fill
content with Documentum
properties based on XML files
linked to each file.

XML files must be composed of a
root element, document attribute
files, and repeating attributes listed
under the value tag.

filename-meta.xml enables import
of XML content as well as
metadata.

Frequency: Once per day

Default state: Inactive

Parameters

• folder: Path of folders containing the files separated by
comma.

• imported_file_folder: Optional parameter for defining the
folder to place successfully imported files. The default setting
creates a folder within the source folder.

• createconfig: Optional parameter for setting the
object_name of the creation profile to use. Default setting
uses the r_object_type found in the XML file. Documentum
Content Server Fundamentals contains further information
about r_object_type.

• args: Sets the document type to use for values. The parameter
is only required when you set a createconfig.

• async: Use asynchronous creation. Default setting is
false. This parameter is no longer used due to the usage of
D2JobCoreDeQueue.

• naming: By default, apply naming during the creation process.
Set false to apply naming when properties are regenerated.

• unicity: By default, control is deactivated after naming. Set
true to activate control.

Name: D2JobCoreDeQueue

Description: Apply
D2CoreMethod on content located
in d2c_mass_create_queue.

Frequency: Once per day

Default state: Active

Parameters

• scan_queue: By default, executes a scan on the queue. Set
false to prevent the scan.

• naming: By default, apply naming after the queue is scanned.
Set false to apply naming when properties are regenerated.

• create: Executes naming by simulating content creation.
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Name: D2JobDocbaseUpdate

Description: Update autolinking
after a dictionary modification.
Update requests are posted in the
d2_update_docbase_queue

Frequency: Once per day

Default state: Active

Parameters

None.

Name: D2JobLifecycleBatch

Description: Change the lifecycle
state of content based on context.

Frequency: Once per day

Default state: Active

Parameters

None.

Name: D2JobMailing

Description: Send mail based on
context.

Frequency: Once per day

Default state: Active

Parameters

None.

Name: D2JobRemoveEmpty-
Folder

Description: Remove empty
folders from the repository.

Frequency: Once per day

Default state: Inactive

Parameters

• paths: List of paths in the repository to scan separated by a
comma.

• parameters: Specifies the dm_folder subtype to delete.
Default setting is dm_folder.

Name: D2JobWFCleanerWork-
flows

Description: Clean the data
of groups and aliases created
dynamically by workflows
when the workflow has ended.
d2_workflow_tracker
changes to the ended state.

Frequency: Once per day

Default state: Active

Parameters

None.

EMC Documentum

Version 4.2 Administration Guide 173



Jobs Reference

Name: D2JobWFLaunchSched-
uledWorkflows

Description: Scan all
d2_workflow_tracker
states for waiting and
launches workflows.
d2_workflow_tracker
changes to the ongoing state.

Frequency: Once per day

Default state: Active

Parameters

None.

Name: D2JobWFReceive-
TaskMail

Description: Scan email accounts,
recover messages, and extract job
identification of tasks. Receive
responses from external tasks by
mail.

Frequency: Every 15 minutes

Default state: Active

Parameters

None.

Name: D2JobWFSendTaskMail

Description: Scan email accounts,
recover messages, and extract
job identification of tasks. Send
external tasks by mail.

Frequency: Every 15 minutes

Default state: Active

Parameters

None.

Name: D2JobWFWorkflowsNo-
tifications

Description: Send notification if
workflow has not ended after the
planned end date.

Frequency: Once per day

Default state: Active

Parameters

• pause: Sets an interval in milliseconds between each mail sent
to reduce overload.
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Name: D2JobWFCleanPopHistory

Description: Clean email history
table d2_wf_pop and alert
administrators of possible bugs
in reject and accept messages.
Specific to Domino server.

Frequency: On demand, or once
per month.

Default state: Active

Parameters

• month_offset: Sets the number of months to clean.

• full_purge: By default, deletes all mails flagged as a
potential problem. Set to false to prevent full purge.

Name: D2JobDelegation

Description: Delegate all pending
tasks for a user.

Frequency: Once per hour

Default state: Active

Parameters

None.

Name: D2JobClean

Description: Delete unused
dm_acl objects and annotations.

Frequency: Once per day

Default state: Active

Parameters

• clean_native_note: By default, enables cleaning of
annotations. Set false to ignore annotations.

Name: D2JobCore

Description: Re-apply
configurations to existing objects.

Frequency: Once per day

Default state: Inactive

Parameters

• dql_filter select r_object_id from dm_document:
Set a DQL filter to select objects related to the job.

• create: By default, does not apply the job to content during
creation. Set true to apply during creation.

• naming: If create is true, by default apply naming during
creation. Set false to avoid applying naming.

• autolink: By default, applies autolink for property
regeneration. Set false to avoid property regeneration.

• security: By default, applies security to the job. Set false to
avoid applying security.

• apply_for_vd: By default, does not apply the job to child
content. Set true to apply to child content.
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Name: D2JobSubscription

Description: Process items from
d2_subscription_queue to send
notifications for events.

Frequency: Every 5 minutes

Default state: Active

Parameters

None.

Name: D2JobSubscriptionSend-
Mail

Description: Process items from
d2_subscription_queue
to send notifications for events if
notification differed is selected in
the subscription component.

Frequency: Every 5 minutes

Default state: Active

Parameters

None.

List of C2 Jobs
Name: C2JobRendition

Description: Create a C2 static
rendition if a C2 method does not
create the file. Launching the job
adds a static rendition request to
the queue.

Frequency: Once per hour

Default state: Active

Parameters

None.
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Chapter 24

Custom Actions Reference

This chapter contains the following topics:

• List of Custom Actions

List of Custom Actions
You can use custom actions when configuring GUI buttons. The following table describes the actions
available for use:

Action Parameters Parameter description

sType: select the window mode to
use.

Set modal, modeless, or window.

sURL: type the URL to be opened
in a new window.

Add to the URL docbase (current
repository name), adminlogin
(Documentum administrator
name), adminticket (administrator
connection ticket), login (current
user login), ticket (current user
ticket), domain (domain name),
and id (list of IDs separated by a
comma).

sFeatures: specify the features of
the opened window.

For modal or modeless windows:

• dialogHeight: set the height in
pixels.

• dialogLeft: set the left position
relative to the top-left corner.

• dialogTop: set the top position
relative to the top-left corner.

• dialogWidth: set the width in
pixels.

• center: yes, no, 1, 0, on, or off
to specify whether to center the
window or not. Default setting
is yes.

For window mode:

• directories: yes or no to show
navigation buttons.

launchIE
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Action Parameters Parameter description

• location: yes or no to show the
address bar.

• menubar: yes or no to show the
menu bar.

• resizable: yes or no to enable
modification of the window size.

• scrollbars: yes or no to show
scroll bar.

• status: yes or no to show status
bar.

• toolbar: yes or no to shown
toolbar.

• width: set the width in pixels.

• height: set the height in pixels.

bUseAdmin: add parameters
adminlogin and adminticket to the
URL.

Boolean.

sPath: set the path of the executable
of the app you want to run.

Use \\ instead of \ in the path.

For example c:\\Documen-
tum\\Checkout\\
Laborantum\\Copy_Struct.exe

bIsBlocking: indicate if the
executable blocks D2.

Boolean.

bUseAdmin: indicate if the
administrator’s session must be
used.

Boolean.

launchApp: for security reasons,
you can only use the function if
canUseAdminInLaunchApp is
enabled in D2-Client.properties.

bNeedOtherSelection: enable
opening of a document browser
to set a second selection in the
repository.

Boolean.

sMethodName: set the name of the
method to launch.

Type the method name.

bRefresh: set whether to refresh
D2-Client after method launch.

Boolean.

sParameters: define the list of
parameters.

For example, parameter1=xxx&
parameter2=yyy

launchMethod: launch a method
once on all Documentum content.
The list of content IDs is in the
parameter selectedIds.

bLaunchAsync: set whether to use
an asynchronous launch.

Boolean.
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Action Parameters Parameter description

sMethodName: the name of the
method to launch.

Type the method name.

bRefresh: refresh D2-Client after
the method is run.

Boolean.

sParameters: define the list of
parameters.

For example, parameter1=xxx&
parameter2=yyy

launchMethodOnEachIds: launch
a method on each selected
Documentum content. The content
ID is the parameter id.

bLaunchAsync: set whether to use
an asynchronous launch.

Boolean.

Parameters starting with an s are strings and must be enclosed in single quotes. Parameters beginning
with a b are Boolean and can be set as true or false.
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Chapter 25
Widget Communication Channel
Reference

This chapter contains the following topics:

• List of Widget Communications Channels

List of Widget Communications Channels
Widgets use communication channels to send messages, which contain strings of information that
dictate interaction between widgets and repositories.

Select a communication channel when creating and configuring external widgets as described in the
following table:

Channel name When an end user or D2 Parameters and notes for focus
events

D2_EVENT_CUSTOM Uses an external widget. D2 uses
the event to communicate between
widgets.

Parameters depend on the custom
event and should be added to allow
subscribers to identify the specific
events.

D2_EVENT_DM_TICKET_GEN-
ERATED

Sends a message using D2_AC-
TION_DM_TICKET_GENERATE

ticket: Documentum ticket.

ticket_timeout:
Documentum ticket timeout
in milliseconds.

ticket_time_generated:
Time of ticket generation in posix
time.

ticket_time_expiration:
Time of ticket expiration in posix
time.

D2_EVENT_SELECT_OBJECT Selects content. parentId: ID of the parent
object.

parentType: Type of the parent
object.

D2_EVENT_SELECT_OBJECTS Selects multiple content. oam_id: List of
object IDs separated by
SEPARATOR_VALUE.
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Channel name When an end user or D2 Parameters and notes for focus
events

D2_EVENT_LOCATED_OB-
JECT

Locates content. oam_id: ID of the object.

locationType: Location type,
such as the widget type in which
the content is shown.

locateId: ID of the object to
locate.

locateName: Name of the object
to locate.

version: Version of the object
to locate.

chronicleId: ChronicleID of
the object to locate.

collapseId: List of IDs of the
folders to reload.

D2_EVENT_LO-
CATED_SEARCH

Locates a search. oam_id: ID of the object.

D2_EVENT_LOCATED_TASK Locates a task. oam_id: ID of the object.

D2_EVENT_OBJECT_DE-
STROYED

Destroys content. oam_id: List of
object IDs separated by
SEPARATOR_VALUE.

D2_EVENT_OBJECT_CRE-
ATED

Creates content. The channel only applies to the
Doclist widget.

oam_id: ID of the folder.

pathId: Path ID of the ob-
ject. For example, /repon-
ame/0c0d04e580000105/
0b0d04e580055dd8

D2_EVENT_COM-
MENT_ADDED

Creates a comment. The channel only applies to the
Comments widget.

comment: ID of the comment.

D2_EVENT_FIL-
TER_CHANGED

Changes the global filter of the
workspace.

D2_EVENT_CHECK-
OUT_STATE_CHANGED

Changes content checkout state.

D2_EVENT_PREFER-
ENCES_CHANGED

Changes their user preferences.

D2_EVENT_PREFER-
ENCES_LOADED

Loads their user preferences.

D2_EVENT_WIDGET_GET_FO-
CUS

Clicks on a widget.
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D2_EVENT_WIDGET_FOCUS D2 sets a widget to active. config: Widget configuration
name.

widgetType: set the value to the
widget type.

If you want to set a specific instance
of a widget, use config and set
the value to the widget name.

D2_EVENT_SEARCH_RUN Runs a search. The channel only applies to the
Searches widget and the Doclist
widget.

oam_id: ID of the search..

searched_type: Search type.

D2_EVENT_SEARCH_SAVED Saves a search. The channel only applies to the
Searches widget.

oam_id: ID of the search..

is_public: Set to true if the
search is public or shared.

D2_EVENT_SEARCH_CATE-
GORY_CREATED

Creates a search category. The channel only applies to the
Searches widget.

D2_EVENT_WORK-
FLOW_ABORTED

Aborts a workflow. The channel only applies to the
Searches widget.

oam_id: List of
object IDs separated by
SEPARATOR_VALUE.

widgetType: set the value to
the widget type associated with the
event.

D2_EVENT_SELECT_TASK Selects a task. oam_id: ID of the task.

D2_EVENT_SE-
LECT_TASK_FOLDER

Selects a folder in the task manager
widget.

The channel activates task details,
task attachments, and task notes.

oam_id: ID of the task folder.

D2_EVENT_SE-
LECT_TASK_NOTE

Selects a note in the task notes
widget.

The channel only applies when
communicating from the Task
browser widget to the Task list
widget.

oam_id: ID of the task note.
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D2_EVENT_SE-
LECT_TASK_PERFORMER

Selects a performer in the task
performers widget.

oam_id: ID of the task performed.

The following are copied from the
selected item:

icon

id

locked

style

thumbnail

version

immutable: D2 sets this to
true if the item is immutable.

D2_EVENT_TASK_READ_
STATE_CHANGED

Changes the read state of a task. oam_id: ID of the task.

locateId: ID of the task to
locate.

parentId: ID of the parent task.

D2_EVENT_TASK_PRIOR-
ITY_CHANGED

Changes the priority of a task. oam_id: ID of the task.

parentId: ID of the parent task.

D2_EVENT_TASK_PRO-
CESSED

Forwards or rejects a task. oam_id: ID of the task.

D2_EVENT_WIDGET_INITIAL-
IZED

Opens a widget.

D2_EVENT_WORKSPACE_
CLOSED

Closes a workspace. oam_cuid: Uid of the workspace
tab that was closed.

D2_EVENT_THEME_CHANGED Changes a workspace theme. oam_cuid: Uid of the container.

The following are copied from the
theme:

background_color

background_color_type

background_color_gradi-
ent_end

background_color_gradi-
ent_start

background_color_tex-
ture_name

header_color

label: Theme label.
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name: Theme name.

selection_blur_color

selection_color

border_color

title_color

tab_active_color

tab_border_color

tab_inactive_color

dialog_background_white:
D2 sets this to true if the dialog
background is white.

tab_colored_text: Boolean
for whether the tabs use colored
text.

D2_EVENT_RENDI-
TION_ADDED

Creates a different rendition of
content.

The channel only applies to the
Renditions widget.

oam_id: ID of the content.

D2_EVENT_IFRAME_ACTIVE Activates an iframe. oam_value: Boolean to indiciate
if the iframe is activated or
deactivated.

D2_EVENT_IFRAME_INIT Opens an iframe. channels: List of events.

D2_EVENT_THEME_CHANGED
contains information about the
iframe theme.

D2_EVENT_SELECT_TAXON-
OMY

Selects a taxonomy. The channel only applies to the
Properties widget.

oam_id: ID of the taxonomy.

The event copies the taxonomy
item attributes.

D2_EVENT_SELECT_DICTIO-
NARY

Selects a dictionary. The channel only applies to the
Properties widget.

oam_id: ID of the dictionary.

The event copies the dictionary
item attributes.
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D2_EVENT_SELECT_USER Selects a user. The channel only applies to the
Properties widget.

oam_id: ID of the user.

The event copies the user item
attributes.

D2_EVENT_USER_CREATED Creates a user. The channel only applies to the
Users widget.

oam_id: ID of the user.

D2_EVENT_SELECT_GROUP Selects a group. The channel only applies to the
Properties widget.

oam_id: ID of the group.

The event copies the group item
attributes.

D2_EVENT_GROUP_CREATED Creates a group. The channel only applies to the
Groups widget.

oam_id: ID of the group.

D2_EVENT_SELECT_RELA-
TION

Selects a relation. The channel only applies to the
Relations widget.

oam_id: ID of the relation.

The event copies the relation item
attributes.

D2_EVENT_SELECT_RENDI-
TION

Selects a rendition in the rendition
widget.

The channel only applies to the
Renditions widget.

oam_id: ID of the rendition.

The event copies the rendition item
attributes.

D2_EVENT_SELECT_RETEN-
TION

Selects a retention policy. The channel only applies to the
Retentions widget.

oam_id: ID of the retention
policy.

The event copies the retention
policy item attributes.

D2_EVENT_SELECT_MARKUP Selects a markup policy. oam_id: ID of the markup policy.

The event copies the markup policy
item attributes.
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D2_EVENT_SELECT_SEARCH Selects a saved search. The channel only applies to the
Doclist widget.

oam_id: ID of the search.

The event copies the search item
attributes.

D2_EVENT_SELECT_FACET Selects a facet. The channel only applies to the
Doclist widget.

oam_id: ID of the facet.

The event copies the facet item
attributes.

D2_EVENT_SELECT_QUERY-
FORM

Selects a query form search. The channel only applies to the
Doclist widget.

oam_id: ID of the query form
search.

The event copies the query form
search item attributes.

D2_EVENT_SELECT_DISTRI-
BUTION

Selects a distribution. oam_id: ID of the distribution.

The event copies the distribution
item attributes.

D2_EVENT_SELECT_WORK-
FLOWTRACKER

Selects a workflow overview. oam_id: ID of the workflow
overview.

The event copies the workflow
overview item attributes.

D2_EVENT_SELECT_WORK-
FLOW_ACTIVITY

Selects a workflow activity. oam_id: ID of the workflow
activity.

The event copies the workflow
activity item attributes.

D2_EVENT_SELECT_AUDIT Selects an audit event. oam_id: ID of the audit.

The event copies the audit item
attributes.

D2_EVENT_SELECT_SNAP-
SHOT

Selects a virtual document
snapshot.

The channel only applies to the
Snapshots widget.

oam_id: ID of the virtual
document snapshot.

The event copies the virtual
document snapshot item attributes.
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D2_EVENT_VD_TEM-
PLATE_SELECTED

Selects a virtual document template
form.

The channel only applies to the
Snapshots widget.

oam_id: ID of the virtual
document template.

The event copies the virtual
document template item attributes.

D2_EVENT_DRAG_DROP_
STARTED

Begins dragging and dropping. oam_id: List of content IDs.

D2_EVENT_DRAG_DROP_
ENDED

Stops dragging and dropping. oam_id: List of content IDs.

D2_EVENT_IM-
PORTED_FROM_URL

Imports content from a URL. oam_id: View position (0 if
none).

cancelReason: Reason for
cancellation if the operation is
canceled.

result: Contains the result if the
operation is completed.

error: Contains the error if the
operation fails.

D2_EVENT_EX-
PORTED_FROM_URL

Exports content from a URL. oam_id: View position (0 if
none).

cancelReason: Reason for
cancellation if the operation is
canceled.

result: Contains the result if the
operation is completed.

error: Contains the error if the
operation fails.

D2_EVENT_DOWN-
LOAD_URLS_RECEIVED

Publishes a D2_ACTION_DOWN-
LOAD_URLS_REQUEST action.

urls: Contains a concatenated
string of URLs.

Send messages through channels to provide information about an action to be performed on content
as described in the following table:
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D2_ACTION_OPEN_FOLDER Opens a folder in the repository. The channel only applies to the
Doclist widget.

oam_id: ID of the folder.

collapseId: List of IDs of the
folders to reload.

pathId: Path ID of the ob-
ject. For example, /repon-
ame/0c0d04e580000105/
0b0d04e580055dd8

D2_ACTION_OPEN_URL Opens a URL in a new browser
window.

url: the URL to open.

D2_ACTION_OPEN_VD Opens a virtual document in the
repository.

The channel only applies to the
Virtual Documens widget.

oam_id: ID of the virtual
document.

D2_ACTION_OPEN_SNAP-
SHOT

Opens a virtual document snapshot. The channel only applies to the
Snapshots widget.

D2_ACTION_LOCATE_OBJECT Locates content in the repository. The channel only applies to the
Locations widget.

oam_id: ID of the content.

D2_ACTION_LOCATE_TASK Locates a task. The channel only applies to the
Locations widget.

oam_id: ID of the task.

D2_ACTION_LO-
CATE_SEARCH

Locates a saved search. The channel only applies to the
Locations widget.

oam_id: ID of the task.

D2_ACTION_REFRESH_DOCU-
MENT

Refreshes content. oam_id: ID of the content.

import: Present if the refresh is
related to the import.

D2_AC-
TION_COPY_LINK_IN_CLIP-
BOARD

Copies the smartlink to the content. oam_id: ID of the content.

type: Content type.

parentType: Content type of
the parent.

D2_ACTION_DUMP Shows a dump of the content. oam_id: ID of the content.

D2_ACTION_CON-
TENT_CHECKIN

Checks in the content. oam_id: ID of the content.

D2_ACTION_CONTENT_IM-
PORT_AS_VERSION

Imports a new version of content. oam_id: ID of the content.
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D2_ACTION_CON-
TENT_CHECKIN_NATIVE_AN-
NOTATION

Checks in content as a native
annotation.

oam_id: ID of the content.

D2_ACTION_CONTENT_PRINT Prints content. oam_id: ID of the content.

D2_ACTION_CONTENT_COM-
PARE

Compares two content. oam_id: ID of the content.

D2_ACTION_CONTENT_EX-
PORT

Exports content. oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CONTENT_EX-
PORT_NATIVE

Export content without including
renditions or metadata.

oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CONTENT_EX-
PORT_FOLDER

Exports folder content. oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CONTENT_EX-
PORT_FOLDER_NATIVE

Exports folder content without
including renditions or metadata.

oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CONTENT_VIEW Views content. oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CON-
TENT_VIEW_NATIVE

Views content without renditions
or metadata.

oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CONTENT_EDIT Edits content. oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CON-
TENT_CHECKOUT

Checks out content. The channel only applies to the
Checkout widget.

oam_id: ID of the content.

DOWNLOAD_LOCATION:
Location for download.

D2_ACTION_CONTENT_CAN-
CEL_CHECKOUT

Cancels the checkout of content. oam_id: ID of the content.

locateAndRefresh: Boolean
to determine if the location and
refresh occurred.

refreshCheckoutState:
Boolean to determine if the
checkout state is refreshed.
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D2_ACTION_CON-
TENT_EDIT_WITH_NA-
TIVE_ANNOTATION

Edits content with native
annotations.

oam_id: ID of the content.

D2_ACTION_CON-
TENT_VIEW_WITH_NA-
TIVE_ANNOTATION

Views content with native
annotations.

oam_id: ID of the content.

D2_ACTION_CON-
TENT_EDIT_NATIVE_AN-
NOTATION

Edits a native annotation. oam_id: ID of the content.

D2_ACTION_COMMENT Shows the comment creation
dialog box.

Set parentCommentId as the
parent comment.

The channel only applies to the
Comments widget.

oam_id: ID of the content.

parentCommendId: ID of the
parent comment.

id: ID of the comment.

editor: Richtext body of the
comment.

D2_ACTION_CONTENT_CRE-
ATE

Shows the content creation dialog
box.

Set parentId as the parent
folder as the content location if no
autolink is set.

oam_id: ID of the content used
for properties inheritance.

parentId: ID of the parent
folder. D2 creates content inside
the specified folder if no autolink
is set.

D2_ACTION_CONTENT_IM-
PORT

Shows the content import dialog
box.

Set parentId as the parent
folder as the content location if no
autolink is set.

oam_id: ID of the content used
for properties inheritance.

parentId: ID of the parent
folder. D2 creates content inside
the specified folder if no autolink
is set.

files: list of files on the client
machine.

D2_ACTION_FOLDER_CRE-
ATE

Shows the folder creation dialog
box.

Set the root_object_type to
dm_folder or dm_cabinet.

oam_id: ID of the folder in which
the new folder is being created.

root_object: set to
dm_folder or dm_cabinet to
specify the folder type.

D2_ACTION_OBJECT_DE-
STROY

Shows the content destruction
dialog box.

Set parentCommentId as the
parent content.

oam_id: ID of the content.

D2_ACTION_PERMIS-
SIONS_SHOW

Shows the permissions dialog box. oam_id: ID of the content.
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D2_ACTION_RENDI-
TION_ADD

Shows the add rendition dialog
box.

oam_id: ID of the content.

D2_ACTION_RENDITION_RE-
QUEST

Requests a rendition. oam_id: ID of the content.

D2_ACTION_RELATION_CRE-
ATE

Shows the relationship creation
dialog box.

oam_id: ID of the content.

D2_ACTION_RELATION_DE-
STROY

Shows the relationship destruction
dialog box.

Set associate_id as the ID of
the relation to destroy.

oam_id: ID of the content.

associate_id: ID of the
relation.

D2_ACTION_MASS_UPDATE Runs a mass update configuration.

Set config_name as the name of
the mass update configuration.

oam_id: ID of the content.

config_name: name of the mass
update configuration.

D2_ACTION_SYNCPLICITY Shows the Syncplicity dialog box. oam_id: ID of the content.

D2_ACTION_CUT Performs a cut operation. oam_id: ID of the content.

parentId: ID of the parent
content.

D2_ACTION_COPY Performs a copy operation. oam_id: ID of the content.

parentId: ID of the parent
content.

D2_ACTION_PASTE Performs a paste operation. parentId: ID of the parent
content.

D2_ACTION_PASTE_LINK Pastes a link of the clipboard
content.

parentId: ID of the parent
content.

D2_ACTION_CLIP-
BOARD_GET

Retrieves the clipboard content.
This action triggers D2_AC-
TION_CLIPBOARD_CONTENT.

D2_ACTION_CLIP-
BOARD_CONTENT

Performs an operation on the
clipboard content.

clipboard-operation:
Operation performed from the
clipboard.

clipboard-contentId: ID
of the clipboard content.

clipboard-value: Value of
the clipboard content.

D2_ACTION_DOWN-
LOAD_URLS_REQUEST

Requests a list of document URLs
for content.

oam_id: ID of the content.

format: Format of the content.

pageModifier: Page modifier.

pagenumber: Page number.
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D2_ACTION_IM-
PORT_FROM_URL

Imports content from a URL. oam_id: ID of the content.

url: URL of the content.

isModel: Set to true to make
the content modal.

D2_ACTION_EX-
PORT_FROM_URL

Exports content from a URL. oam_id: ID of the content.

url: URL of the export location..

useViewLocation: Set to
true to use the view location,
otherwise the export opens the
application selection dialog box.

hasDataPost: Boolean to
indicate whether the export
operation has information in the
dataPost parameter.

dataPost: The values to post.

D2_ACTION_SENDMAIL Sends mail. oam_id: ID to send. You do not
need to use oam_id if you used
id.

id: ID to send.

type: Object type.

parentType: Parent content
type. Optional.

D2_ACTION_FAVORITE_ADD Adds content to the list of favorites. oam_id: ID of the content.

D2_ACTION_FAVORITE_RE-
MOVE

Removes content from the list of
favorites.

oam_id: ID of the content.

D2_ACTION_ACROBAT_AN-
NOTATION_OPEN

Opens an Adobe Acrobat
annotation.

oam_id: ID of the content.

D2_ACTION_TICKET_GENER-
ATE

Generates a Documentum ticket.

Send messages through channels to perform interface actions as described in the following table:

Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_DISPLAY_DIA-
LOG

Shows a dialog box. oam_id: ID of the dialog box.

raw: A boolean that retrieves the
raw oam_id content when set to
true. Optional.

DIALOG_NAME: Dialog box
name.
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MANAGER: Manager class name.
Optional.

parentType: Parent object type.
Optional.

mode: Create, edit, or import
mode of the dialog box. Optional.

D2_ACTION_EXECUTE_MAN-
AGER

Executes a manager class for a
dialog box.

oam_id: ID of the dialog box.

raw: A boolean that retrieves the
raw oam_id content when set to
true. Optional.

DIALOG_NAME: Dialog box
name.

MANAGER: Manager class name.

D2_ACTION_EXECUTE Executes an action. rId: Returned ID. By default, this
is set to the message ID.

rType: Returned type (JS,
NATIVE, or EVENT). By default,
this does nothing.

rAction: Returned action (inline
Javascript, native function name,
or event name). By default, this
does nothing.

eMode: Entry mode (set as
SINGLE to call the action for one
ID, MONO to call the action once
for each ID, or MULTI to call
the action once with a list of all
provided IDs). By default, this is
set to MULTI.

eCall: Entry call for when
eMode is set to MONO (set as
SEQUENTIAL to call the actions
one at a time by waiting for
each service call to return or
PARALLEL to call the actions at
the same time). By default, this is
set to SEQUENTIAL.

eMethod: Name of the entry
method. This is only required for
D2FS services in conjunction with
the eService parameter.
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eService: Name of the plug-in
interface service without the I
prefix and Service suffix.

D2_ACTION_REFRESH_WID-
GET

Refreshes the widget. oam_id: ID of the widget.

target_type: Widget type.

D2_AC-
TION_RELOAD_WORKSPACE

Refreshes the active workspace. oam_id: ID of the workspace.

option_same_repository:
Determines if the workspace is in
the same repository.

D2_ACTION_WID-
GET_FULLSCREEN

Sets the widget to fullscreen view. original_widget: Original
widget ID.

original_event: Original
event ID.

original_cuid: Original cuid.

original_global: Original
global ID.

url: URL of the widget.

Send messages through channels to provide information about an action to be performed on
distributions as described in the following table:

Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_DISTIBU-
TION_ACCEPT

Accepts the distribution.

Set config_name as the
distribution configuration name.

oam_id: ID of the content.

config_name: name of the
distribution.

D2_ACTION_DISTRIBU-
TION_REJECT

Rejects the distribution.

Set config_name as the
distribution configuration name.

oam_id: ID of the content.

config_name: name of the
distribution.

D2_ACTION_DISTRIBU-
TION_PREPARE

Prepares the distribution.

Set config_name as the
distribution configuration name.

oam_id: ID of the content.

config_name: name of the
distribution.

D2_ACTION_DISTRIBU-
TION_LAUNCH

Launches the distribution.

Set config_name as the
distribution configuration name.

oam_id: ID of the content.

config_name: name of the
distribution.

D2_ACTION_DISTRIBU-
TION_STOP

Stops the distribution.

Set config_name as the
distribution configuration name.

oam_id: ID of the content.

config_name: name of the
distribution.
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D2_ACTION_DISTRIBU-
TION_REPORT

Reports the distribution.

Set config_name as the
distribution configuration name.

oam_id: ID of the content.

config_name: name of the
distribution.

D2_ACTION_SUBSCRIBE Subscribes to a distribution. oam_id: ID of the distribution.

Send messages through channels to provide information about an action to be performed on searches
as described in the following table:

Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_SEARCH_DOCU-
MENT

Searches the repository for content. oam_id: ID of the search.

locateId: ID of the object to
search.

searched_type: Search type
name.

facet_attr_name: Facet
attribute name.

facet_attr_value: Facet
attribute value.

reset_facet_attr_name:
Reset the facet attribute name.

D2_ACTION_SEARCH_HIGH-
LIGHT_TERMS

Highlight search terms. oam_value: Binary value for
whether to highlight search terms
(0 or 1).

D2_ACTION_AD-
VANCED_SEARCH

Shows the advanced search dialog
box.

oam_id: ID of the search. If
you set this to null, the action
prompts the user to create a new
advanced search.

D2_ACTION_SEARCH_CATE-
GORY_DIALOG

Shows the advanced search
category dialog box.

D2_ACTION_PREFER-
ENCES_SHOW

Shows the user preferences dialog
box.

D2_ACTION_QUERY-
FORM_SHOW

Shows the query form search
dialog box.

oam_id: ID of the content.

D2_ACTION_QUERY_CATE-
GORY_DIALOG

Shows the query form search
category dialog box.

Send messages through channels to provide information about an action to be performed on virtual
documents as described in the following table:
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D2_ACTION_CONVERT_VD Converts a document to a virtual
document.

oam_id: ID of the content.

D2_ACTION_CONVERT_DOC Converts a virtual document to a
simple document.

oam_id: ID of the virtual
document.

D2_ACTION_SNAPSHOT_CRE-
ATE

Creates a virtual document
snapshot.

The channel only applies to the
Snapshots widget.

oam_id: ID of the virtual
document.

D2_AC-
TION_VD_ADD_CHILD_SE-
LECTED

Shows the add child dialog box.

D2_ACTION_VD_RE-
MOVED_CHILD_SELECTED

Shows the remove child dialog
box.

D2_AC-
TION_VD_SET_CHILD_BIND-
ING_VERSION

Shows the binding version dialog
box.

D2_ACTION_VD_INSERT_IN-
HERITED_COMPONENT

Shows the insert inherited
component dialog box.

D2_ACTION_VD_CLEAR_VD Clears a virtual document of
elements.

Send messages through channels to provide information about an action to be performed on lifecycles
and workflows as described in the following table:

Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_LIFECY-
CLE_DCTM

Runs a lifecycle operation on a
Documentum lifecycle.

oam_id: ID of the content.

operation: the operation to
perform.

policyId: the policy to use.

D2_ACTION_LIFECYCLE_D2 Runs a lifecycle operation on a D2
lifecycle.

oam_id: ID of the content.

operation: the operation to
perform.

policyId: the policy to use.

D2_ACTION_WORK-
FLOW_LAUNCH

Launches a workflow. oam_id: ID of the content.

config: name of the workflow
configuration.

D2_ACTION_WORK-
FLOW_LAUNCH_SCHEDULED

Launches a workflow when
scheduled.

oam_id: ID of the queue_item.
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Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_WORKFLOW_UP-
DATE_PERFORMERS

Shows the update performers
dialog box.

oam_id: ID of the queue_item.

workflowTrackerId:
ID of the workflow tracker
used if oam_id is not an
ID2cWorkfowTracker or
IDfQueueItemworkflow.
Optional.

D2_ACTION_WORK-
FLOW_ABORT

Shows the abort workflow dialog
box.

oam_id: ID of the workflow
tracker.

D2_ACTION_TASK_ACQUIRE Sets the task as acquired. oam_id: ID of the task.

parentId: ID of the parent task.

forceAcquire: set to true to
force acquisition.

forceRead: set to true to force
reading.

D2_ACTION_TASK_READ Toggles the read or unread status
of the task.

oam_id: ID of the task.

parentId: ID of the parent task.

read: set to true or false.

D2_ACTION_TASK_PRIORITY Sets the task priority. oam_id: ID of the task.

parentId: ID of the parent task.

priority: set to the priority
integer.

D2_ACTION_TASK_FORWARD Shows the task progression dialog
box.

oam_id: ID of the task.

D2_ACTION_TASK_REJECT Shows the task rejection dialog
box.

oam_id: ID of the task.

D2_ACTION_TASK_DELE-
GATE

Shows the task delegation dialog
box.

oam_id: ID of the task.

source: set to tracker or
task.

D2_ACTION_TASK_NOTE Shows the task note dialog box. The channel only applies to the
Task notes widget.

oam_id: ID of the task.

D2_ACTION_TASK_PROCESS Shows the task processing dialog
box.

Set operation as the operation
to perform.

oam_id: ID of the task.

operation: the operation to
perform.

Send messages through channels to provide information about an action to be performed on
taxonomies and dictionaries as described in the following table:
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Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_TAXONOMY_EX-
PORT

Shows the taxonomy export dialog
box.

oam_id: ID of the taxonomy.

D2_ACTION_TAXONOMY_IM-
PORT

Shows the taxonomy import dialog
box.

oam_id: ID of the taxonomy.

D2_ACTION_TAXON-
OMY_CHECKIN

Shows the taxonomy checkin
dialog box.

oam_id: ID of the taxonomy.

D2_ACTION_TAXON-
OMY_SAVE

Shows the taxonomy save dialog
box.

oam_id: ID of the taxonomy.

D2_ACTION_TAXON-
OMY_PROPERTIES

Shows the taxonomy properties
dialog box.

oam_id: ID of the taxonomy.

D2_ACTION_TAXONOMY_LO-
CATE

Searches for the taxonomy. The channel only applies to the
Locate widget.

oam_id: ID of the taxonomy.

D2_ACTION_TAXONOMY_RE-
STORE

Shows the taxonomy restoration
dialog box.

oam_id: ID of the taxonomy.

D2_ACTION_DICTIO-
NARY_EXPORT

Shows the dictionary export dialog
box.

oam_id: ID of the dictionary.

D2_ACTION_DICTIO-
NARY_IMPORT

Shows the dictionary import dialog
box.

oam_id: ID of the dictionary.

D2_ACTION_DICTIO-
NARY_SAVE

Shows the dictionary save dialog
box.

oam_id: ID of the dictionary.

D2_ACTION_DICTIO-
NARY_RESTORE

Shows the dictionary restoration
dialog box.

oam_id: ID of the dictionary.

D2_ACTION_DICTIO-
NARY_UPDATE

Shows the dictionary update dialog
box.

oam_id: ID of the dictionary.

D2_ACTION_DICTIO-
NARY_PROPERTIES

Shows the dictionary properties
dialog box.

oam_id: ID of the dictionary.

Send messages through channels to provide information about an action to be performed on users
and groups as described in the following table:

Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_OPEN_GROUP Opens a group oam_id: ID of the group.

D2_ACTION_GROUP_CREATE Creates a group. The channel only applies to the
Groups widget.

D2_ACTION_GROUP_PROPER-
TIES

Sets the properties of a group. The channel only applies to the
Properties widget.

oam_id: ID of the group.
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Channel name Requests that D2 Parameters and notes for focus
events

D2_ACTION_USER_CREATE Creates a user. The channel only applies to the
Users widget.

oam_id: ID of the user.

D2_ACTION_USER_PROPER-
TIES

Sets the properties of a user. The channel only applies to the
Properties widget.

oam_id: ID of the user.
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Chapter 26

Reserved Words

This chapter contains the following topics:

• List of Reserved Words in D2 when Using Documentum Application Builder

List of Reserved Words in D2 when Using
Documentum Application Builder
Do not use the following words when defining objects and relations in Documentum Application
Builder or Documentum Composer, as they conflict with the D2 property page component:

• abstract

• boolean

• break

• byte

• case

• catch

• char

• class

• const

• continue

• default

• delete

• do

• double

• else

• export

• extends

• instanceof

• int

• long

• native

• new

• null

• package

• private

• protected

• public

• return

• short

• static

• super

• switch

• synchronized

• this
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• false

• final

• finally

• float

• for

• function

• goto

• if

• implements

• import

• in

• throw

• throws

• transient

• true

• try

• typeof

• var

• void

• while

• with
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Chapter 27

PDF Fields Reference

This chapter contains the following topics:

• List of PDF Fields

List of PDF Fields
Field Description

#page Current page

#page_count Number of pages

#chapter Chapter name

#datetime Date and time of the client host

#username Current user

#controled_username Name of the user printing the content

#controled_username_count Number of controlled prints by the current user

#controled_count Total number of controlled prints

#reason Reason for printing

#folder_path First path of the document

#complete_name First path of the document and name

#server_datetime Server date and time

#docbase Repository name

#version Version number of the content

Volume auto-link

Property name (for example, object_name) Documentum single-value attribute

Property name.dictionary name.language or alias
name (for example, object_name.dico1.fr)

Dictionary mapping

Property name (for example, keywords) Comma-separated Documentum repeating-value
attribute

Property name[index] (for example, keywords[0]) Repeating-value attribute

Property name.dictionary name.language or alias
name[index] (for example, keyword[0].dico1.fr)

Dictionary mapping

ID.Property name (for example, dqlkey.object_name) All recorded comma-separated values
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Field Description

ID.Property name[index] (for example,
dqlkey.object_name[0])

Recorded value

ID.Property name.dictionary name.language or alias
name[index] (for example, keyword[0].dico1.fr)

Dictionary mapping
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